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Descripcion general

Configuracion del sistema

En esta seccion se muestra un ejemplo de la configuracion del sistema de la cdmara.

SELP28135G
SEL1635Z
SELP18200
Objetivo

[™™—h

ECM-MS2

Micréfono LA-EAS,
LA-EA4
Adaptador de
montura A

u
e

IFU-WLM3
Modulo LAN inaldmbrico USB
(suministrado)

RMT-845
Control remoto de
infrarrojos (suministrado)

Control remoto de la
empufadura (suministrado)

VCT-FS7
Adaptador para los
hombros

UWP-D11, SMAD-P3 XLR-K2M HVL-LBPC
UWP-D12 Adaptador de Kit de Luz de video
Paquete de la zapata de Adaptador
micréfono interfaces de XLR
inalambrico multiples
L e e e e
A
Series S/IN/M/H/G MRW-E80
Tarjeta de memoria XQD Lector de tarjetas
XQb

BP-U30, BP-U60,
BP-U60T, BP-U90
Bateria

(BP-U30 suministrada)

XDCA-FS7
Unidad de
extension

Adaptador
inalambrico
CBK-WA100

BC-U1A, BC-U2A
Adaptador de CA/Cargador
(BC-U1A suministrada)

T

080
0690
— — i
HXR-IFR5 AXS-R5
Unidad de Grabadora
interfaz de
memoria
portatil



Ubicacion y funcion de los componentes

Para obtener mds informacion acerca del uso'y las funciones de cada componente, consulte la pagina a la que

se haga referencia.
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1. Asa (pdgina 8)
2. Conector del visor (pdgina 22)
3. Conector REMOTE (pdgina 25)

4. Interruptor INPUT1 (LINE/MIC/
MIC+48V) (pdgina 45)

5. Interruptor INPUT2 (LINE/MIC/
MIC+48V) (pdgina 45)

6. Acoplamiento de la empuiiadura
(pdgina 25)

7. Conector del médulo LAN inaldmbrico
USB

8. Indicador de grabacién (pdgina 100)
Parpadea cuando la capacidad restante del
soporte de grabacion o de la bateria es baja.

9. Gancho para cinta métrica
El gancho para cinta métrica estd situado en el
mismo plano que el sensor de imagen. Para
medir la distancia entre el camcorder y el sujeto
de forma precisa, utilice este gancho como
punto de referencia. Puede unir el extremo de la
cinta métrica al gancho para medir la distancia
desde el sujeto.

10. Botén WB SET (ajuste del balance de
blancos) (pdgina 45)

11. Pasador de bloqueo del objetivo
(pdgina 24)

12. Bot6n de liberacién del objetivo
(pdgina 24)

13. Zapata para accesorios

14. Botén de grabacién del asa START/STOP
El botén de grabacion no se puede utilizar
cuando la palanca de bloqueo estd en la posicién
de bloqueo.

15. Palanca de zoom del asa (pdgina 70)

16. Zapata de interfaz miltiple

S Multi
Y interface Shoe

Para obtener mds informacién acerca de los
accesorios compatibles con la zapata de interfaz
muiltiple, péngase en contacto con su
representante de ventas.



Acople de la zapata para accesorios

1 Levante el borde delantero del muelle de la zapata y
tire del muelle en la direccién opuesta a la flecha que
se encuentra grabada en este.

Muelle de la zapata

“l%
O\ >

=3
N
Zapata para accesorios

2 Sitde la zapata para accesorios en la montura de la
zapata para accesorios, alineando los salientes de la
zapata con los puntos correspondientes de la montura,
y apriete los cuatro tornillos.

3 Introduzca el muelle de la zapata en la direccién de la
flecha de modo que la parte en forma de U encaje en
el extremo de la zapata para accesorios.

Zapata para
accesorios

-
R
Muelle de la
zapata

Extraccion de la zapata para accesorios
Extraiga la zapata para accesorios tal y como se
describe en el paso 1 de la seccion “Acople de la
zapata para accesorios”, afloje los cuatro tornillos
y extraiga la zapata para accesorios.

Acoplamiento de la placa de proteccidn del
mddulo LAN inalambrico

1 Extraiga el tornillo de acoplamiento al asa.

2 Acople la placa de proteccién y apriete el tornillo.

Extraccion del asa
Retire los cuatro tornillos de acoplamiento del asa
y extraiga el asa del camcorder.

Colocacion de la tapa protectora del conector del
asa (suministrada)

Cuando utilice el camcorder sin el asa, proteja el
conector con la tapa protectora del conector.

Proteccidn de los terminales de los conectores
Acople la cubierta en conectores que no se
utilicen para proteger los terminales de los
conectores.
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1. Botén START/STOP

2. Dial ND FILTER (pdgina 44)
3. Botones ASSIGN (asignables) del 1 al 3
(pdgina 47)
4. Botén PUSH AUTO IRIS (pdgina 43)
5. Botén PUSH AUTO FOCUS (pdgina 41)
6. Interruptor FOCUS (pdgina 41)
7. Botén DISPLAY (pdgina 13)
8. Botén FULL AUTO (pdgina 39)
9. Interruptor POWER (pdgina 19)
10. Dial IRIS (pdgina 47)
11. Botén STATUS CHECK (pdgina 15)
12. Interruptor HOLD (pdgina 100)

13. Interruptor CH1 LEVEL CONTROL
(pdgina 45)

14. Dial CH1 INPUT LEVEL (pdgina 45)

15. Interruptor CH2 LEVEL CONTROL
(pdgina 45)

16. Dial CH2 INPUT LEVEL (pdgina 45)

17. Botén SLOT SELECT (seleccion de la
tarjeta de memoria XQD) (pdgina 31)

18. Botén CANCEL/BACK (pdgina 59)
19. Botén MENU (pdgina 61)
20. Botén THUMBNAIL (pdgina 58)

) @ 1
e = NN = ST O R
O=e |,

|SHH T

1
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21. Botén derecho
Se utiliza para definir valores numéricos y
mover el cursor hacia la derecha en las pantallas
de miniaturas y menus.

22. Dial SEL/SET (seleccionar/definir)
Gire el dial para mover el cursor hacia arriba y
hacia abajo para seleccionar elementos o ajustes
del mend. Pulse para aplicar el elemento
seleccionado.

23. Botén izquierdo
Se utiliza para definir valores numéricos y
mover el cursor hacia la izquierda en pantallas
con miniaturas y menus.

24. Botén SHUTTER (pdgina 44)

25. Interruptor WHT BAL (seleccién de

memoria de balance de blancos)
(pdgina 44)

26. Boton WHT BAL (balance de blancos)
(pdgina 44)

27. Interruptor GAIN (seleccién de ganancia)
(pdgina 43)

28. Bot6én ISO/Gain (pdgina 43)



1.

12.

13.
14.

15.
16.
17.

. Conector para auriculares (pdgina 42)
. Ranura A de la tarjeta XQD (pdgina 31)
. Ranura de tarjeta UTILITY SD

(pdgina 32)

. Indicador de acceso XQD (A) (pdgina 31)

. Indicador de acceso de la tarjeta SD

(pdgina 32)

. Indicador de acceso XQD (B) (pdgina 31)
. Conector USB

Conéctese a un ordenador con un cable USB
para acceder a los soportes de grabacién en una
ranura de tarjeta XQD del camcorder.

. Ranura B de la tarjeta XQD (pdgina 31)
. Altavoz integrado (pdgina 42)

. Boton de liberacion de la tapa de soportes

(pdgina 31)

Conector de la unidad de extensiéon
(pdgina 33)

Indicador de grabacion posterior
(pdgina 39)

Conector DC IN (pdgina 20)

Boton BATT RELEASE (liberacion de la
bateria) (pdgina 19)

Bateria (pdgina 19)
Acoplamiento de la bateria (pdgina 19)

Sensor del receptor del control remoto de
infrarrojos (pdgina 35)

18. Micréfono interno (pdgina 45)
Micréfono de narracion para grabar el sonido
ambiental.

19. Conector INPUT1 (entrada de audio 1)
(pdgina 45)

20. Conector INPUT?2 (entrada de audio 2)
(pdgina 45)

21. Conector SDI OUT 1 (pdgina 104)
22. Conector SDI OUT 2 (pdgina 104)
23. Conector HDMI OUT (pdgina 104)

Parte inferior
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1. Orificio para los tornillos del tripode (1/4

pulgadas, 3/8 pulgadas) ObjetIVO (SOIQ PXW'FS7K)
Compatible con tornillos 1/4-20UNC y 3/8-

16UNC. Para obtener mas informacion, consulte el manual
Acople la unidad a un tripode (opcional, de funcionamiento del objetivo.

longitud de tornillos 5,5 mm o inferior).

Control remoto de la empuiiadura

Visor

Para obtener mds informacion acerca de la
Para obtener mds informacién acerca de la conexion del control remoto de la empuiiadura
conexién del visor (suministrado) y el ocular, (suministrado), consulte la pdgina 25.

consulte la pdgina 22.

[T

1. Dial CONTRAST
2. Botén PEAKING
3. Botén ZEBRA

4. Interruptor MIRROR 7N\

5. Ganchos de conexién del ocular 8 \k ((L\Q\\ \\@@ @I

Ocular

Para obtener mds informacion acerca de la
conexion del ocular (suministrado), consulte la
pdgina 23.

1. Palanca de zoom

2.Botén ASSIGN (asignable) 4

3. Dial asignable

4.Botén ASSIGN (asignable) 6

5. Botén START/STOP de grabacién
6. Selector miiltiple

7. Botén de rotacién de la empuiiadura
1. Dial de ajuste diéptrico 8. Botén ASSIGN (asignable) 5
2. Copa ocular

11



Control remoto de infrarrojos

’_(—\ 8

TART/STOP

PLAY  PAUSE

SCANSL
&
22

\‘D @CI')\
(@) C)%
]

S Ol & WN =

5B

1. Botén DATA CODE

No se utiliza en esta version.
2.Botén TC RESET
3. Botén SCAN/SLOW
4. Bot6n ¢« /»»1 (PREV/NEXT)
9. Botén PLAY
6. Botén STOP
7. Botén DISPLAY
8. Transmisor del control remoto
9. Botén START/STOP
10. Palanca de zoom
11. Botén PAUSE

12. Botén MODE
No se utiliza en esta version.

13. Botén </»/A/V/ENTER

10
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Unidad de extensién (opcional)

Para obtener mas informacioén sobre la conexion
de una unidad de extensién (opcional), consulte la
pdgina 33.

1.Botén BATT RELEASE

2. Conector de la bateria

3. Conector GENLOCK IN

4. Conector DC IN

5. Conector DC OUT

6. Indicador de grabacién

7. Conector REF OUT

8. Conector TC IN/OUT

9. Interruptor TC IN/OUT
10. Conector RAW OUT



Visualizacion de la pantalla

Pantalla del visor

Durante la filmacién (grabacién/en espera) y la reproduccion, el estado y la configuracion del camcorder
se superponen sobre la imagen mostrada en el visor.

Puede mostrar/ocultar la informacién con el botén DISPLAY.

También puede elegir si desea mostrar u ocultar cada elemento independientemente (pdgina 85).

En el visor se muestra la imagen con relacion de aspecto 17:9 capturada por el sensor de imagen. En los
formatos de grabacion de 16:9, las partes oscuras que aparecen en los bordes izquierdo y derecho no se
graban.

Informacion mostrada en la pantalla durante la filmacion

|

1

I a

L _
L |
[ e——

29 —{|RecCt]STOP)

28—{50 ip Name 567 567
([TCG00:00:00:00) [mﬂ S| (4 == | [TA—]000min 1B 000min
| |

27 26 25 24 23 22
1. Indicador del modo del obturador/ -
velocidad del obturador (pdgina 44) Al/[B|@Rec Grabacidn
2. Indicador del filtro ND (pdgina 44) /[B]stby En espera
3. Indicador de ganancia (pdgina 43) S&Q|A /[B|@Rec ~ Crabacionen modo
Se muestra como valor EI cuando Base Setting Inov1m1e}nt2‘a camara
(pdgina 96) >Shooting Mode en el ment veerﬁ)aci};larsip;e?io amas
System estd ajustado en “Cine EI”. alta ¢

4. Indicador deiplo/swlon de enfogue s&Q[A /[B] Sty Modo movimiento a
Muestra la posicion de enfoque (si se acopla un cdmara lenta y rapida, y
objetivo compatible con la pantalla de velocidad de fotogramas

configuracién del enfoque). alta en espera

5. Modo de grabacién, icono de la ranura A/ Int[A] /@Rec Grabacién a intervalos
B e indicadores de estado




10.

1.

12.

13.

14.

15.

Int W /@Stby Carga de imdgenes de
grabacion a intervalos
en espera

Int W /@ Stby Grabacién a intervalos

en espera

Grabacién de memoria
intermedia de imagenes

A/Ble

Memoria intermedia de

W/E ®Cache imdgenes en espera
. Icono de la ranura B e indicadores de
estado
®Rec Grabacién
Stby En espera

. Indicador de grabacion RAW externo

(pdgina 53)

. Indicador de profundidad de campo

. Indicador de temperatura de color

(pdgina 44)

Indicador de velocidad de fotogramas
S&Q Motion (pdgina 90)/Visualizacion del
intervalo de grabacién a intervalos
(pdgina 48)

Indicador de capacidad de bateria
restante/tensién de DC IN (pdgina 20)

Indicador de formato de grabaciéon
(tamaiio de imagen) (pdgina 27, 97)
Muestra el tamafio de imagen para grabaciones
en tarjetas de memoria XQD.

El modo de escaneado del sensor de imagen (F:
2K Full, C: 2K Center) se muestra a la izquierda
del tamafio de la imagen. Solo se muestra el
modo de escaneado si Codec esta ajustado en
“RAW” (2KF: 2K Full, 2KC: 2K Center).

Indicador de formato de grabacion
(velocidad de fotogramas y método de
exploracion)

Indicador de formato de grabaciéon
(codec) (pdgina 43)

Muestra el nombre del formato de grabacién en
tarjetas de memoria XQD.

Indicador LUT de monitor/gamma
(pdgina 74, 83)

Muestra el ajuste gamma. Cuando Shooting
Mode (pdgina 96) esta ajustado en “Cine EI”
muestra el ajuste gamma o LUT del monitor
para la grabacién de videos en tarjetas de
memoria XQD.
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16.

17.

18.

19.

20.

21.

22.

23.

24.

25.
26.
27.

28.
29.

Indicador de formato de salida externo
(pdgina 82)

Indicador de bloqueo de cédigo de tiempo
externo

Muestra “EXT-LK” cuando estd bloqueado con
el cdigo de tiempo de un dispositivo externo.

Indicador de estado de la conexién Wi-Fi
(pdgina 55)

Se muestra cuando la funcién Wi-Fi esta
ajustada en “Enable”. Cuando el IFU-WLM3 no
estd conectado al camcorder, m no se
muestra.

Indicador de estado GPS (pdgina 53)
Muestra el estado del GPS.

Indicador de enfoque asistido (pdgina 42)
Muestra un fotograma de deteccién (marcador
de la zona de enfoque) que indica el area para la
deteccién del enfoque, y una barra de nivel
(indicador de enfoque asistido) que indica el
grado de enfoque dentro de dicha drea.
Monitor de seiial de video (pdgina 52)
Muestra una forma de onda, un vectorscopio y
un histograma.

Cuando Shooting Mode (pdgina 96) esta
ajustado en “Cine EI”, la informacién del LUT
de monitor también se muestra para el monitor
(pdgina 52).

Indicador de capacidad restante/estado
del soporte de la ranura A/B (pdgina 32)
Soporte de grabacién cuando el lado izquierdo
del icono estd iluminado en color naranja.
Soporte de reproduccién cuando el indicador
verde de la parte superior derecha del icono estd
encendido.

Indicador de nivel de burbuja

Muestra el nivel horizontal y la pendiente
anterior-posterior en intervalos de +1° hasta
+20°.

Medidor del nivel de audio
CH3 y CH4 se pueden controlar en la pantalla de
estado.

Indicador de nombre del clip (pdgina 58)
Indicador de enfoque (pdgina 41)

Visualizacion de datos de tiempo
(pdgina 46)
Indicador de tarjeta SD

Indicador de estado del control de salida
SDI (pdgina 104)



30. Indicador de modo de balance de blancos
(pdgina 44)

W:P Modo predeterminado
W:A Modo memoria A
W:B Modo memoria B

31. Indicador de modo AE (pdgina 43)

32. Indicador de diafragma automatico
(pdgina 43)

33. Indicador de AGC (pdgina 43)

34. Indicador de obturador automitico
(pdgina 44)

35. Indicador de modo de enfoque

36. Indicador de modo de estabilizacién de la
imagen

37. Indicador de 4rea de enfoque
Muestra el drea de enfoque para el enfoque
automdtico.

Cuando el enfoque automético de pulsacion
(Push Auto Focus) estd disponible

Durante el enfoque automético

No se muestra cuando Focus Area (pdgina 68)
estd ajustada en Wide.

38. Indicador de posicién del zoom
Muestra la posicién del zoom en el rango de 0
(gran angular) a 99 (telefoto) (si se acopla un
objetivo compatible con la pantalla de
configuracién de zoom).
También puede mostrarse como un grafico de
barras (pdgina 87).

39. Indicador de posicion del diafragma
Muestra la posicion del diafragma (si se acopla
un objetivo compatible con la pantalla de
configuracion del diafragma).

Informacion mostrada en la pantalla durante la

reproduccion

La siguiente informacién se superpone sobre la

imagen reproducida.

1 2
| |
([000170012_Giips) =0

~No o b

A001C001_1234567A

T
10 9

. Nimero del clip/Nimero total de clips
. Modo de reproduccion

. Indicador de capacidad restante la bateria

S W N =

. Indicador de formato de reproduccion
(tamaiio de imagen)

5. Indicador de formato de reproduccion
(velocidad de fotogramas)

6. Indicador de formato de reproduccién
(codec)

7. Indicador de estado de la conexién Wi-Fi
(pdgina 55)
Se muestra cuando la funcién Wi-Fi estd
ajustada en “Enable”. Cuando el IFU-WLM3
no esta conectado al camcorder, m no se
muestra.

8. Indicador de soporte

9. Indicador de nivel de audio
Muestra el nivel de audio durante la grabacién.

10. Visualizacién de datos de tiempo
Cuando Display On/Off > Timecode en el mend
VF estd ajustado en “On”, se muestran los datos
de tiempo al pulsar el botén DISPLAY.

Pantalla de estado

Para mostrar la pantalla de estado:
* Pulse el botén STATUS CHECK.



Para cambiar a la pantalla de estado:
« Gire el dial SEL/SET.
* Mueva el selector miltiple arriba/abajo.

CH3 Wind Filter

Ajuste del filtro de reduccién del
ruido en el micréfono del canal 3

Medidor del nivel
CH4

Medidor de nivel de audio del
canal 4

Para ocultar la pantalla de estado: CH4 Source Fuente de entrada del canal 4
* Pulse el botéon STATUS CHECK. CH4 Wind Filter ~ Ajuste del filtro de reduccién del

. ruido en el micréfono del canal 4
Pantalla de esm_do de, la camara Audio Input Level Ajuste del nivel de entrada de
Muestra la configuracién del obturador audio
electronico de la cdmara y el estado del objetivo. Monitor CH Ajuste del canal del monitor
ISO/Gain/EI<H>  Ajuste de ISO/Gain/EI<H> HDMI Output CH  Ajuste de la combinacién del
ISO/Gain/EI<M>  Ajuste de ISO/Gain/EI<M> canal de audio de salida HDMI
ISO/Gain/EI<L>  Ajuste de ISO/Gain/EI<L> Headphone Out  Ajuste del tipo de salida de
Shutter Ajuste del obturador (Speed/ auriculares

Angle/ECS/Of .
Iris Valir F-stop ol?lem'do del objetivo Pantalla de e;tado del sistema
- M Muestra los ajustes de la senal de video.

Zebral Ajuste Zebral On/Off y nivel
Zebra2 Ajuste Zebra2 On/Off y nivel Country Ajuste de region NTSC o PAL
Gamma Ajuste de Gamma Select Rec Format Formato para grabaciones en
White Modo de balance de blancos y tarjetas de memoria XQD

ajustes

Focal Length

Valor de la distancia focal
obtenida desde el objetivo

AE Level Ajuste de nivel AE

AE Speed Ajuste de velocidad de control AE

AGC Limit Ajuste de ganancia maxima de la
funcién AGC

A.SHT Limit La velocidad mds rdpida del
obturador en la funcién de
obturador automatico

AE Mode Ajuste del modo AE (Backlight/

Standard/Spotlight)

Pantalla de estado del audio

Muestra el ajuste de entrada, el medidor del nivel
de audio y el ajuste del filtro de reduccién de
ruido para cada canal.

Medidor del nivel
CHI1

Medidor de nivel de audio del
canal 1

CHI1 Source

Fuente de entrada del canal 1

CH1 Ref./Sens.

Nivel de referencia de entrada del
canal 1

CH1 Wind Filter

Ajuste del filtro de reduccion del
ruido en el micréfono del canal 1

Medidor del nivel
CH2

Medidor de nivel de audio del
canal 2

CH2 Source Fuente de entrada del canal 2

CH2 Ref./Sens. Nivel de referencia de entrada del
canal 2

CH2 Wind Filter ~ Ajuste del filtro de reduccién del

ruido en el micréfono del canal 2

Medidor del nivel
CH3

Medidor de nivel de audio del
canal 3

CH3 Source

Fuente de entrada del canal 3
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Picture Size

Tamafio de imagen para
grabaciones en tarjetas de
memoria XQD

Frame Rate

Velocidad de fotogramas para
grabaciones en tarjetas de
memoria XQD

Rec Function

Se habilita un formato de
grabacién y unos ajustes
especiales

Simul Rec

Estado de encendido/apagado de
Simul Rec

Picture Cache Rec

Estado de encendido/apagado de
Picture Cache Rec

Video Light Set

Indicador de encendido/apagado
de luz de video HVL-LBPC

Imager Scan

Modo de escaneado del sensor de
imagen

Pantalla de estado de la salida de video
Muestra los ajustes de salida de video, SDI 'y

HDMI

SDI1 Tamaiio de la imagen de salida
Espacio de color
Salida de visualizacién de la
pantalla
Gamma

SDI2 Tamaiio de la imagen de salida

Espacio de color

Salida de visualizacién de la
pantalla

Gamma




HDMI

Tamaiio de la imagen de salida
Espacio de color

Salida de visualizacién de la
pantalla

Gamma

REF

Tamaiio de la imagen de salida

RAW

Tamaiio de la imagen de salida

Pantalla de estado de los botones asignables
Muestra las funciones asignadas a cada uno de los
botones asignables.

1 Funcién asignada al botén
ASSIGN 1

2 Funcién asignada al botén
ASSIGN 2

3 Funcién asignada al botén
ASSIGN 3

4 Funcién asignada al botén
ASSIGN 4

5 Funcién asignada al botén
ASSIGN 5

6 Funcién asignada al botén
ASSIGN 6

IRIS Dial Funcién asignada al dial IRIS

Assignable Dial ~ Funcién asignada al dial asignable

Pantalla de estado de la bateria
Muestra informacién sobre la bateria y sobre la

fuente DC IN.

Detected Battery

Tipo de bateria

Remaining Capacidad restante (%)

Charge Count Numero de recargas

Capacity Capacidad restante (Ah)

Voltage Tension (V)

Manufacture Date  Fecha de fabricacion de la bateria
Video Light Muestra la capacidad restante de
Remaining la bateria de la luz de video.

Power Source

Fuente de alimentacién

Supplied Voltage

Tension de la fuente de
alimentacién

Pantalla de estado de los soportes

Muestra la capacidad y el tiempo de grabacién
restantes de los soportes de grabacion (tarjetas de
memoria XQD Ay B).
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Informacién del
soporte A

Muestra el icono del soporte
cuando el soporte de grabacion se
ha introducido en la ranura A.

Proteccién del
soporte A

Muestra el icono de bloqueo
cuando el soporte de grabacién
introducido en la ranura A estd
protegido (bloqueado).

Las tarjetas de memoria XQD no
se pueden proteger con el
camcorder.

Medidor de la
capacidad restante
del soporte A

Muestra la capacidad de grabacién
restante del soporte de grabacion
introducido en la ranura A,
expresado en forma de porcentaje
en un grafico de barras.

Tiempo de
grabacidn restante
del soporte A

Muestra un calculo del tiempo de
grabacion restante del soporte de
grabacion introducido en la ranura
A, expresado en minutos segtn las
condiciones de grabacién actuales.

Informacién del
soporte B

Muestra el icono del soporte
cuando el soporte de grabacion se
ha introducido en la ranura B.

Proteccién del
soporte B

Muestra el icono de bloqueo
cuando el soporte de grabacién
introducido en la ranura B estd
protegido (bloqueado).

Las tarjetas de memoria XQD no
se pueden proteger con el
camcorder.

Medidor de la
capacidad restante
B

Muestra la capacidad de grabacién
restante del soporte de grabacion
introducido en la ranura B,
expresado en forma de porcentaje
en un grafico de barras.

Tiempo de
grabacidn restante
del soporte B

Muestra un cdlculo del tiempo de
grabacion restante del soporte de
grabacion introducido en la ranura
B, expresado en minutos segtn las
condiciones de grabacién actuales.

Informacién de la
tarjeta SD

Muestra el icono de soportes
cuando se ha introducido alguno
en la ranura de la tarjeta UTILITY
SD.

Proteccién de la

Muestra el icono de bloqueo

tarjeta SD cuando el soporte introducido en
la ranura de la tarjeta UTILITY
SD estd protegido (bloqueado).

Medidor de la Muestra la capacidad restante del

capacidad restante soporte introducido en la ranura

de la tarjeta SD

de la tarjeta UTILITY SD,
expresado en forma de porcentaje
en un grifico de barras.




Capacidad
restante de la
tarjeta SD

Muestra la capacidad restante del
soporte introducido en la ranura
de la tarjeta UTILITY SD,
expresado en unidades de GB.

Vida itil de la
tarjeta SD

Muestra la vida ttil de
funcionamiento del soporte en la
ranura de la tarjeta UTILITY SD
en forma de porcentaje.

Pantalla de ajustes del boton Rec
Muestra los ajustes de los botones START/STOP
del camcorder y el asa (pdgina 40).

Rec Button Muestra las ranuras para la
grabacién controladas por el botén
de grabacién START/STOP.

Handle Rec Muestra las ranuras para la

Button grabacidén controladas por el botén

de grabacién START/STOP del
asa.

18



Fuente de alimentacion

Puede utilizar una bateria o una fuente de
alimentacién de CA mediante un adaptador de
CA.

Por su seguridad, utilice solo las baterfas y los
adaptadores de CA Sony que se enumeran a
continuacion.

Baterias de iones de litio
BP-U30 (suministrado)
BP-U60

BP-U60T

BP-U90

Adaptadores de CA/Cargadores
BC-U1A (suministrado)
BC-U2A

Precaucion

No guarde las baterfas en lugares expuestos a la
luz solar directa, cerca de fuegos ni a temperatura
elevadas.

¢ Cuando se utilice conectado a una toma de corriente,
utilice el adaptador de CA suministrado.

 Ajuste siempre el interruptor POWER (Alimentacion)
en la posicion de apagado antes de desconectar o
conectar una baterfa o un adaptador de CA. En
determinados casos, si el dispositivo se desconecta o se
conecta con el interruptor POWER (Alimentacion) en
la posicién de encendido, es posible que la
videocdmara no sea capaz de iniciarse. Si la
videocdmara no se puede iniciar, ajuste el interruptor
POWER (Alimentacion) en la posicién de apagado y
extraiga la baterfa o desconecte el adaptador de CA
temporalmente; a continuacion, espere unos
30 segundos antes de volver a intentar conectarlos. (Si
el adaptador de CA estd desconectado o conectado
mientras la videocdmara funciona gracias a la baterfa,
o viceversa, el dispositivo se puede desconectar o
conectar con el interruptor POWER (Alimentacion) en
la posicién de encendido sin problemas).
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Utilizacion de una bateria

Para colocar la bateria, conéctela en el
acoplamiento (pdgina 10) empujindolo hasta el
tope y a continuacion deslicela hacia abajo para
que quede bloqueada en la posicién final.

Para extraer la bateria, mantenga pulsado el boton
BATT RELEASE (pdgina 10), deslicela hacia
arriba y a continuacion, tire de ella para sacarla
del acoplamiento.

\

Botén BATT
RELEASE

 Antes de colocar una baterfa, cirguela con el adaptador
de CA/cargador de baterias BC-U1A o BC-U2A
especifico.

* Si carga la baterfa inmediatamente después de
utilizarla y cuando todavia estd caliente, es posible que
no se recargue completamente.



Comprobacion de la capacidad restante

Durante la filmacién y la reproduccién con
bateria, la capacidad de bateria restante se
muestra en el visor (pdgina 13).

Icono Capacidad restante

Entre 91% y 100%

Entre 71% y 90%

Entre 51% y 70%

Entre 31% y 50%

Entre 11% y 30%

BN

Entre 0% y 10%

El camcorder indica la capacidad restante al
calcular el tiempo de uso disponible con la bateria
si el uso es continuado y con el ritmo de consumo
de energia actual.

Uso de una unidad de extension

Cuando se utiliza la unidad de extensién XDCA-
FS7, se muestra la tension de la bateria o la
capacidad de bateria restante en funcién de la
bateria usada.

La bateria del camcorder no se puede utilizar cuando la
unidad XDCA-FS7 también esta conectada al
camcorder. Deberd acoplar la bateria a la XDCA-FS7 o
conectar el camcorder a una toma de alimentacién
externa.

Si el nivel de carga de la bateria es bajo

Si la carga restante de la baterfa desciende por
debajo de un nivel determinado durante el
funcionamiento (Low BATT state), aparecerd un
mensaje de bateria baja, el indicador de grabacién
comenzard a parpadear y se escuchard un pitido
de advertencia.

Si la carga restante de baterfa desciende por
debajo del nivel al que el funcionamiento ya no
puede continuar (BATT Empty state), aparecera
un mensaje de bateria agotada.

Sustituya la baterfa por una bateria cargada.

Cambio de los niveles de advertencia

Elnivel Low BATT estd ajustado en el 10% de la
carga total de la bateria y el nivel de BATT Empty
estd ajustado en el 3% de manera predeterminada.
Puede cambiar la configuracion del nivel de
advertencia en Camera Battery Alarm

(pdgina 102) en el menud System.
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Utilizacién de la alimentacién por
CA

Si el camcorder se conecta a una toma de
corriente este se podrd utilizar sin preocuparse de
la necesidad de recargar la baterfa.

Ejemplo de conexidn: al conectar BC-U1A

Conector DC IN

Alatomade
corriente

Cable de
| alimentacion

Conecte el adaptador de CA al conector DC IN
del camcorder y, a continuacién, conecte el cable
de alimentacion (suministrado) a la toma de
corriente. Ajuste el interruptor de seleccién de
modo del BC-U1A en la posicién DC OUT.

Si disminuye la tension de salida del
adaptador de CA

Si la tension de salida del adaptador de CA
desciende por debajo de un determinado nivel
durante el funcionamiento (DC Low Voltagel
state), aparecerd un mensaje informandole de que
la tension ha disminuido, el indicador de
grabacién comenzard a parpadear y se escuchard
un pitido.

Si la tension de salida del adaptador de CA
desciende por debajo del nivel minimo requerido
para el funcionamiento (DC Low Voltage?2 state),
aparecerd un mensaje informandole de que la
tension de salida del adaptador de CA es
demasiado baja.



En ese caso, es posible que el adaptador de CA
esté defectuoso. Si es necesario, verifique el
adaptador de CA.

Cambio de los niveles de advertencia

El nivel DC Low Voltagel estd ajustado en

11,5 V y el nivel DC Low Voltage2 estd ajustado
en 11,0 V de manera predeterminada de fébrica.
Puede cambiar la configuracion del nivel de
advertencia en Camera DC IN Alarm

(pdgina 102) en el menud System.

Adaptadores de CA

« No conecte ni utilice un adaptador de CA en
espacios reducidos, como por ejemplo, entre
una pared y un mueble.

¢ Conecte el adaptador de CA a la toma de
corriente mds cercana. Si se produce algtin
problema durante el uso, desconecte
inmediatamente el cable de alimentacion de la
toma de corriente.

* No provoque un cortocircuito en las piezas
metdlicas del enchufe del adaptador de CA. Si
lo hace, provocard un fallo de funcionamiento.

 La bateria no se puede cargar mientras estd
conectada al camcorder aunque el adaptador de
CA esté conectado.

Acople de dispositivos

Acople del soporte de micréfono
[ Notas

« El soporte de micr6fono viene acoplado de fabrica.

* Acople o retire el soporte de micréfono mientras el
camcorder estd apagado.

* Acople o retire el soporte de micréfono con la tapa de
la montura acoplada de manera que no se dafie el
sensor de imagen.

1 Introduzca el soporte de micréfono en
el asa.

2 Introduzcala pieza de cierre en la
cavidad y apriete el tornillo para fijar el
soporte.

Pieza de
cierre



Extraccion del soporte de microfono

Ajuste del angulo del visor

Extraiga la pieza de cierre y siga los pasos del
procedimiento de acople del soporte de
micréfono en orden inverso.

Acople del visor
[ Nota |

Acople o retire el visor mientras el camcorder esté
apagado.

1 Afloje la abrazadera del visor e inserte
el visor en el saliente de la parte frontal
del asa.

Abrazadera

2 Ajuste el posicionamiento izquierdo/
derecho del visor, apriete la abrazadera
y, a continuacion, conecte el cable del
visor al conector del visor del
camcorder.

Compruebe que el visor esté conectado de forma segura.
El visor puede caerse durante la filmacién si la
abrazadera estd suelta.

Incline el visor hacia arriba/abajo para ajustar el
angulo del visor.

Puede ajustar el dngulo de manera que el visor
esté orientado hacia el sujeto. Si se ajusta el
interruptor MIRROR (pdgina 51) en B/T, se
invierten los lados izquierdo y derecho de la
imagen en la pantalla LCD, pero la imagen se
grabard en la orientacion correcta.

Ajuste del contraste del visor

Gire el dial CONTRAST para ajustar el contraste.

Puede ajustar el brillo en el visor mediante VF
Setting >Brightness (pdgina 85) en el mend VF.

Extraccion del visor

Afloje la abrazadera del visor y siga los pasos del
procedimiento de acoplamiento del visor en
orden inverso.



Acople del ocular Apertura del ocular

m Pulse el botén indicado por la flecha.

Acople o retire el ocular mientras el camcorder estd
apagado.

1 Acople las abrazaderas de metal del
ocular a los ganchos de conexién del
ocular en el visor.

Abra el ocular hacia arriba cuando se desconecta
el bloqueo. El visor se puede ver directamente
cuando el ocular se abre.

Ganchos de conexion del ocular

2 Pulsela placa de fijacion en la parte
inferior del ocular en la direccion de la
flecha para fijar el ocular en posicion.

Placa de
fijacion

Extraccion del ocular

Desconecte el bloqueo del ocular y extraiga el
ocular del visor.
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Acople de un objetivo

Objetivos recomendados
SELP28135G
SEL1635Z

SELP18200

Para obtener mds informacion acerca de los
objetivos compatibles con el camcorder, pongase en
contacto con el servicio de asistencia técnica de
Sony.

Precaucion

No deje el objetivo orientado directamente al sol.
La luz directa del sol puede penetrar a través del
objetivo, enfocarse en el camcorder y provocar un
incendio.

* Acople o retire los objetivos mientras el camcorder
esté apagado.

* Los objetivos son componentes de precision. No
coloque los objetivos sobre una superficie dejando la
montura de estos orientada hacia abajo. Acople la tapa
de la montura del objetivo suministrada.

Acoplamiento en un tripode

Utilice los orificios para los tornillos del tripode

del camcorder cuando la acople a un tripode.

Utilizar el soporte para tripode en el objetivo

podria ocasionar dafios.

Acople de un objetivo de montura E

1 Extraiga la tapa del objetivo y la
cubierta del camcorder y el objetivo.
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2 Alinee la marca de la montura del
objetivo (blanca) con el camcorder,
introduzca con cuidado el objetivo y, a
continuacién, gire el objetivo en el
sentido de las agujas del reloj.

Suena un clic cuando el objetivo se bloquea
en su posicion.

Marca de la montura
(blanca)

Acople de un objetivo de montura A

Para utilizar un objetivo de montura A, acople un
adaptador de montura de objetivos (opcional) y, a
continuacidn, acople el objetivo de montura A.

 Cuando utilice un objetivo de montura A, el diafragma
se ajusta en manual.

* Cuando se ajusta el enfoque en AF con un LA-EA2 o
LA-EA4 acoplado, el diafragma se ajusta en F3.5 o
totalmente abierto.

Extraccion de un objetivo

Extraiga un objetivo a través del siguiente
procedimiento.

1 Mantenga pulsado el botén de
liberacion del objetivo y gire el objetivo
en sentido contrario a las agujas del
reloj.

2 Tire del objetivo hacia afuera en
direccion de avance.

Si no se va a acoplar otro objetivo inmediatamente,
ajuste la montura del objetivo en la zona de la cavidad de
la montura del objetivo y girelo en el sentido de las
agujas del reloj.



Ajustes de diafragma para objetivos con
interruptor Auto Iris

¢ Cuando la funcién Auto Iris del objetivo se
ajusta en AUTO, el diafragma se ajusta
automaticamente y también se puede ajustar
manualmente desde el camcorder.

Cuando la funcién Auto Iris del objetivo se
ajustaen MANUAL, el diafragma solo se puede
ajustar usando el anillo del objetivo. El
funcionamiento del diafragma desde el
camcorder no tiene ningin efecto.

Ajustes de enfoque para objetivos con
interruptor FOCUS

» Cuando el interruptor de enfoque del objetivo se
ajusta en AF/MF o AF, el enfoque se ajusta
automaticamente y también se puede ajustar
manualmente desde el camcorder.

Cuando el interruptor de enfoque del objetivo se
ajusta en Full MF o MF, el enfoque solo se
puede ajustar usando el anillo del objetivo. El
funcionamiento del enfoque desde el camcorder
no tiene ningin efecto.

Acople del control remoto de Ia
empunadura

Acople o retire el control remoto de la empuiadura
mientras el camcorder esté apagado.

1 Conecte el brazo al acoplamiento de la
empuiiadura y apriete el tornillo.

2 Conecte el cable del control remoto de
la empuiiadura al conector REMOTE
del camcorder.




« Compruebe que el brazo y el control remoto de la

empufiadura estén conectados de manera segura.
Pueden caerse durante la filmacion si los tornillos
estdn sueltos.

* No apoye el peso del camcorder sujetando solamente

el control remoto de la empufiadura.

Ajuste de la posicion del control remoto
de la empuiadura

Ajuste el dngulo del brazo (@).

Afloje los dos tornillos de la parte posterior del
brazo con una moneda o un objeto similar, ajuste
la longitud del brazo (@) y, a continuacion,
apriete los dos tornillos.

Pulse el botdn de rotacién de la empunadura
(pdgina 11) para ajustar el dngulo del control
remoto de la empunadura (@).

Extraccion del control remoto de la
empuiadura

1

Desconecte el cable del control remoto
de la empuiiadura del conector
REMOTE del camcorder.

Extraiga el brazo del camcorder.
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Ajuste del reloj

La pantalla de ajustes iniciales aparece en el visor
la primera vez que se enciende el camcorder o
después de que la bateria de reserva se haya
descargado completamente.

Ajuste la fecha y la hora del reloj interno en esta
pantalla.

Time Zone

Time Zone ajusta la diferencia horaria desde UTC
(Tiempo Universal Coordinado). Cambie el
ajuste seglin sea necesario.

Ajuste de la fecha y la hora

Gire el dial SEL/SET (pdgina 9) para seleccionar
elementos y ajustes y, a continuacion, pulse el
dial SEL/SET para aplicar la configuracién y que
el reloj comience a funcionar.

Después de cerrar la pantalla de ajustes, puede
cambiar los ajustes de fecha, hora y zona horaria
en Clock Set (pdgina 101) en el menu System.

« Siel ajuste del reloj se pierde debido a que la bateria de
reserva se descarga totalmente por el hecho de
permanecer desconectado durante un periodo
prolongado (sin bateria ni fuente de alimentacién DC
IN), se mostrard la pantalla de ajustes iniciales la
proxima vez que encienda el camcorder.

Mientras se muestra la pantalla de ajustes iniciales, no
podrd realizar ninguna otra operacion, excepto apagar
el dispositivo, hasta que se completen los ajustes en
esta pantalla.

El camcorder dispone de una baterfa recargable
incorporada que almacena la fecha, la hora y otros
ajustes incluso cuando estd apagado. Si desea obtener
mds informacion acerca de la baterfa recargable
incorporada, consulte pdagina 108.



Configuracion del
funcionamiento bhasico
del camcorder

Antes de filmar, configure el funcionamiento
bésico del camcorder que mejor se adapte a su
uso.

Modo de filmacion

Puede cambiar el modo de filmacion entre el
modo “Custom” para crear imdgenes de manera
flexible in situ y el modo “Cine EI” (donde el
camcorder funciona de manera similar a una
cdmara de cine y el metraje se revela en
postproduccién).

Puede seleccionar el modo en Base Setting
(pdgina 96) >Shooting Mode en el ment System.

Espacio de color

El espacio de color selecciona una gama de
colores base para las sefiales grabadas y las
sefiales de salida.

Si el modo de filmacién estd ajustado en modo
Custom, el espacio de color se ajusta en “Matrix”.
Matrix: permite seleccionar la gama de colores

mediante el pardmetro Matrix, similar a las
cdmaras de video convencionales.
Si el modo de filmacion estd ajustado en el modo
Cine EI, el espacio de color permite seleccionar la
gama de colores de la salida de video con el ajuste
MLUT establecido en Off.

S-Gamut/SLog2: amplia gama de colores
comparable a la de las cdmaras
cinematograficas.

S-Gamut3.Cine/SLog3: gama de colores ficil de
ajustar para el cine digital (DCIP3).

S-Gamut3/SLog3: amplia gama de colores que
ofrece compatibilidad con gamas estdndar
futuras, optimizada con la tecnologfa de
correccién de distorsién de imagen de Sony.

Puede seleccionar la gama de colores en Base
Setting (pdgina 96) >Color Space en el menu
System.
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Modo de escaneado del sensor de
imagen

Puede establecer el modo de escaneado del sensor
de imagen.

Puede seleccionar el modo en Base Setting
(pdgina 96) >Imager Scan Mode en el menu
System.

Normal: cuando no se estd utilizando el modo de
velocidad de fotogramas alta Slow & Quick
Motion, escanea el dngulo de visién completo
de tamafio Sdper de 35mm.

Cuando S&Q Motion (pdgina 90) >High
Frame Rate Mode en el menu Recording estd
ajustado en “Full Scan,” escanea el dngulo de
visiéon completo de tamaifio Stper de 35mm y
convierte la sefial en datos 2K. Cuando estd
ajustado en “Center Scan”, escanea un dngulo
de vision 2K de tamafio medio Stper de
35mm en el centro de la imagen.

2K Full: escanea el angulo de visiéon completo de
tamafio Super de 35mm y convierte la sefial
en 2K.

2K Center: escanea un angulo de visién 2K de
tamafio medio Stper de 35mm en el centro de
la imagen.

Laresolucién del formato de grabacién esta restringida a
2K o inferior cuando el Imager Scan Mode (pdgina 97)
estd ajustado en 2K Full o 2K Center.



Utilizacion de tarjetas
de memoria XQD

El camcorder graba audio y video en tarjetas de
memoria XQD (disponibles por separado)
introducidas en las ranuras para tarjetas.

Acerca de las tarjetas de memoria
Xab

Utilice las siguientes tarjetas de memoria XQD de
Sony en el camcorder.

Para obtener mds informacion sobre las
operaciones con soportes de otros fabricantes,
consulte las instrucciones de mantenimiento de
dichos soportes o la informacién del fabricante.

Tarjetas de memoria XQD serie S

Tarjetas de memoria XQD serie H
Tarjetas de memoria XQD serie N
Tarjetas de memoria XQD serie M
Tarjetas de memoria XQD serie G

No se garantiza el uso de otras tarjetas de
memoria XQD que no sean de Sony.

Para obtener mds informacion acerca del uso de
tarjetas de memoria XQD 'y las precauciones de uso,
consulte las instrucciones de funcionamiento de las
tarjetas de memoria XQD.
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Soportes recomendados

Las condiciones de funcionamiento garantizadas variardn segtin los ajustes de Rec Format y Recording.
Si: operacion admitida
No: no se garantiza un funcionamiento normal

Formato XQDb G XQD N Descatalogados:
XQD S XQDM XQD H
(EB Stream) XQD S
(sin EB Stream)
32/64/128 GB 32/64/128 *1 GB 16/32/64 GB

XAVC-I 4096 x 2160P — 59.94P Si No No

50p Si No No

29.97p Si No No

25p Si No No

24p Si No No

23.98P Si No No

3840 x 2160 — 59.94P Si No No

50P Si No No

29.97P Si No No

25P Si No No

23.98P Si No No

1920 x 1080 Modo normal o 59.94P Si No No

S&Q (excepto 59.94i S s No

HFR %) 50P st No No

501 Si Si No

29.97P Si Si No

25P Si Si No

23.98P Si Si No

S&Q (modo HFR)  59.94P Si No No

50P Si No No

29.97P Si No No

25P Si No No

23.98P Si No No
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Formato XQDb G XQD N Descatalogados:
XQDb S XQD M XQD H
(EB Stream) XQD S
(sin EB Stream)
32/64/128 GB 32/64/128 "1 GB 16/32/64 GB
XAVC-L 3840 x 2160 — 59.94pP Si Si No
50P Si St No
29.97pP Si St No
25P Si Si No
23.98P Si St No
1920 x 1080 Modo normal o 59.94P Si Si Si
S&Q (excepto HFR) 50P St St St
59.94i Si Si Si
501 Si Si Si
29.97P Si Si Si
25P Si Si Si
23.98P Si Si Si
1920 x 1080 S&Q (modo HFR)  59.94P Si Si No
50P Si Si No
29.97P 50 Mbps: No
Si 35 Mbgs; Si No
25P Si No No
23.98P Si No No
MPEG HD 1920 x 1080 — 59.94i Si Si Si
422 50i Si Si Si
29.97P Si Si Si
25P Si St Si
23.98P Si Si Si
1280 x 720 - 59.94P Si Si Si
50p Si Si Si
29.97P Si Si Si
25P Si Si Si
23.98P Si Si Si
ProRes 422 1920 x 1080 — 59.94i Si No No
HQ 50 Si No No
29.97pP Si No No
25P Si No No
23.98P Si No No
ProRes 422 1920 x 1080 — 59.94i Si St No
501 Si Si No
29.97pP Si St No
25P Si Si No
23.98P Si St No

*1 Solo para la serie M
*2 HFR: velocidad de fotogramas alta
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Introduccion de una tarjeta de
memoria XQD

1 Pulse el botén de liberacién de la tapa
de soportes (pdgina 10) para abrir la
tapa de soportes de la seccion de la
ranura para tarjetas.

2 Introduzca una tarjeta de memoria
XQD con al etiqueta XQD orientada
hacia la izquierda.

El indicador de acceso (pdgina 10) se
iluminard en rojo y, a continuacién, cambiara
a verde si la tarjeta se puede utilizar.

3 Cierrela tapa de soportes.

La tarjeta de memoria, la ranura de la tarjeta de
memoria y los datos de imagen de la tarjeta de
memoria pueden resultar dafiados si la tarjeta se
introduce a la fuerza en la ranura en la orientacién
incorrecta.

Cuando grabe en los soportes utilizando ambas ranuras
de tarjeta XQD, la A y la B, inserte los soportes en las
dos ranuras que se recomiendan para su
funcionamiento con el formato que desea grabar.

Extraccion de tarjetas de memoria
XaD

Pulse el botdn de liberacion de la tapa de soportes
(pdgina 10) para abrir la tapa de soportes de la
seccion de la ranura para tarjetas y presione
ligeramente la tarjeta de memoria para extraerla.

Si el camcorder estd apagado o si se extrae la tarjeta de
memoria mientras se estd accediendo a esta, no se
podré garantizar la integridad de los datos de la tarjeta.
Es posible que se pierdan todos los datos grabados en
la tarjeta. Asegurese de que el indicador de acceso esté
siempre iluminado en color verde o apagado antes de
apagar el camcorder o extraer la tarjeta de memoria.
Cuando extraiga una tarjeta de memoria XQD
inmediatamente después de finalizar una grabacion, es
posible que la tarjeta de memoria XQD esté caliente
pero esto no indica un problema.
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Intercambio de tarjetas de
memoria XQD

Cuando se han cargado tarjetas de memoria XQD
tanto en la ranura A como en la B, puede cambiar
la tarjeta utilizada para grabaciones con tan solo
pulsar el botén SLOT SELECT (pdgina 9).

Si una tarjeta se llena por completo durante la
grabacion, el camcorder cambia automaticamente
a la otra tarjeta.

El botéon SLOT SELECT esté deshabilitado durante la
reproduccion. Las tarjetas de memoria no se
intercambian incluso si pulsa el botén. El botén estd
habilitado mientras se muestra la pantalla de miniaturas
(pdgina 58).

Formateo (inicializacion) de
tarjetas de memoria XQD

Si se introduce una tarjeta de memoria XQD sin
formatear o formateada con especificaciones
diferentes, aparecera en el visor el mensaje
“Media Needs to be Formatted”.

Formatee la tarjeta mediante el siguiente
procedimiento.

Seleccione Format Media (pdgina 93)
>Media(A) o Media(B) en el meni Media y,
a continuacion, seleccione Execute. Cuando
aparezca un mensaje de confirmacion,
vuelva a seleccionar Execute.

Se mostrard un mensaje durante el formateo y el
indicador de acceso se iluminard en rojo.
Cuando se haya completado el formateo, se
mostrard un mensaje de finalizacion. Pulse el dial
SEL/SET para ignorar el mensaje.

Si el formateo no se completa correctamente
Las tarjetas de memoria XQD protegidas y las
tarjetas de memoria no compatibles con el
camcorder no se podrdn formatear.

Se mostrard un mensaje de advertencia. Siga las
instrucciones para sustituir la tarjeta por una
tarjeta de memoria XQD compatible.

Al formatear una tarjeta de memoria se borran todos los
datos, incluidos los archivos de configuracién y los datos
de videos grabados.



Comprobacion del tiempo de
grabacion restante

Durante la filmacién (grabacién/en espera),
puede comprobar la capacidad restante de la
tarjeta de memoria XQD en cada ranura mediante
los indicadores de capacidad de los soportes A/B
en el visor (pdgina 13).

El tiempo de grabacion restante se calcula a partir
de la capacidad restante de los soportes en cada
ranura y del formato de video actual (velocidad de
bits de grabacion), y se mostrara en minutos.

Si los soportes estan protegidos se mostrara la marca B.

Tiempo de cambio de tarjetas de
memoria XQD

 Cuando el tiempo de grabacion restante total en
las dos tarjetas de memoria es inferior a 5
minutos, aparece el mensaje “Media Near Full”,
el indicador de grabacién comienza a parpadear
y se escucha un pitido (salida de auriculares) de
advertencia.

Introduzca algiin soporte que disponga de
espacio.

Si continda grabando hasta que el tiempo
restante de grabacion total llegue a cero, el
mensaje cambiard a “Media Full” y la grabacién
se detendrd.

En una tarjeta de memoria XQD se pueden grabar hasta
600 clips aproximadamente.

Si el nimero de clips grabados alcanza el limite, el
indicador de tiempo de grabacion restante cambiard a “0”
y también aparecerd el mensaje “Media Full”.
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Utilizacion de una
tarjeta UTILITY SD

Puede guardar datos de configuracién de la
cdmara para el camcorder en una tarjeta SD
(disponible por separado). Los archivos de datos
guardados se pueden importar desde la tarjeta SD.

Tarjetas SD compatibles

Tarjetas de memoria SDHC*
Tarjetas de memoria SD*

* En este manual se denominan de manera general como
“tarjetas SD”.

Introduccion de una tarjeta SD

1 Pulse el botén de liberacién de la tapa
de soportes (pdgina 10) para abrir la
tapa de soportes de la seccion de la
ranura para tarjetas.

2 Introduzca una tarjeta de memoria SD
con al etiqueta SD orientada hacia la
izquierda.

El indicador de acceso (pdgina 10) se
iluminard en rojo y, a continuacion, se
apagard si la tarjeta se puede utilizar.

3 Cierre la tapa de soportes.

Extraccion de la tarjeta SD

Pulse el boton de liberacion de la tapa de
soportes (pdgina 10) para abrir la tapa de
soportes de la seccién de la ranura para
tarjetasy presione ligeramente la tarjeta SD
para extraerla.

Si el camcorder estd apagado o si se extrae la tarjeta SD
mientras se estd accediendo a esta, no se podra
garantizar la integridad de los datos de la tarjeta. Es
posible que se pierdan todos los datos grabados en la
tarjeta. Asegtrese de que el indicador de acceso esté
siempre apagado antes de apagar el camcorder o
extraer la tarjeta SD.

Tenga cuidado para evitar que la tarjeta SD se caiga al
introducirla o extraerla.



Formateo (inicializacién) de
tarjetas SD

Es necesario formatear las tarjetas SD la primera
vez que se van a utilizar en el camcorder.

Las tarjetas SD que se vayan a utilizar en el
camcorder se deben formatear mediante la
funcién de formateo del camcorder. Si aparece un
mensaje cuando la tarjeta SD se introduce en el
camcorder, formatee la tarjeta SD.

Seleccione Format Media (pdgina 93) >SD
Card en el meni Media y, a continuacion,
seleccione Execute. Cuando aparezca un
mensaje de confirmacién, vuelva a
seleccionar Execute.

Se mostrard un mensaje y el estado de avance
durante el formateo y el indicador de acceso se
iluminara en rojo.

Cuando se haya completado el formateo, se
mostrard un mensaje de finalizacion. Pulse el dial
SEL/SET para ignorar el mensaje.

Al formatear una tarjeta SD se borran todos los datos de
esta. La tarjeta no se podra restaurar.

Comprobacion de la capacidad
restante

Puede comprobar la capacidad restante de una
tarjeta SD en la pantalla Media Status
(pdgina 17).

Si la tarjeta SD estd protegida se mostrard la marca (@ .

Para utilizar una tarjeta SD formateada con el
camcorder en la ranura de otro dispositivo

En primer lugar, realice una copia de seguridad de
la tarjeta y, a continuacién, vuelva a formatear la
tarjeta en el dispositivo que se va a utilizar.

Uso de la XDCA-FS7

Puede afiadir funciones al camcorder como, por
ejemplo, una bateria tipo V o una sefial de
sincronizacién externa; para ello, conecte una
unidad de extensiéon XDCA-FS7 (opcional) al
camcorder.

Acople de la XDCA-FS7
 Notas

La bateria del camcorder no se puede utilizar cuando la
unidad XDCA-FS7 también estd conectada al
camcorder. Deberd acoplar la bateria a la XDCA-FS7
o conectar el camcorder a una toma de alimentacion
externa.

Acople o retire la unidad XDCA-FS7 mientras el
camcorder esté apagado.

1 Extraiga la bateria (pdgina 19)
acoplada al camcorder.

2 Retirela tapa de la seccion del conector
de la unidad de extension.




3 Alinee los salientes de la XDCA-FS7 con La cubierta de la seccién del conector de la

las ranuras izquierda y derecha del unidad de extensi6n se puede insertar en la
camcorder y deslicelo por completo. parte superior de la unidad de extension.
Luego deslice la XDCA-FS7 hacia abajo

en la seccion del conector. @,

I

Ranuras Salientes

. o Extraccion de la XDCA-FS7

4 Apriete los dos tornillo situados en la

parte superior de la XDCA-FS7 para Afloje los dos tornillos de la parte superior de la

asegurar la unidad. XDCA-FS7 y retire la unidad del camcorder.
Colocacion de la bateria
Introduzca la bateria en el acople de esta en la
XDCA-FS7.
Extraccion de la bateria
Tire de la bateria hacia afuera del acople de esta

en la XDCA-FS7 mientras mantiene pulsado el
botén BATT RELEASE.

Cambio de la entrada/salida de
cddigo de tiempo

Puede cambiar la entrada/salida de cédigo de
tiempo con el interruptor TC IN/OUT
(pdgina 12).

Para obtener mds detalles, consulte pdgina 106.
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Uso de las unidades
HXR-IFR5 y AXS-R5

Puede grabar video RAW (pdgina 53) en una
unidad AXS-R5 RAW Recorder (opcional)
mediante una unidad de interfaz HXR-IFR5
(opcional) y una XDCA-FS7 (opcional).

Para obtener mds informacion acerca de la
configuracién de la HXR-IFRS5 y AXS-RS5,
consulte el manual de funcionamiento de la HXR-
IFR5.

Conexion de la HXR-IFR5 al
camcorder

1 Acople la XDCA-FS7 al camcorder
(pdgina 33).

2 Conecte el conector RAW OUT de la
XDCA-FS7 al conector SDI IN (RAW)
de la HXR-IFRS mediante un cable
SDI.

HXR-IFR5

Extraccion de la HXR-IFR5

Desconecte el cable SDI del conector RAW
OUT de la XDCA-FS7.

Uso del control remoto
de infrarrojos

Primer uso

Tire de la pelicula aislante del soporte de baterfas
cuando utilice por primera vez el control remoto
de infrarrojos suministrado.

Pelicula aislante

1

reg

En el soporte de baterias viene preinstalado de
fébrica una bateria de iones de litio CR2025.

Control del camcorder con el control
remoto

Para utilizar el control remoto, primero encienda
el camcorder y, a continuacidn, active el
funcionamiento del control remoto.

Utilice el meni de configuracién para activar o
desactivar el funcionamiento del control remoto.

Para activarlo mediante el meni

Pulse el boton MENU para cambiar el camcorder
al modo ment y, a continuacion, ajuste IR
Remote (pdgina 102) en On en el mend System.

* Apunte el control remoto hacia el sensor del receptor
de control remoto del camcorder.

* Configure el camcorder de manera que el sensor del
receptor del control remoto no esté expuesto a la luz
directa del sol ni a una luz fuerte de otras fuentes. Las
luces potentes pueden dificultar el funcionamiento
correcto del control remoto.

* Es posible que otras unidades de video se pongan en
funcionamiento por error al utilizar el control remoto
suministrado para controlar el camcorder. En tal caso,
cambie el interruptor de modo del control remoto en la
unidad de video a DVD2 o cubra el sensor del receptor
del control remoto con papel negro.



Cambio de la bateria del control remoto

El control remoto utiliza una bateria estandar
CR2025.
No utilice una bateria distinta a la CR2025.

1 Empuje la pestaiia hacia adentro y
extraiga el soporte de la bateria
introduciendo una ufia en la ranura.

2 Introduzca una bateria nueva con el
terminal + orientado hacia arriba.

3 Introduzca el soporte de la bateria
hasta que encaje en su lugar.

)
Pestafia }@ =

Precaucion

No guarde las baterfas en lugares expuestos a la
luz solar directa, cerca de fuegos ni a temperatura
elevadas.

Sustituir una bateria por otra no especificada puede
provocar averfas en el dispositivo. Utilice siempre las
baterias especificadas.

Elimine las baterfas usadas de acuerdo con las leyes
locales y nacionales.

Uso del control remoto
Wi-Fi

Puede utilizar el camcorder desde un navegador
web; para ello, conecte un smartphone, una
tableta u otro dispositivo que utilice un navegador
web al camcorder mediante una conexiéon LAN
inaldmbrica. Esta funcién de denomina control
remoto Wi-Fi.

Esta funcion resulta ttil cuando se utiliza el
camcorder desde una ubicacién remota como, por
ejemplo, cuando el camcorder estd montado en
una grua.

Para obtener mds informacion acerca del
procedimiento de configuracion del control
remoto Wi-Fi, consulte pdgina 57.

Pantalla remota Wi-Fi (smartphone)
Pantalla Main

* Ajustes
S&Q FPS, Shutter,
White, Sensitivity/
Gain/Exposure Index,
Gamma, MLUT, Color
Bars, Auto Black,
Auto White, Rec Start/
Stop, Lock, Iris, Focus,
Zoom, Auto Iris, Auto
Shutter, AGC, ATW

Auto Black



Pantalla Playback

Camera Control

A001C001
S26min [

Playback Cursor

Assign  Main

Pantalla Cursor

ESi26min (IO

Assign  Main

Thumbnail

Playback _C

User Menu

Pantalla Assign

Camera Control

[ES26min [N O

Main  Playback Cursor

 Estado

* Botones de
reproduccién
Play/Pause, Stop, F
Fwd, F Rev, Next, Prev

Estado

Botones del cursor
Up, Down, Left, Right,
Set, Cancel/Back,
Menu, Status,
Thumbnail, User
Menu

* Estado

* Botones asignables
Botones asignables de
la6
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Pantalla Wi-Fi Remote (tableta)
Pantalla Main

Camera Control

23:01:52:

Playback

Auto Black

e Ajustes
S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure
Index, Gamma, MLUT, Color Bars, Auto Black, Auto
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto
Iris, Auto Shutter, AGC, ATW

Pantalla Playback
Control

23:01:52:2

1

Assign Cursor

* Estado
* Bot6n de reproduccién
Play/Pause, Stop, F Fwd, F Rev, Next, Prev



Pantalla Cursor
Camera Control

23:01:52:29

Assign Main  Playback

.

« Estado
* Botones del cursor

Up, Down, Left, Right, Set, Cancel/Back, Menu,

Status, Thumbnail, User Menu

Pantalla Assign

Camera Control

Main  Playback  Cursor

* Estado
« Botones asignables
Botones asignables de 1 a 6
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Procedimiento basico de funcionamiento

La filmacidn bésica se realiza mediante el
siguiente procedimiento.

1 Acople los dispositivos necesarios y
compruebe que se suministra la
alimentacion necesaria.

Introduzca las tarjetas de memoria.

3 Coloque el interruptor POWER en la
posicion ON.

Laimagen de la cdmara aparecerd en el visor.

4 Ppulse el botén de grabacion (pdgina 7).

El indicador de grabacion se encenderd y el
camcorder comenzard a grabar.

O Para detener la grabacién, pulse el
botén de grabacion de nuevo.

La grabacion se detendrd y el camcorder
cambiard al modo STBY (en espera).

Si se pulsa el bot6n de grabacién pocos segundos
después de encender la videocdmara, el indicador de
grabacion se iluminard para indicar que la unidad se
encuentra en estado de grabacion; pero es posible que la
grabacion en los soportes no se produzca durante los
primeros segundos, segtn el formato de grabacién
seleccionado.

Filmacion (Modo automatico completo)

Pulse el botén FULL AUTO y gire el indicador
del bot6n hasta que se encienda.

Las funciones de diafragma automadtico (solo
objetivos compatibles), AGC, obturador
automdtico y ATW (localizacién automdtica del
balance de blancos) se habilitan para controlar el
brillo y el balance de blancos automdaticamente
(modo automdtico completo).

Para controlar cada funcién manualmente, gire el
interruptor del modo automatico completo a la
posicion Off.

Grabacion continua mientras se cambian
las tarjetas de memoria (Relay Rec)

Cuando las tarjetas de memoria se introducen en
las ranuras A 'y B, la grabacion cambia
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automaticamente a la segunda tarjeta de memoria
justo antes de que la capacidad restante de la
primera tarjeta se reduzca a cero.

* No extraiga una tarjeta de memoria mientras se esté
grabando en ella. Cambie solo las tarjetas de memoria
en las ranuras cuyo indicador de acceso esté apagado.
Cuando la capacidad restante de la tarjeta de memoria
en la que se estd grabando es inferior a un minuto y en
la otra ranura se ha insertado otra tarjeta de memoria en
la que se puede grabar, aparecerd el mensaje “Will
Switch Slots Soon”. El mensaje desaparecerd después
de cambiar las ranuras de tarjeta de memoria.

Es posible que la grabacién continua no funcione si la
grabacion comienza cuando la capacidad restante de la
tarjeta de memoria es inferior a un minuto. Para una
grabacion continua correcta, compruebe que la
capacidad restante de la tarjeta de memoria es superior
a un minuto antes de comenzar a grabar.

* Los videos creados con la funcién de grabacion
continua del camcorder no se pueden reproducir sin
interrupciones en el camcorder.

Para combinar los videos creado con la funcion de
grabacion continua del camcorder, utilice el software
Catalyst Browse.

Grabacidn en la tarjetas de memoria Ay
B simultaneamente (Simul Rec)

Puede grabar simultdneamente en las dos tarjetas
de memoria Ay B.

Ajuste Simul Rec >Setting en el meni
Recording en “On”.

La grabacién simultdnea no es compatible con el modo
de Slow & Quick Motion (pdgina 90) ni con el modo de
grabacién Picture Cache (pdgina 91).

Ademds, la grabacion simultdnea no es compatible con
los siguientes formatos de grabacién (pdgina 97).

Area NTSC

XAVC-1

4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 24.00P, 4096 x 2160 23.98P,
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P
XAVC-L

3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P



RAW (con las unidades XDCA-FS7, HXR-IFR5
y AXS-RS5 conectadas)

4096 x 2160 59.94P, 4096 x 2160 29.97P,

4096 x 2160 23.98P, 2048 x 1080 59.94P,

2048 x 1080 29.97P, 2048 x 1080 23.98P

RAW y XAVC-I (con las unidades XDCA-FS7,
HXR-IFRS5 y AXS-RS5 conectadas)

4096 x 2160 59.94P, 2048 x 1080 59.94P
ProRes 422 HQ, ProRes 422 (con la unidad
XDCA-FS7 conectada)

1920 x 1080 59.94i, 1920 x 1080 29.97P,

1920 x 1080 23.98P

Area PAL
XAVC-1
4096 x 2160 50P, 4096 x 2160 25P,
3840 x 2160 50P, 3840 x 2160 25P,
1920 x 1080 S0P
XAVC-L
3840 x 2160 50P, 3840 x 2160 25P
RAW (con las unidades XDCA-FS7, HXR-IFR5
y AXS-RS conectada)
4096 x 2160 50P, 4096 x 2160 25P,
2048 x 1080 50P, 2048 x 1080 25P
RAW y XAVC-I (con las unidades XDCA-FS7,
HXR-IFRS5 y AXS-RS5 conectadas)
4096 x 2160 50P, 2048 x 1080 S0P
ProRes 422 HQ, ProRes 422 (con la unidad
XDCA-FS7 conectada)
1920 x 1080 50i, 1920 x 1080 25P

Cambio de los ajustes de los hotones de
grabacion START/STOP en el camcorder
yenel asa

Cuando se habilita la grabacion (Simul Rec),
puede iniciar y detener la grabacion en cada
tarjeta de memoria de forma independiente con
los botones START/STOP de grabacion en el
camcorder y en el asa.
Segtin el ajuste predeterminado de fabrica, ambos
botones se han configurado para iniciar y detener
la grabacion simultdnea en ambas tarjetas A y B.
¢ “Rec Button [SlotA SlotB] Handle Rec Button
[SlotA SlotB]”
Cuando los botones se establecen para controlar
la grabacion de diferentes tarjetas de memoria,
SDI/HDMI Rec Control y RAW Rec Control
siguen el estado de grabacion de la ranura A.
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Para cambiar el ajuste

Seleccione Simul Rec >Rec Button Set en el
meni Recording.

Rec Button Set Botones y tarjetas de

memoria
“Rec Button Inicia y detiene la grabacion
[SlotA SlotB] simultdnea en las tarjetas de
Handle Rec memoria A y B con cualquiera de
Button [SlotA los botones.
SlotB]”
“Rec Button El botén START/STOP inicia y
[SlotA] Handle detiene la grabacién en la tarjeta
Rec Button de memoria A, y el botén START/
[SlotB]” STOP de grabacién del asa inicia
y detiene la grabacién en la tarjeta
de memoria B.
“Rec Button El bot6n START/STOP inicia y
[SlotB] Handle detiene la grabacién en la tarjeta
Rec Button de memoria B, y el boton START/
[SlotA]” STOP de grabacién del asa inicia

y detiene la grabacién en la tarjeta
de memoria A.

Ajuste automatico del enfoque

Se necesita un objetivo compatible con enfoque
automatico. Sitde el interruptor FOCUS

(pdgina 9) del camcorder en la posicién
“AUTO?”. Si el objetivo dispone de interruptor de
seleccion de enfoque, sitde el interruptor en la
posicion “AF/MF” o “AF”. Si se ajusta el
interruptor en la posicién “Full MF” o “MF”, el
enfoque del objetivo no se puede realizar con el
camcorder (pdgina 25).

El LA-EA1/3 (opcional) admite solamente la funcién
Push Auto Focus.

Especificacion del area de enfoque
automatico (Focus Area)

Puede establecer el drea de destino para el
enfoque automadtico mediante Focus > Focus
Area (pdgina 68) en el meni Camera.

En el LA-EA2/4 (opcional), la posicion no se
puede establecer.



Detencidn temporal del enfoque
automatico (Focus Hold)

Enfocar con una visualizacion
aumentada (Focus Magnifier)

Pulse el botén PUSH AUTO FOCUS (pdgina 9)
cuando esté en modo de enfoque automadtico para
anular el enfoque automatico.

Esto resulta util, por ejemplo, cuando frente al
sujeto se cruza algo que no desea enfocar o
cuando se pierde el enfoque automatico.

Ajuste manual del enfoque

Para ajustar el enfoque manualmente, ajuste el
interruptor FOCUS (pdgina 9) en “MAN”.
Esto le permitird ajustar el enfoque manualmente
segtin las condiciones de filmacion.
El enfoque manual resulta ttil para los siguientes
tipos de sujetos.

- Sujetos en la parte mds alejada de una

ventana cubierta por gotas de agua
- Sujetos con poco contraste con el fondo
- Sujetos mas alejados que otros mas cercanos

Ajuste rapido del enfoque con el enfoque
manual (Push Auto Focus)

Sitie al sujeto con el que desee ajustar el enfoque
en el centro de la imagen y, a continuacion, pulse
el botén PUSH AUTO FOCUS (pdgina 9).

El enfoque volverd al ajuste anterior cuando
suelte el boton.

Esto resulta ttil cuando desea enfocar
rdpidamente a un sujeto antes de empezar a
filmar.

Puede establecer la posicién para el enfoque
mediante Focus > Focus Area (Push AF)
(pdgina 68) en el menu Camera.

¢ La funcién Push Auto Focus no se puede utilizar si el
objetivo estd ajustado en enfoque manual.

* Durante el uso de Push Auto Focus cuando se utiliza
LA-EA2/4, el modo Full Auto estd activado.

 Durante la ampliacién del enfoque, el enfoque se ajusta

para adaptarse a la posicion de visualizacién ampliada.

Indicador de enfoque

Indica el estado del enfoque.

« (Encendido): el sujeto estd en el enfoque.

« (Parpadeando): el sujeto estd fuera de enfoque.
Debido a que el enfoque no es automdtico,
cambie los ajustes de composicion y enfoque
para conseguir el enfoque.
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Segtin el ajuste predeterminado de fabrica, la
funcién Focus Magnifier x4/x8 se asigna al botén
ASSIGN4 en el control remoto de la empuiiadura
(pdgina 47).

Pulse el boton ASSIGN4.

La pantalla de ampliacién del enfoque aparecera
con el centro ampliado unas cuatro veces
aproximadamente. Pulse el boton de nuevo para
incrementar el aumento hasta aproximadamente
ocho veces. Esta funcién resulta ttil para
comprobar el enfoque.

Pulse el boton de nuevo para volver a la pantalla
normal.

Puede mover la posicion para que se amplie
durante la ampliacién del enfoque mediante el
selector multiple. Al pulsar el selector miltiple,
se regresa al centro de la imagen. También puede
controlar la posiciéon mediante los botones
izquierdo/derecho y el dial SEL/SET del
camcorder, el controlador remoto de infrarrojos o
el controlador remoto Wi-Fi.

Si se utiliza la funcién Push Auto Focus durante
la ampliacién del enfoque, el enfoque se ajusta
para adaptarse a la posicion de visualizacién
ampliada.

» Laimagen grabada o la imagen de salida SDI/HDMI
no aumenta cuando se aumenta el enfoque.

* Durante el aumento del enfoque, el botén STATUS
CHECK y los botones de ment no se pueden usar.

« La posicién de enfoque desaparece cuando el
camcorder se apaga. Cuando se vuelve a encender el
camcorder, la posicién de ampliacién del enfoque
regresa al centro de la imagen cuando se cambia a la
pantalla de ampliacién del enfoque.



Ajuste del enfoque mediante el indicador
de enfoque asistido

Marco del rango de deteccién del enfoque
(Marcador del area de enfoque)

-T-:I

Indicador de enfoque asistido

La posicién de enfoque estd indicada por el nivel
maximo que alcance la barra. Ajuste el enfoque
para maximizar la longitud de la barra.

Enfocado: posicién del nivel T
maximo que alcance la barra

« Es posible que el indicador de enfoque muestre poca o
ninguna variacién cuando filme sujetos con pocas
diferencias de superficie o en escenas oscuras.

* El rango de deteccién no se puede establecer.

Control del audio

Puede controlar el audio que se estd grabando con
los auriculares.

Al conectar unos auriculares al conector de
auriculares (pdgina 10) podra controlar el audio
que se estd grabando. También puede controlar el
audio de reproduccion (pdgina 59) con el altavoz
integrado (pdgina 10) o con los auriculares.
Puede seleccionar el canal de audio que desea
controlar y ajustar el volumen mediante Audio
Output (pdgina 81) en el ment Audio.

Intercambio de tarjetas de
memoria XQD

Si introduce dos tarjetas de memoria XQD, pulse
el botén SLOT SELECT (pdgina 9) para
intercambiar las tarjetas.

No se pueden intercambiar las tarjetas de memoria
durante el modo de reproduccién. Ademds, la
reproduccién continua de un soporte de duracién de un
clip en la ranura A y B no es compatible.

Clips (datos grabados)

Al dejar de grabar, el video, el audio, y los datos
que los acompafian desde el principio hasta el
final de la grabacion, se guardan como un solo
“clip” en una tarjeta de memoria XQD.

Nombres de clips

A cada clip grabado por el camcorder se le
asigna automdticamente un nombre formado
por la palabra “Clip” y un nimero de 4 digitos.
El nimero de 4 digitos aumenta
automdticamente en cada grabacién.

Puede cambiar el prefijo del “clip” con la
opcion Clip del mend Media.

Duracion maxima de clip

Hasta 6 horas por clip.

Se graban varios clips sucesivamente durante la
grabacion continua, pero la grabacion se
detendra de manera automatica transcurridas
unas 13 horas.




Cambio de la
configuracion basica

Puede cambiar la configuracién segin la
aplicacién de video o las condiciones de
grabacion.

Seleccion del formato de
grabacion

Los formatos disponibles que se pueden
seleccionar varfan segtn los ajustes Country
(regién de uso) y Codec.

Seleccione un formato mediante Rec Format
>Video Format en el menud System.

Ajuste del brillo

Puede ajustar el brillo mediante el ajuste de
diafragma, ganancia y velocidad del obturador y
también mediante el ajuste del nivel de luz con
filtros ND.

Al ajustar el brillo sin usar filtros ND, gire el
interruptor del modo Full Auto a la posicion
(pdgina 39) Off.

Puede ajustar el nivel de brillo en el menu de
configuracion.

Ajuste del nivel de control deseado
Ajuste el nivel de exposicién con Auto Exposure
(pdgina 67) >Level en el menu Camera.

El brillo no puede ajustarse automdticamente en el modo
Cine EIL

Ajuste automatico del diafragma

Esta funcién ajusta el brillo segtin el sujeto. Se
necesita un objetivo compatible con diafragma
automatico.

1 sise acopla un objetivo con interruptor
Auto Iris, coloque el interruptor en
AUTO.

2 Pulse el botén IRIS (pdgina 47) para
activar Auto Iris.

El ajuste alterna entre activado y desactivado
cada vez que se pulsa el boton IRIS.
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El diafragma no se puede ajustar de manera
automdtica en un objetivo de montura A.

Ajuste manual del diafragma

Pulse el botén IRIS para desactivar Auto
Iris y luego ajuste usando el dial IRIS.

También puede asignar la funcién IRIS a un dial
asignable (pdgina 47).

Ajuste temporal del diafragma de forma
automatica

Mantenga pulsado el botén PUSH AUTO IRIS
para activar el diafragma automadtico de forma
temporal.

El diafragma volverd al ajuste anterior cuando
suelte el boton.

Cuando el interruptor Auto Iris del objetivo se ajusta en
“MANUAL?, las funciones Auto Iris y Push Auto Iris
del camcorder no tendrdn ningiin efecto. Los ajustes
manuales de diafragma en el camcorder tampoco tendran
ningun efecto.

Ajuste automatico de la ganancia

Pulse el boton ISO/Gain (pdgina 9) para activar
AGC.

O seleccione Auto Exposure (pdgina 67) >AGC
en el menu Camera y ajistelo en “On”.

Ajuste manual de la ganancia

Puede controlar la ganancia cuando desee ajustar
la exposicion con un ajuste de diafragma fijo, o
bien cuando desee evitar que la ganancia aumente
debido al AGC.

1 Pulseel botén ISO/Gain (pdgina 9) para
desactivar AGC.

2 Ajuste el interruptor GAIN (pdgina 9)
enH,MoL.

Control de la ganancia (ajuste fino)

Gire el dial IRIS, o el dial asignable asignado a la
funcién ISO/Gain/El, para ajustar el valor de
ganancia establecido con el interruptor GAIN.
Esto es til cuando desea ajustar la exposicion en
un nivel sin cambiar la profundidad de campo.
El valor de ganancia ajustado e puede cancelar
con el interruptor GAIN o activando AGC.



Filmacion con obturador automatico

Esta funcién ajusta la velocidad del obturador
automdticamente como respuesta al brillo de la
imagen.

Pulse el boton SHUTTER (pdgina 9).

Si se visualiza la pantalla de ajustes, pulse de
nuevo el botén.

O seleccione Auto Exposure (pdgina 67) >Auto
Shutter en el menti Camera y ajistelo en “On”.

Filmacion con obturador fijo

Puede filmar con una velocidad de obturador
definida.

Pulse el boton SHUTTER para mostrar una
pantalla con los valores de obturador admitidos y,
a continuacion, seleccione y establezca un valor
con el dial SEL/SET. Si vuelve a pulsar el botén
SHUTTER en lugar del dial SEL/SET, se
habilitard el obturador automatico.

Configuracion en el menii Camera
Seleccione Shutter (pdgina 68) en el ment
Camera y ajuste el modo de obturador y la
velocidad.

Ajuste del nivel de luz (filtro ND)

En condiciones donde la luz es demasiado fuerte,
puede ajustar el brillo adecuado si cambia el filtro
ND.

Gire el Dial ND FILTER (pdgina 9) para
seleccionar Clear — 1/4 — 1/16 — 1/64 —
Clear de forma consecutiva.
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Ajuste de colores naturales
(balance de blancos)

Puede seleccionar el modo de ajuste que mejor se
adapte a las condiciones de filmacién.

ATW (localizacién automatica del
balance de blancos)

Esta funcion ajusta el balance de blancos
automdticamente en el nivel adecuado.

El balance de blancos se ajusta automaticamente
cuando la temperatura de color de la fuente de luz
cambia.

Pulse el boton WHT BAL (pdgina 9) para activar
o desactivar ATW.

Puede seleccionar la velocidad de ajuste (cinco
pasos) mediante White >ATW Speed (pdgina 72)
en el mend Paint.

Puede congelar el ajuste del balance de blancos
actual si asigna la funciéon ATW Hold a un botén
asignable (pdgina 47) y pulsa el bot6n asignable
para pausar temporalmente el modo ATW.

* ATW no se puede utilizar en el modo Cine EIL
« Tal vez no sea posible ajustar los colores adecuados
con ATW, segtin las condiciones de iluminacién y del
sujeto.
Ejemplos:
- Cuando un tnico color domina el sujeto, como por
ejemplo el cielo, el mar, la tierra o las flores.
- Cuando la temperatura del color es
extremadamente alta o extremadamente baja.
Si no se puede obtener el efecto adecuado porque
la velocidad de correccion automdtica de ATW es
demasiado lenta o por cualquier otro motivo,
utilice el balance de blancos automdtico.

Ajuste manual del balance de blancos

1 Desactive el modo automatico completo
(pdgina 39).

2 Siel balance de blancos esta ajustado en
el modo ATW, pulse el botén WHT
BAL (pdgina 9) para seleccionar el
modo manual.

3 Seleccione B, A o PRESET con el
interruptor WHT BAL (pdgina 9).

B: modo memoria B *

A: modo memoria A

PRESET: modo predeterminado
* B puede asignarse a ATW ON.



Modo predeterminado

Este modo ajusta la temperatura del color a un
valor predeterminado (el valor predeterminado de
fabrica es 3200 K).

Modo memoria A/memoria B

Este modo ajusta el balance de blancos en la
configuracién guardada en la memoria A o B
respectivamente.

Los ajustes del interruptor WHT BAL en el modo Cine
El estdn fijados del modo siguiente.

B: 5500 K

A: 4300 K

PRESET: 3200 K

Utilizacion del balance automatico de
blancos

1 Pulseel botén ISO/Gain (pdgina 9) para
activar AGC.
O seleccione Auto Exposure (pdgina 67)
>AGC en el mentd Camera y ajtstelo en
“On”.

2 Para guardar un valor de ajuste en la
memoria, seleccione el modo memoria
A o el modo memoria B.

3 Coloque un papel blanco (u otro objeto)
en un lugar con la misma fuente de
iluminacién y condiciones que el sujeto
y, a continuacion, utilice el zoom para
acercarse al papel y asi mostrar blanco
en la pantalla.

4 Ajuste el brillo.

Ajuste el diafragma con el procedimiento
descrito en “Ajuste manual del diafragma”
(pdgina 43).

O Pulse el botén WB SET (pdgina 7).

Si el balance automatico de blancos se ajusta
en el modo de memoria, el valor de ajuste se
guarda en la memoria (A o B) seleccionada
en el paso 2.

Si el balance de blancos se ajusta en el modo
ATW, el ajuste del balance de blancos vuelve
al balance de blancos del modo ATW cuando
finaliza el ajuste.
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El ajuste automadtico de blancos no funciona en el
modo Cine EI.

Si el ajuste no se realiza correctamente, aparecerd un
mensaje de error en la pantalla durante unos tres
segundos. Si el mensaje de error continta después de
varios intentos repetidos de ajuste del balance de
blancos, péngase en contacto con su servicio de
asistencia técnica de Sony.

Especificacion del audio que se va
a grabar

Puede especificar el audio que se va a grabar con
los conectores de entrada, interruptores y diales
del camcorder.

Interruptores de seleccion y conectores de
entrada de audio externa

Conector INPUT1 (pdgina 10)

Conector INPUT?2 (pdgina 10)

Interruptor INPUT1 (LINE/MIC/MIC+48V)
(pdgina 7)

Interruptor INPUT2 (LINE/MIC/MIC+48V)
(pdgina 7)

Interruptores para ajustar el nivel de audio
Interruptor CH1 LEVEL CONTROL (pdgina 9)
Interruptor CH2 LEVEL CONTROL (pdgina 9)
Dial CH1 INPUT LEVEL (pdgina 9)

Dial CH2 INPUT LEVEL (pdgina 9)

Seleccion del dispositivo de entrada de
audio

1 Seleccione el conector de entrada de
audio.

Seleccione la entrada de audio con Audio
Input >CH1 Input Select o CH2 Input Select
en el mend Audio.

Establezca INPUT1 o INPUT2 para que
coincidan con el conector del dispositivo
conectado. Si utiliza un micréfono acoplable
o un adaptador de XLR, especifique Shoe 1 o
Shoe 2 del mismo modo. Para obtener mds
informacién acerca del adaptador de XLR,
consulte “Adicion de conectores de entrada
de audio” (pdgina 54).



El camcorder estd equipado con un micréfono
interno. Aunque no resulta adecuado para obtener el
audio final, se puede utilizar para la sincronizacién
con otro equipo. En tales casos, especifique Internal
MIC.

2 Seleccione la fuente de entrada de
audio.
Ajuste los interruptores INPUT1/INPUT2
(LINE/MIC/MIC+48V) en los dispositivos
conectados a los conectores INPUT1/
INPUT?2 respectivamente.

Dispositivo conectado Posicion del

interruptor
Fuente externa de audio ~ LINE
(por ejemplo, mezclador)
Micréfono dindmico, MIC
micréfono con bateria
Micréfono con MIC+48V

alimentaci6n fantasma de
+48 V

« Si selecciona “MIC+48V” y conecta un
micréfono que no sea compatible con
fuentes de +48 V, es posible que dafie el
dispositivo conectado. Compruebe el ajuste
antes de conectar el dispositivo.

* Si le preocupa el ruido en conectores que
no tengan un dispositivo conectado, ajuste
los interruptores INPUT1/INPUT?2 (LINE/
MIC/MIC+48V) correspondientes en
“LINE”.

Ajuste automatico del nivel de grabacién
de audio

2 Durante la filmacién o en espera, gire
los diales INPUT LEVEL (CH1)/(CH2)
hasta los canales correspondientes para
ajustar el nivel de audio.

También puede ajustar el nivel de grabacién
con el dial asignable (pdgina 47), si estd
asignado a la funcién Audio Input Level, o
bien desde el ment de configuracion.

Para CH3/CH4, ajuste Audio Input >CH3
Level Control y CH4 Level Control del ment
Audio en “Manual” y, a continuacion, ajuste
el nivel de grabacién de audio en CH3 Input
Level y CH4 Input Level (pdgina 79).

Es posible que los ajustes de Audio Input Level
estén desactivados, en funcién de la
combinacién de ajustes del mend Audio. Para
obtener mas informacién, consulte el diagrama
en la pdgina 135.

Si Audio Input > CHI Input Select o CH2 Input
Select del mend Audio estd ajustado en
“Internal MIC”, CH2 cambia a automdtico/
manual juntamente con el interruptor CH1
LEVEL CONTROL. Asimismo, el nivel de
grabacion de audio de CH2 se establece
juntamente con el dial CH1 INPUT LEVEL
(pdgina 79).

El camcorder admite combinaciones de
diferentes ajustes. Para obtener mds
informacién, consulte el diagrama en la

pdgina 135.

Especificacion de los datos de
tiempo

Ajuste del codigo de tiempo

Ajuste los interruptores CH1/CH2 LEVEL
CONTROL para que los canales se ajusten
automdticamente en “AUTO”.

Para CH3/CH4, ajuste Audio Input >CH3 Level
Control y CH4 Level Control del ment Audio en
“Auto” (pdgina 79).

Ajuste manual del nivel de grabacidon de
audio

Utilice el siguiente procedimiento para ajustar el
nivel de grabacion de audio de CH1/CH2.

1 Ajuste los interruptores CH1/CH2
LEVEL CONTROL para que los
canales se ajusten manualmente en
“MAN”.
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Ajuste el c6digo de tiempo que se va a grabar
mediante Timecode (pdgina 89) en el meni TC/
UB.

Visualizacidon de los datos de tiempo

Pulse el botén DISPLAY para mostrar los datos
de tiempo en la pantalla (pdgina 14).

Ajuste el c6digo de tiempo que se va a mostrar
mediante TC Display (pdgina 89) >Display
Select en el ment TC/UB.

Si pulsa un botén asignable (pdgina 47) al que se
le haya asignado DURATION/TC/U-BIT,
cambiard la visualizacion entre codigo de tiempo,
bits de usuario y duracién de forma consecutiva.



Funciones utiles

Botones/diales asignables

Existen seis botones asignables (pdgina 9,
pdgina 11) en el camcorder a los que puede
asignar diversas funciones.

También puede asignar funciones al dial IRIS
(pdgina 9) en el camcorder y al dial asignable
(pdgina 11) en el control remoto de la
empuifiadura.

Cambio de funcidn de los botones

Utilice Assignable Button (pdgina 98) en el meni
System.

Puede visualizar las funciones asignadas en la
pantalla Assignable Button Status (pdgina 17).

Las funciones se asignan a cada hoton asignable
de manera predeterminada de fabrica

Botén 1 S&Q Motion

Botén 2 IRIS

Botén 3 User Menu

Botén 4 Focus Magnifier x4/x8
Botén 5 User Menu

Botén 6 Off

Funciones asignables

* Off

* Marker

* Zebra

¢ Peaking

¢ Video Signal Monitor
« DURATION/TC/U-BIT
¢ Focus Magnifier x4/x8
» Focus Magnifier x4

¢ Focus Magnifier x8

¢ Push AF/Focus Hold
* Focus Area

¢ Focus Area (Push AF)
* VF Mode

« IRIS

« AGC

*« SHUTTER

* Auto Exposure Level
* Push Auto Iris

¢ Push AGC

* Spotlight

* Backlight
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« ATW

* ATW Hold

* SteadyShot

¢ Color Bars

* User Menu

* Rec Lamp

* S&Q Motion

¢ Picture Cache Rec
* Rec Review

¢ Thumbnail

* Shot Mark1

e Shot Mark2

* Clip Flag OK

* Clip Flag NG

* Clip Flag Keep
* High/Low Key

Cambio de funcion de los diales

Utilice Assignable Dial (pdgina 100) en el menu
System.

Puede visualizar las funciones asignadas en la
pantalla Assignable Button Status (pdgina 17).
IRIS se asigna de manera predeterminada de
fabrica.

Funciones asignables
e Off

¢ IRIS

¢ ISO/GAIN/EI

* Focus

* Audio Input Level



Movimiento a camara lenta y
rapida

Cuando el formato de video (pdgina 96) se ajusta
en uno de los siguientes valores, puede
especificar un valor diferente para la velocidad de
fotogramas de grabacién y la velocidad de
fotogramas de reproduccién.

Area NTSC
XAVC-I
4096 x 2160 59.94P, 4096 x 2160 29.97P,
4096 x 2160 24.00P, 4096 x 2160 23.98P,
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 2160 23.98P, 1920 x 1080 59.94P,
1920 x 1080 29.97P, 1920 x 1080 23.98P
XAVC-L
3840 x 2160 59.94P, 3840 x 2160 29.97P,
3840 x 216023.98P, 1920 x 1080 59.94P 50,
1920 x 1080 59.94P 35, 1920 x 1080 29.97P
50, 1920 x 1080 29.97P 35, 1920 x 1080
23.98P 50, 1920 x 1080 23.98P 35

Area PAL

XAVC-1

4096 x 2160 50P, 4096 x 2160 25P,

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P, 1920 x 1080 25P

XAVC-L

3840 x 2160 50P, 3840 x 2160 25P,

1920 x 1080 50P 50, 1920 x 1080 50P 35,

1920 x 1080 25P 50, 1920 x 1080 25P 35
Puede establecer la velocidad de fotogramas para
grabaciones si mantiene pulsado un botén
asignable al que haya asignado S&Q Motion.

La funcién Slow & Quick Motion no se puede ajustar
durante la grabacién, la reproduccion ni durante la
visualizacién de la pantalla de miniaturas.

La grabacién automatica no es compatible con el modo
Slow & Quick Motion.

La funcién de enfoque automatico se inhabilita en el
modo Slow & Quick Motion.

Las siguientes condiciones se aplican cuando se filma
a velocidades de fotogramas mayores a 60 fps.

- El indicador de enfoque asistido, el indicador de
profundidad de campo, el indicador de posicién de
enfoque, el indicador de posicién del diafragma y
el indicador de posicién del zoom se desactivan.
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Area NTSC

Formato Resolucion Velocidad Velocidad de

de fotogramas
fotogramas alta
XAVC-I 2160 Dela No admitido
60 fps
(59.94P, 29.97P, 24.00P,
23.98P)
1080 Dela 72/75/80/90/96/
60 fps 100/110/120/125/
135/144/150/160/
168/175/180 fps
(59.94P, 29.97P, 23.98P)
XAVC-L 2160 Dela No admitido
60 fps
(59.94P, 29.97P, 23.98P)
1080 Dela 72/75180/90/96/
60 fps 100/110/120 fps
(59.94P 50, 59.94P 35, 29.97P
50, 29.97P 35, 23.98P 50,
23.98P 35)
Area PAL
Formato Resolucion Velocidad Velocidad de
de fotogramas
fotogramas alta
XAVC-I 2160 Dela No admitido
60 fps
(59P, 25P)
1080 Dela 72/75180/90/96/
60 fps 100/110/120/125/
135/144/150 fps
(59P, 25P)
XAVC-L 2160 Dela No admitido
60 fps
(59P, 25P)
1080 Dela 72/75/80/90/96/
60 fps 100/110/120 fps
(50P 50, 50P 35, 25P 50,
25P 35)

Grabacion de video de manera
intermitente (Interval Rec)

La funcién Interval Rec del camcorder le permite
capturar videos time-lapse en la memoria interna
del camcorder. Esta funcién es una manera
efectiva de filmar sujetos que se mueven
lentamente.

Al iniciar la grabacion, el camcorder graba
automaticamente un nimero especificado de
fotogramas (Number of Frames) en un intervalo
de tiempo (Interval Time) especificado.



Esta funcion se activa cuando el camcorder esta
ajustado en cualquiera de los siguientes formatos
de video (pdgina 96).

XAVC-1

XAVC-L*

MPEG HD 422*

*59.94i y 50i no son compatibles.

Intervalo de tiempo (Interval Time)

l_l_l

Numero de fotogramas en una toma
(Number of Frames)

Cuando Interval Rec estd activado, la luz de video
del HVL-LBPC (opcional) se enciende
automdticamente antes de que comience la
grabacion, lo que le permite grabar imdgenes con
una iluminacién y unas condiciones de
temperatura de color estables (funcién de
preiluminacién).

Ajustes de Interval Rec y filmacion

Solo se puede utilizar una funcién de grabacion
especial al mismo tiempo, como la grabacién Interval
Rec.

Si se activa otro modo de grabacién especial mientras
se estd utilizando Interval Rec, se desactivard
automdticamente Interval Rec.

El modo Interval Rec se desactiva automaticamente
después de cambiar los ajustes del sistema, como el
formato de video.

No se pueden cambiar los ajustes de Interval Rec
durante la grabacién o la reproduccion, ni cuando se
muestre la pantalla de imdgenes en miniatura.
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Para ajustar Interval Rec

Ajuste Interval Rec (pdgina 90) >Setting en el
menud Recording en On y ajuste Number of
Frames e Interval Time.

Si utiliza la luz de video del HVL-LBPC
(opcional), ajuste el intervalo de tiempo para
encender la luz de video antes de que comience la
grabacion en Pre-Lighting en el menu Interval
Rec, si es necesario.

« Si desea encender la luz de video antes de que
comience la grabacidn, ajuste el interruptor de la luz de
video en AUTO. La luz de video se enciende y se
apaga automadticamente en funcién del ajuste de Video
Light Set (pdgina 71) en el mend Camera.

Si enciende la luz de video, esta siempre estard
iluminada (la luz de video no se encenderd/apagara
automaticamente).

Si la luz de video estd configurada para que se apague
durante un perfodo de 5 segundos o menos, la luz de
video no se apagard.

El camcorder sale del modo Interval Rec cuando
se apaga, pero se mantienen los ajustes de
Number of Frames, Interval Time y Pre-lighting.
No es necesario volver a ajustarlos la proxima vez
que filme en el modo Interval Rec.

Para filmar utilizando Interval Rec

Pulse el botén de grabacién para comenzar a
grabar. “Int[A /[B] @Rec” e “Int[A]/[B] @Stby”
aparecen de manera alterna en el visor.

Si estd utilizando la funcién de preiluminacion, la
luz de video se enciende antes de que comience la
grabacion.

Para detener la filmacion

Detenga la grabacién.

Cuando la filmacion finalice, los datos de video
almacenados en la memoria hasta ese punto se
graban en el soporte.

Para salir del modo Interval Rec

Realice una de las siguientes acciones.

* Ajuste el interruptor POWER en Off.

* En el modo de espera de grabacidn, ajuste
Interval Rec >Setting en el ment Recording en
Off.

Asimismo, el modo Interval Rec se desactivara

automdticamente cuando se reinicie el

camcorder.

Limitaciones durante la grabacion

* No se graba el audio.

* No es posible revisar la grabacién (Rec
Review).

* No se aplica el generador de sincronismo.



Si el camcorder se apaga durante la grabacion
« Si el interruptor POWER del camcorder estd
ajustado en la posicion Off, se accede al soporte
durante varios segundos para grabar las
imdgenes almacenadas en la memoria hasta ese
momento y, a continuacion, la alimentacién se
apaga automaticamente.

Si la unidad deja de recibir alimentacién porque
se ha extraido la bateria, se ha desconectado el
cable de alimentacién de CC o se ha apagado la
alimentacion desde el adaptador de CA, los
datos de audio y de video filmados hasta ese
punto se pueden perder (10 segundos como
maximo).

Se debe tener cuidado al cambiar la baterfa.

Grabacion de memoria intermedia
de imagenes (Picture Cache Rec)

La funcion de grabacién de memoria intermedia
de imdgenes le permite capturar video de forma
retroactiva cuando empieza a grabar y después lo
graba en tarjetas de memoria XQD; esto se
consigue manteniendo una memoria intermedia
de imdgenes de una duracion especifica durante la
filmacién. El tiempo de grabacion de memoria
intermedia se establece mediante Picture Cache Rec
>Cache Rec Time (pdgina 91) en el ment
Recording.

Formatos de grabacion compatibles

Formato de ., Tiempo de
., Resolucién .
grabacion memoria [s]
RAW 4096x2160 No admitido
2048x%1080
XAVC ! 4096x2160 0a2
3840x2160
19201080 0a2/2a4/4a6/6a8
MPEG-2 1920x1080 0a2/2a4/4a6/6a
8/8a10/13a 15
ProRes422 1920x1080 No admitido

*1: XAVC-159.94P y 50P no son compatibles.

Picture Cache Rec no puede estar activado al mismo
tiempo que Interval Rec o Slow & Quick Motion.
Cuando Picture Cache Rec estd activado, estos otros
modos de grabacién se apagan de forma forzosa.

El modo Picture Cache Rec no se puede seleccionar
mientras se graba o cuando Rec Review estd en
proceso.

Cuando Picture Cache Rec estd activado, el cédigo de
tiempo se graba en el modo Free Run

independientemente del ajuste del meni TC/UB
(pdgina 89).

* Es posible que el ajuste de Output Format no se pueda
configurar en el modo Picture Cache Rec. Si esto
sucede, ajuste temporalmente Picture Cache Rec en
Off y, a continuacidn, cambie el ajuste.

Configuracidn antes de la filmacidn

Configure Picture Cache Rec (pdgina 91) en el
menu Recording antes de filmar.

También puede asignar la funcién Picture Cache
Rec a un bot6n asignable (pdgina 47) y activar o
desactivar Picture Cache Rec >Setting con el
botén.

Cuando estd configurado, el indicador @ (verde)
aparece en el visor (pdgina 13).

Grabacion de memoria intermedia de
imagenes

Cuando pulsa el botén de grabacion, la grabacion
comienza y el video se graba en las tarjetas de
memoria XQD a partir del video almacenado en
la memoria intermedia.

Para cancelar Picture Cache Rec

Desactive el ajuste Picture Cache Rec >Setting en
el menud Recording o pulse un botén asignable
que tenga asignada la funcién Picture Cache Rec.

El cambio del formato de grabacion borra el video de
la memoria intermedia almacenado hasta ese punto y
comienza a almacenar video nuevo. En consecuencia,
la grabacion de memoria intermedia de imdgenes no es
posible antes de cambiar el formato, aunque empiece a
grabar inmediatamente después de cambiar el formato.
Si Picture Cache Rec se activa/desactiva
inmediatamente después de insertar una tarjeta de
memoria XQD, los datos de la memoria intermedia
pueden no grabarse en la tarjeta.

El video se almacena en la memoria intermedia cuando
la funcidn de grabacién en memoria intermedia estd
activada. No se almacena en la memoria media el
video anterior a la activacién de la funcién.

El video no se almacena en la memoria intermedia
durante el acceso a una tarjeta de memoria XQD; lo
mismo ocurre durante la reproduccién, Rec Review o
la visualizacién de miniaturas en la pantalla. Durante
ese intervalo, la grabacién de memoria intermedia de
imdgenes de video no es posible.

Puede cambiar el ajuste del tiempo de grabacion de
memoria intermedia con el menu durante la grabacion,
pero el valor nuevo no surte efecto hasta que finalice la
grabacion.



Revision de una grabacion (Rec
Review)

Puede comprobar el video del clip que ha grabado
por tltimo en la pantalla.

Cuando detenga la grabacién, pulse el
boton asignable (pdgina 47) al que se ha
asignado la funcién Rec Review.

El clip se reproduce hasta el final, Rec Review
finaliza y el camcorder vuelve al modo STBY (en
espera).

Mantenga pulsado el botén para comenzar la
reproduccion en direccion contraria. Cuando
suelte el botdn, el clip se reproducird hasta el
final.

Para detener Rec Review
Pulse el botdn asignable al que ha asignado Rec
Review.

Rec Review no es compatible si el formato de video se
cambia después de grabar un clip.

Modo Self Portrait (autorretrato)

Puede dar la vuelta a la imagen en el visor
(pdgina 11) verticalmente u horizontal/
verticalmente con el interruptor MIRROR.
Esto le permite girar el visor 180° hacia el
objetivo.

[ T

OFF B/T ROT

(@

OFF

La imagen no se invierte.

B/T

La imagen se da la vuelta de forma vertical.
La visualizacién de informacién se invierte de
forma vertical y horizontal.




ROT : —y:
La imagen se da la vuelta de forma vertical y Visualizacion de cebra
horizontal.

La visualizacién de informacién también se
invierte de forma vertical y horizontal.

Puede activar o desactivar la visualizacién del
patrén de cebra con el botén ZEBRA en el visor
(pdgina 11).

Puede activar o desactivar la visualizacién del
patrén de cebra y ajustar el tipo de patrén y el
nivel de visualizacién de cebra con Zebra
(pdgina 85) en el mend VF.

El camcorder mide la imagen en el visor. En el modo
Cine EI, ajuste el nivel de visualizacién y otros
pardmetros de acuerdo con el ajuste de LUT de monitor
del visor (pdgina 83).

Monitor de seiial de video

Puede establecer el tipo de sefial de video que
desea visualizar en la pantalla del visor en forma
de onda, vectorscopio o histograma mediante
Video Signal Monitor > Setting (pdgina 88) en el
mend VF.

El monitor de sefial de video del camcorder mide
la sefial de video en la fase de salida de video. En
consecuencia, si el video de salida tiene los
bordes recortados con respecto al video grabado,
el componente de sefial recortada no se medira.
Cuando esto ocurre, se muestra “EC” en la parte
superior izquierda del monitor de sefial de video.
Cuando la salida de video estd ajustada en 2K o
inferior en el modo Cine EI, puede medir la sefial
de video tanto del sistema SDI1 como del SDI2
mediante Video Signal Monitor > Source
(pdgina 88) en el mend VF. El ajuste de LUT de
monitor (pdgina 83)del sistema SDI especificado
se muestra en la parte superior derecha del
monitor de sefial de video.

EC LUT 709

Las vistas B/T y ROT solo se visualizan en el visor. El
video de salida y el video grabado seguirdn sin verse
afectados.

234567890123456
=i 000min 000min

Puede activar o desactivar la nitidez con el botén . . . .
 Cuando Display On/Off > Setting (pdgina 87) estd

PEAKING en el visor (pdgina 11). ajustado en Off en el ment VF, el monitor de sefial de

Puede activar o desactivar la nitidez y ajustar el video no se muestra.

tipo y la frecuencia de nitidez con Peaking * Cuando el ajuste de LUT de monitor del sistema SDI

(pdgina 85) en el ment VF. especificado estd ajustado en Off, el ajuste de Color
Space (pdgina 96) se muestra en la parte superior
derecha del monitor de sefial de video.

Visualizacion de la nitidez
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Obtencidn de la informacion de
ubicacion (GPS)

Ajuste GPS en “On” en el ment System.

M se mostrard cuando el camcorder esté
buscando satélites de GPS. Cuando se establece el
posicionamiento, la informacién de ubicacién se
graba mientras se filma el video.

« El ajuste de GPS no se puede establecer en “On” en el
menu System cuando el asa no estd acoplada, puesto
que el receptor de GPS estd integrado en el asa.

« El icono que se muestra varia segtin la recepcion de
sefial de los satélites GPS.

Estado de Pantalla
posiciona-
miento

Estado de recepcion
de GPS

Off Sin visuali-  GPS se ha ajustado en
“Off” o se ha producido

un error.

zacion

Ubicacién no
disponible

No se ha podido obtener
la informacién de
ubicacién porque no se
ha podido recibir la sefial
de GPS. Desplécese
hasta una ubicacién con
una vista despejada del
cielo.

NO GPS
SIGNAL

Buscando satélites de
GPS. Puede que tarde
varios minutos en
encontrar satélites.

Buscando

&
satélites »@

Posiciona-
miento

’ Se recibe una sefial débil
‘
Pt de GPS.

0 Se recibe una sefial de
GPS. Se puede conseguir
la informacién de
ubicacién.

Se recibe una sefial fuerte
de GPS. Se puede
conseguir la informacién
de ubicacion.

ul

* GPS se ajusta en “On” de manera predeterminada de
fabrica. El camcorder grabard la informacién de
ubicacién y de tiempo del video grabado cuando el
posicionamiento esté activado.

Sidespués de varios minutos no se muestra un icono de
posicionamiento, es posible que exista un problema
con la recepcidn de sefial. Comience a filmar sin
informacion de ubicacién o desplécese a una zona con
una vista clara del cielo. Si filma cuando no se muestra
un icono de posicionamiento, la informacién de
ubicacién no se grabard.
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« Es posible que no se reciba sefial de GPS cuando esté
en interiores o cerca de estructuras altas. Despldcese
hasta una ubicacién con una vista despejada del cielo.

* Es posible que se interrumpa la grabacién de
informacién de ubicacién, segin la fuerza de la sefial
recibida, incluso si se muestra el icono de
posicionamiento.

Filmacion en modo Cine El

Este modo imita la manera en que funciona una
cdmara de cine y presupone que el metraje se
revela en postproduccion.

Restricciones del modo Cine El

* Funciones que no se pueden ajustar de forma
automadtica (correccién)
- White balance
- Gain
- Shutter
- Iris
- Auto Exposure
* Funciones que no se pueden configurar
- Gain
- Ajustes del mend Paint
- Scene File
- Lens File

Funciones disponibles solo en modo
Cine El

* Exposure Index

* Monitor LUT

* High/Low Key

¢ Grabacion de videos RAW

Grabacion de videos RAW

Puede grabar videos RAW en un grabador AXS-
RS (opcional) si convierte la sefial de salida de un
conector RAW OUT de una XDCA-FS7
(opcional) acoplada al camcorder con una HXR-
IFRS5 (opcional) (pdgina 35).

1 Configure la unidad de grabaciéon RAW
externa (pdgina 35).

2 Ajuste Base Setting >Shooting Mode en
el ment System en Cine EL



3 Ajuste Codec >Select en RAW en el
ment System.
Si selecciona RAW & XAVC-], se grabara
simultdneamente video RAW en el grabador
RAW externo y video HD en las tarjetas de
memoria XQD del camcorder.

4 Ajuste la resoluciéon mediante Imager
Scan Mode en el ment System.

Cuando estd ajustado en Normal, la
resolucion RAW es 4096 x 2160.

5 Ajuste la velocidad de fotogramas en
Rec Format >RAW Output Format en
el menu System.

6 Compruebe que el grabador externo
esté encendido y, a continuacion, pulse
el boton de grabacion en el camcorder.

A continuacion se muestran los formatos de

salida RAW compatibles.

Area NTSC

Ajuste de Codec Formatos de salida
>Select RAW

RAW /RAW & 4096 x 2160 59.94P

XAVC-1/RAW &
XAVC-L/RAW &

4096 x 2160 29.97P
4096 x 2160 23.98P

MPEG HD422 2048 x 1080 59.94P
2048 x 1080 29.97P
2048 x 1080 23.98P

Area PAL

Ajuste de Codec Formatos de salida

>Select RAW

RAW /RAW & 4096 x 2160 S0P

XAVC-1/RAW &
XAVC-L/RAW &
MPEG HD422

4096 x 2160 25P
2048 x 1080 50P
2048 x 1080 25P

Indicador de estado de grabacion

Si Display On/Off (pdgina 87) >HXR-IFR5 Rec
Control del mentd VF estd ajustado en “On”, el
estado de grabacion RAW se mostrard en el visor
mediante un icono.
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Grabacion de movimiento a camara lenta y rapida
Si S&Q Motion >Setting en el ment Recording
estd ajustado en “On”, el video RAW se grabard
en el modo de movimiento a cimara lenta y
rdpida.

RAW output Slow & Quick Motion es
compatible solo con una resolucién de 2K a 120/
240 fps (NTSC) y 100/200 fps (PAL).

El conector RAW OUT del camcorder solo controla la
grabacion mediante la transmisién de una sefial Rec
Control al grabador externo; por lo tanto, el camcorder
puede indicar que la grabacién de video RAW estd en
proceso cuando el grabador externo no estd grabando
realmente. Compruebe el indicador del grabador
externo para obtener el estado de funcionamiento
correcto.

Cuando la grabacién se ha iniciado en un grabador
externo, sin utilizar el botén de grabacién del
camcorder, es posible que los clips no se graben
correctamente.

Adicién de conectores de entrada
de audio

Puede conectar al camcorder hasta cuatro canales
de los dispositivos de audio XLR al mismo
tiempo si utiliza un adaptador de XLR XLR-K2M
(no suministrado).

Acople el adaptador de XLR a la zapata Ml y, a
continuacién, ajuste Audio Input >CH3 Input
Select en “Shoe 1” y CH4 Input Select en “Shoe
2” en el mend Audio.

Las funciones del camcorder que se solapen se
inhabilitardn para los canales en los que el
adaptador de XLR se haya seleccionado como la
entrada. Utilice los interruptores y los diales del
adaptador de XLR para realizar los ajustes.

Si Audio Input >CH3 Level y CH4 Level se han
establecido en “Audio Input Level” en el mend Audio,
el Audio Input Level del camcorder se ajustard para
que coincida con el nivel que se haya ajustado en el
adaptador de XLR. Audio Input Level también se
habilita cuando el dial del adaptador de XLR esta
ajustado en AUTO. Cuando se especifique “Through”,
el audio se grabard en el nivel que se haya ajustado con
el adaptador de XLR (pdgina 136).

También es posible asignar a CH1 y CH2 acoplando un
adaptador de XLR y estableciendo Audio Input >CH1
Input Select y CH2 Input Select en el ment Audio en
“Shoe 1"’y “Shoe 2,” respectivamente. No obstante, si
se asigna la entrada desde un adaptador de XLR a CH1
y CH2, la entrada desde los conectores INPUT1/
INPUT?2 del camcorder ya no se podrd asignar a los
canales.



Conexion de
dispositivos con LAN
inalambrica

El camcorder se puede conectar a smartphones,
tabletas y otros dispositivos que utilicen una
conexion LAN inaldmbrica, mediante el acople
del médulo de LAN inaldmbrica USB IFU-
WLM3 (suministrado) o una adaptador
inaldmbrico CBK-WA100 (opcional).

Los médulos inalambricos USB distintos del IFU-
WLM3 no son compatibles.

Las siguientes funciones son compatibles con
dispositivos conectados mediante LAN inaldmbrico.
 Control remoto

Habilita el control remoto del camcorder.
» Control de video (solo CBK-WA100)

Habilita el control del video desde el

camcorder.

Es necesario disponer del CBK-WA100

(opcional) y de la aplicacién Content

Browser Mobile.

Para obtener mds informacion acerca de la
aplicacion Content Browser Mobile, pongase en
contacto con el servicio de asistencia técnica o de
ventas de Sony.

Dispositivos compatibles

Puede utilizar un smartphone, tableta u ordenador
para configurar y utilizar el camcorder. En la
siguiente se indican los dispositivos, sistemas
operativos y navegadores compatibles.

Dispositivo SO Navegador
Smartphone  Android 5.1 Chrome
i0S 9 Safari
Tableta Android 5.1 Chrome
i0S 9 Safari
Ordenador Microsoft Windows 7/ Chrome

Microsoft Windows 8.1/
Microsoft Windows 10
Mac OS 10.10/10.11 Safari

Acople del IFU-WLM3

Enchufe el IFU-WMLS3 en el conector USB del
modulo de LAN inaldmbrica (pdgina 7).

Tras acoplar la unidad, ajuste Wi-Fi >Wi-Fi
(pdgina 101) en el mend System en “Enable” para
habilitar la LAN inaldmbrica.

Acople o retire el IFU-WLM3 mientras el camcorder
esté apagado.

Acople del CBK-WA100
[ Nota |

Acople o retire el CBK-WA100 mientras el camcorder
esté apagado.

1 Conecte el CBK-WA100 al soporte de
montaje y apriete los dos tornillos.

2 Conecteel soporte de montaje del CBK-
WA100 en el camcorder y apriete los
tornillos.



3 Conecte el cable USB del CBK-WA100
al conector del médulo LAN
inalambrico USB (@) y el cable SDI al
conector SDI OUT (®@).

4 Encienda el CBK-WA100 y luego
encienda el camcorder.

5 Cuando se completa la conexién, el
LAN inalambrico debe habilitarse si se
establece Wi-Fi >Wi-Fi (pdgina 101) en
Enable en el menii System.
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El pardmetro de salida SDI OUT se debe configurar para
utilizar el CBK-WA100 con el camcorder. No obstante,
el camcorder no puede emitir una sefial compatible con
el CBK-WA100 cuando se utiliza XAVC-124.0P o
ProRes 23.98P (pdgina 82).

Acerca del CBK-WA100

El CBK-WA100 cuenta con funciones de
grabacion de archivos proxy de baja resolucién en
una tarjeta SD, asi como de transferencia de
archivos a un servidor mediante LAN
inalambrico. Para obtener mds informacion,
consulte el manual de funcionamiento del CBK-
WAT100.

Conexion con un toque de
dispositivos con NFC (solo para el
IFU-WLM3)

Los dispositivos compatibles con NFC se pueden
conectar (conexion con un toque) mediante NFC.

1 Acople un IFU-WLM3 al camcorder
(pdgina 55), y ajuste Wi-Fi >Wi-Fi
(pdgina 101) en el menid System en
‘“Enable” para habilitar la LAN
inalambrica.

N apareceri en pantalla.

= U |

=

2 Abra “Settings” en el dispositivo,
seleccione ‘“More” y marque la casilla
de NFC.

Los diferentes ajustes variardn segtn el
dispositivo. Para obtener mas informacion,
consulte el manual de instrucciones del
dispositivo.



3 Toque el camcorder con el dispositivo.

El dispositivo se conectard al camcorder,
abrird un navegador web y mostrara el
control remoto Wi-Fi. Se requiere
autenticacion la primera vez que se conecta
el dispositivo.

* Desactive previamente el modo de suspensién y el
bloqueo de pantalla.

« Toque sin soltar el dispositivo hasta que se inicie la
aplicacién “Content Browser Mobile” (1 o
2 segundos).
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Visualizacion del control
remoto Wi-Fi

La pantalla Wi-Fi Remote cambia de tamafio
automadticamente para adaptarse al tamaio de la
pantalla del dispositivo conectado.

1 Conecte el camcorder y el dispositivo
mediante una conexion de LAN
inalambrica (pdgina 56).

2 Abraun navegador en el dispositivo y
escriba “http://<direccion IP del
camcorder (Wi-Fi >direccién IP en el
ment System)>/rm.html” en la barra de
direcciones.

Por ejemplo, si la direccion IP es
192.168.1.1, introduzca “http://192.168.1.1/
rm.html” en la barra de URL.

3 Introduzca el nombre de usuario yla
contraseiia (Basic Authentication >User
Name y Password en el meni System).

Cuando la conexidn se realiza correctamente,
en el dispositivo aparecerd la pantalla Wi-Fi
Remote.

Puede utilizar la pantalla Wi-Fi Remote para
controlar el camcorder.

Puede desactivar el funcionamiento del
botén de grabacion si desliza el dial Lock
hacia la derecha.

Para mostrar la pagina de un smartphone, cambie
“rm.htm]” por “rms.html” en la URL. Para mostrar la
pégina de un tableta, cambie “rm.html” por “rmt.html”
en la URL. Cuando se introduce “rm.html”, la pagina
cambia automdaticamente para mostrar la pantalla en el
dispositivo correspondiente. Sin embargo, es posible
que no se muestre la pagina adecuada en funcién del
dispositivo.
Es posible que la pantalla Wi-Fi Remote no coincida
con los ajustes del camcorder en las siguientes
circunstancias. Si esto ocurre, vuelva a cargar la
ventana del navegador.

- Si el camcorder se reinicia mientras estd conectado

- Si el camcorder se utiliza directamente mientras

estd conectado
- Si el dispositivo se ha reconectado
- Si se han utilizado los botones de Adelante/Atrds
del navegador

Es posible que el control remoto por Wi-Fi no funcione
si la sefial inaldmbrica es débil.



Pantalla de imagenes en miniatura

Pantalla de imagenes en miniatura

La pantalla de imédgenes en miniatura aparece si pulsa el boton THUMBNAIL (pdgina 9). La pantalla de
imdgenes en miniatura muestra los clips almacenados en las tarjetas de memoria XQD como imédgenes en
miniatura (imdgenes indice).

Puede seleccionar un clip en la pantalla de imdgenes en miniatura e iniciar la reproduccion de dicho clip.
La imagen de reproduccion se puede mostrar en el visor y en un monitor externo.

Si pulsa el boton THUMBNAIL de nuevo, se cierra la pantalla de imdgenes en miniatura y vuelve a la
imagen de la cdmara.

Solo los clips grabados con el formato de grabacion seleccionado actualmente se mostrardn en la pantalla de imdgenes
en miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabacion. Tenga en cuenta esto
antes de formatear (inicializar) soportes.

Si Codec > Select del ment System se establece en uno de los siguientes parametros, la grabacién no se puede iniciar

durante la reproduccién o cuando se muestra la pantalla de miniaturas.
RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

Disefio de la pantalla

La informacion para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

Indicador de la tarjeta de memoria XQD seleccionada

actualmente

(Se muestra un icono de bloqueo si la tarjeta esta protegida).

Numero del clip/Numero total de clips
|

)| ) {am

Cursor
(amarillo) : 1
TCR00:00:00:12  TCR 00:00:00:15  TCR 00:00:00:34
=
o ] .:_.Ji._‘:— ﬁ -
TCR 00:00:01:56  TCR 00:00: 2 TCR00:00:02:35
1 e |

2 — (I | 27 Jin 2014 1220 A g

C i ) ( | D) (@ i )
3 4 5
1. Miniaturas (imagenes indice) 2. Nombre del clip
Muestra la imagen indice de un clip. Cuando se Muestra el nombre del clip seleccionado.
graba un clip, su primer fotograma se ajusta 3. Formato de grabacién del video

automdticamente como imagen indice.

La informacidn del clip/fotograma se muestra
debajo de la imagen en miniatura. Puede
cambiar la informacién mostrada en Customize
View (pdgina 92) >Thumbnail Caption en el
mend Thumbnail.

Muestra el formato de archivo del clip
seleccionado.
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4. Informacién del modo de grabacién
especial
Muestra el modo de grabacion solo si el clip se
grabé con un modo especial de grabacién.
En clips con Slow & Quick Motion, la velocidad
de fotogramas se muestra a la derecha.

5. Duracién del clip

6. Fecha de creacién
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Reproduccidon de clips

Reproduccion de clips grabados

Puede reproducir clips grabados cuando el
camcorder esté en modo de espera (Stby).

1 Introduzca una tarjeta de memoria
XQD para la reproducciéon.

2 Pulse el botéon THUMBNAIL.

3 Gire el dial SEL/SET (pdgina 9) para
mover el cursor hasta la imagen en
miniatura del clip que desea
reproducir.

4 Pulse el dial SEL/SET.
La reproduccién comienza desde el principio
del clip seleccionado.

Puede controlar la reproduccién con los
siguientes botones.
Dial SEL/SET:
Pausa la reproduccion.
Pulse de nuevo para volver a la reproduccién
normal.
Pulse los botones izquierda/derecha:
Pasa al inicio del clip/inicio del siguiente clip.
Mantenga pulsado los botones izquierda/
derecha:
Rebobinado/avance rdpido.
Vuelve a la reproduccién normal cuando
suelta el botén.
Boton CANCEL/BACK:
Detiene la reproduccién y vuelve al modo de
espera de grabacion.

Pueden existir roturas momentdneas de imagen o
visualizarse imdgenes fijas en el cambio de un clip a
otro. Durante este periodo no podra utilizar el
camcorder.

Cuando selecciona un clip en la pantalla de imagenes
en miniatura y comienza la reproduccién, pueden
existir roturas momentdneas de imagen al principio del
clip. Para visualizar el principio del clip sin roturas,
ponga el camcorder en modo de reproduccion, pause y,
a continuacion, utilice el botén izquierdo del dial SEL/
SET para volver al principio del clip y comience de
nuevo la reproduccién.

También puede controlar la reproduccién con el
control remoto suministrado.



Operaciones con clips

En la pantalla de imdgenes en miniatura, puede
utilizar los clips o comprobar sus propiedades a
través del mentd Thumbnail.

El mend Thumbnail (pdgina 92) aparece cuando
pulsa el botoén MENU y selecciona una imagen en
miniatura.

Operaciones con el menii de
imagenes en miniatura

Gire el dial SEL/SET (pdgina 9) para seleccionar
una funcién y, a continuacion, pulse el dial SEL/
SET.

Pulse el botén de CANCEL/BACK (pdgina 9)
para volver a la pantalla anterior.

Algunos elementos no pueden seleccionarse,
dependiendo del estado, cuando se visualiza el menu.

Elementos del menti Thumbnail

Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Para obtener mds informacion sobre los ments de
operaciones con clips, consulte la “Menii
Thumbnail” (pdgina 92).

Visualizacion de propiedades de clips

Seleccione Display Clip Properties (pdgina 92)
en el mend Thumbnail para mostrar la pantalla de
propiedades de los clips.

Visualizacion de la pantalla de iméagenes
en miniatura de marcadores

Seleccione Thumbnail View (pdgina 92)
>Essence Mark Thumbnail en el menu
Thumbnail y seleccione el tipo de marcador para
mostrar una visualizacién de imagenes en

miniatura de los fotogramas que tienen los
marcadores especificados.

Visualizacidn de la pantalla de imagenes
en miniatura de clips filtrados

Seleccione Filter Clips (pdgina 92) en el menud
Thumbnail y seleccione un tipo de marca para
mostrar solo aquellos clips que tengan la marca
especificada.

Para visualizar todos los clips, ajuste Thumbnail
View > Essence Mark Thumbnail en el ment
Thumbnail en All

Eliminacion de clips

Puede eliminar clips de tarjetas de memoria
XQD.
Seleccione Delete Clip >Select Clip o All Clips
en el mend Thumbnail.
Select Clip:
Elimina el clip seleccionado. Compatible con
la seleccion de varios clips.
All Clips:

Elimina todos los clips mostrados.

Cambio de la informacion mostradaen la
pantalla de imagenes en miniatura

Puede cambiar la informacién de fotogramas/
clips que se muestra debajo de la imagen en
miniatura.
Seleccione Customize View >Thumbnail Caption
en el mend Thumbnail y seleccione la
informacién que desea mostrar.
Date Time:
Muestra la fecha y 1a hora de creacion del clip
y de su tdltima modificacién.
Time Code:
Muestra el cédigo de tiempo.
Duration:
Muestra la duracién del clip.
Sequential Number:
Muestra el nimero secuencial de cada
imagen en miniatura.



Pantalla de meniis y ajustes

Configuracion del mena de ajustes y jerarquia

Pulse el boton MENU para mostrar el menu de
configuracion en el visor con el fin de especificar
los distintos elementos para filmar, grabar y
reproducir (el ment también se puede visualizar
en un monitor externo). El menu de configuracion
incluye los siguientes mends.
Menu User:
Contiene elementos del menu configurados
por el usuario mediante Edit User Menu.
Menu Edit User:
Contiene elementos del menu para editar el
ment User.
Menu Camera:
Contiene ajustes relacionados con la
filmacion.
Menu Paint:
Contiene ajustes relacionados con la calidad
de la imagen.
Menu Audio:
Contiene ajustes relacionados con el audio.
Menu Video:
Contiene ajustes relacionados con la salida
de video.
Menu VF:
Contiene ajustes de la pantalla del visor.
Menu TC/UB:
Contiene ajustes relacionados con el cédigo
de tiempo y los bits de usuario.
Menu Recording:
Contiene ajustes relacionados con la
grabacion.
Menu Thumbnail:
Contiene ajustes relacionados con la pantalla
de imdgenes en miniatura.
Menu Media:
Contiene ajustes relacionados con los
soportes.
Menu File:
Contiene ajustes relacionados con los
archivos.
Menu System:

Contiene ajustes relacionados con el sistema.

Organizacion del meni de
configuracion

User Country

(Ajustes de Base Setting

fébrica) Rec Format
Codec
S&Q Motion

Picture Cache Rec

Simul Rec

Output Format
Monitor LUT
Clip

VF Setting
Assignable Button

Assignable Dial
Format Media
Edit User Menu
Add Item
Customize Reset
ISO/Gain/EI
Auto Exposure

Edit User

Camera

Focus
Shutter
Color Bars

Noise Suppression
Flicker Reduce
SteadyShot

Handle Zoom

Auto Black Balance
AF Micro Adjustment
Video Light Set
White

Offset White

Black

Gamma

Paint

Black Gamma

Knee

White Clip
Detail(HD Mode)
Skin Detail
Aperture

Matrix

Multi Matrix
Maintenance
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Audio Audio Input System Base Setting
Audio Output Codec
Video Output On/Off Rec Format
Output Format Genlock
Output Setting Assignable Button
Monitor LUT Assignable Dial
Output Display Rec Lamp
VF VF Setting Fan Control
Peaking HOLD Switch Setting
Zebra Lens
Marker Language
Display On/Off Clock Set
Video Signal Monitor Country
TC/UB Timecode Hours Meter
TC Display Basic Authentication
Users Bit Wi-Fi
HDMI TC Out GPS
Recording S&Q Motion IR Remote
Interval Rec Camera Battery Alarm
Picture Cache Rec Camera DC IN Alarm
Simul Rec Ext. Unit Battery Alarm
SDI/HDMI Rec Control Ext. Unit DC IN Alarm
Thumbnail Display Clip Properties All Reset
Set Index Picture APR
Thumbnail View Camera Config
Set Shot Mark Version
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Filter Clips
Customize View
Media Update Media
Format Media
Clip
File All File
Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File
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Operaciones del menii
de configuracion

Pulse el botén MENU para mostrar el ment de
configuracion en el visor con el fin de especificar
los distintos elementos para filmar, grabar y
reproducir (el mend también se puede visualizar
en un monitor externo).

Controles del menii

Botdon MENU (pdgina 9)
Activa y desactiva el modo de menu para las
operaciones del menu de configuracién.

Boton izquierdo/botdn derecho (pdgina 9)

Dial SEL/SET (pdgina 9)

Pulse el botdn izquierdo/derecho para mover el
cursor hacia la izquierda/derecha y seleccionar
elementos o ajustes del mend.

Gire el dial SEL/SET para mover el cursor hacia
arriba y hacia abajo para seleccionar elementos o
ajustes del menu.

Pulse el dial SEL/SET para aplicar el elemento
seleccionado.

Boton CANCEL/BACK (pdgina 9)
Cancela un ajuste antes de que se aplique y sube
un nivel en la jerarquia del mend.

El meni de configuracion no se puede utilizar cuando el
modo de ampliacién de enfoque estd activado
(pdgina 41).

Elementos del meni de configuracion

Gire el dial SEL/SET para mover el cursor hasta
el elemento del menu que se desea ajustar y, a
continuacién, pulse el dial SET/SEL para
seleccionar el elemento.

« El drea de seleccion de elementos del menu
muestra hasta ocho lineas. Si las opciones
disponibles para un elemento no se pueden
mostrar al mismo tiempo, desplacese por la
pantalla moviendo el cursor hacia arriba/abajo.
Si un elemento tiene una amplia gama de
opciones disponibles (por ejemplo, de —99 a
+99), el area de seleccion no se visualiza. El
ajuste actual se resalta para indicar que el valor
se puede cambiar.
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« Si selecciona [Execute] para una funcion, la
funcién correspondiente se ejecutard.

* Si selecciona un elemento que requiere
confirmacién antes de su ejecucion, el menu se
ocultard temporalmente y se mostrard un
mensaje de confirmacién. Compruebe el
mensaje y a continuacion selecciones si desea
ejecutar o cancelar la funcién.

Introduccion de una cadena de
caracteres

Cuando selecciona un elemento, como por
ejemplo un nombre de archivo, que requiere la
introduccién de caracteres, aparecerd la pantalla
para introducir caracteres.

1

Edit File Name

Kurokawa_Scene_001 a

1 Gire el dial SEL/SET para seleccionar
un tipo de caracter y, a continuacién,
pulse el dial.

ABC: caracteres alfabéticos en mayusculas
abc: caracteres alfabéticos en mintsculas
123: caracteres numéricos

1#$: caracteres especiales

2 Seleccione un caracter del tipo de
caracter seleccionado y, a continuacion,
pulse el dial.

El cursor pasa al campo siguiente.

Space: introduce un caracter de espacio en la
posicién del cursor.

<«—/— : mueve la posicién del cursor.

BS: elimina el caracter a la izquierda del
cursos (retroceso).

3 Cuando acabe, seleccione [Done] y
pulse el dial.
La cadena de caracteres se confirma y la
pantalla de introduccidn de caracteres
desaparece.



Lista del meni de configuracion

Esta seccion describe la funcion y los ajustes de los elementos en cada mend.
Los ajustes predeterminados de fabrica se muestran en negrita (por ejemplo, 18dB ).

Menu User

User

Elemento

Ajuste de subelementos Descripcion

Country
Ajustes de regién

Consulte Country en el mend
System.

Base Setting Consulte Base Setting en el ment
Ajustes bésicos System.
Rec Format Consulte Rec Format en el mend

Ajustes del formato de grabacién

System.

Codec
Ajustes de cédec

Consulte Codec en el ment
System.

S&Q Motion
Ajustes del modo de movimiento
lento y rdpido

Consulte S&Q Motion en el mentd
Recording.

Picture Cache Rec
Ajustes del modo de grabacién de
memoria intermedia

Consulte Picture Cache Rec en el
ment Recording.

Simul Rec
Ajustes de grabacion simultidnea

Consulte Simul Rec en el mend
Recording.

Output Format
Ajustes del formato de salida

Consulte Output Format en el
mend Video.

Monitor LUT Consulte Monitor LUT en el mentd
Ajustes LUT del monitor Video.
Clip Consulte Clip en el mend Media.

Ajustes relacionados con los
nombres de los clips

VF Setting
Ajustes del visor

Consulte VF Setting en el mend
VE.

Assignable Button
Ajustes para asignar funciones a
los botones asignables

Consulte Assignable Button en el
menu System.

Assignable Dial
Ajustes para asignar funciones a
los diales asignables

Consulte Assignable Dial en el
menu System.

Format Media
Formatear (inicializa) tarjeta de
memoria

Consulte Format Media en el mentd
Media.

Edit User Menu
Edici6n de los elementos del
menu User

Edita los elementos en el mend User.
Si selecciona el ment “Edit User Menu”, este
se mueve al nivel superior y se muestran los

elementos del menu.

64



Menu Edit User

El mend Edit User se muestra en el nivel superior cuando se selecciona “Edit User Menu” en el mend

User.

Edit User

Elemento

Ajuste de subelementos

Descripcion

Add ltem
Adicién de un elemento al mend
User

Agrega un elemento del ment al menu User.

Customize Reset
Restablecimiento de los
elementos en el mend User

Restaura los elementos del mend registrados
en el mend User de manera predeterminada de
fébrica.

Elemento de menu seleccionado  Delete Elimina el elemento de mend registrado del
durante la edicién ment User.
Move Reordena los elementos de menu registrados
dentro del ment User.
Edit Sub Item

Elimina los subelementos de ment registrados
en el mend User.

Menu Camera

Camera

Elemento Ajuste de subelementos Descripcion

ISO/Gain/El Mode Selecciona el modo de ajuste de ganancia.
Ajustes de 1SO/dB

ganancia ISO/Gain<H>

rango dindmico es 460%:
1SO 800 /1SO 1000 /
ISO 1250 /1SO 1600 /
1SO 2000 /1SO 2500 /
1SO 3200 / ISO 4000 /
ISO 5000/ ISO 6400

Cuando Mode se ajustaen ISO y el

rango dindmico es 800%:
ISO 1600/ ISO 2000 /
1SO 2500/ ISO 3200 /
1SO 4000 / ISO 5000 /
1SO 6400 / ISO 8000 /
1SO 10000 / ISO 12500

Ajusta el valor predeterminado de ganancia <H>.
Cuando Mode se ajustaen ISOy el Cuando Mode estd ajustado en ISO y el rango dindmico es
1300% (Gamma Category estd ajustado en S-Log2 o S-Log3):
ISO 2000 /ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 / ISO 6400 /
1SO 8000 / ISO 10000 / ISO 12500 /

ISO 16000

Cuando Mode estd ajustado en dB:
—3dB/0dB /3dB/6dB /
9dB /12dB / 18dB

El rango dindmico se determina por el gamma.

Gamma

Rango dinamico

STD/HG1/HG2/HG3/HG4 460%

HG7/HG8 / User 800%

S-Log2/S-Log3

1300%
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Camera

Elemento

Ajuste de subelementos

Descripcion

ISO/Gain<M>
(El mismo ajuste que ISO/
Gain<H>)

Ajusta el valor predeterminado de ganancia <M>.

Los valores predeterminados se indican abajo.

Cuando Mode se ajusta en ISO y el rango dindmico es 460%:
ISO 1600

Cuando Mode se ajusta en ISO y el rango dindmico es 800%:
ISO 3200

Cuando Mode estd ajustado en ISO y el rango dindmico es

1300% (Gamma Category estd ajustado en S-Log2 o S-Log3):
ISO 4000

Cuando Mode estd ajustado en dB:
6dB

ISO/Gain<L>
(El mismo ajuste que ISO/
Gain<H>)

Ajusta el valor predeterminado de ganancia <L>.

Los valores predeterminados se indican abajo.

Cuando Mode se ajusta en ISO y el rango dindmico es 460%:
ISO 800

Cuando Mode se ajusta en ISO y el rango dindmico es 800%:
ISO 1600

Cuando Mode estd ajustado en ISO y el rango dindmico es

1300% (Gamma Category estd ajustado en S-Log2 o S-Log3):
ISO 2000

Cuando Mode estd ajustado en dB:
0dB

Exposure Index<H>
500EI/ 4.0E
640EL / 4.3E
800EI/ 4.7E
1000EL/ 5.0E
1250EI/5.3E
1600EL/5.7E
2000EI / 6.0E
2500EL/ 6.3E
3200EIl / 6.7E
4000EL/ 7.0E
5000EI/7.3E
6400EL/7.7E
8000EI / 8.0E

Ajusta el valor del indice de exposiciéon <H>.
Disponible solo en modo Cine EI.

Exposure Index<M>
(El mismo ajuste que Exposure
Index<H>)

Ajusta el valor del indice de exposicion <M>.
El valor predeterminado es 1600El/ 5.7E

Exposure Index<L>
(El mismo ajuste que Exposure
Index<H>)

Ajusta el valor del indice de exposicion <L>.
El valor predeterminado es 800EI / 4.7E

Shockless Gain
On / Off

Activa y desactiva la funcién de ganancia sin vibraciones.
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Camera

Elemento

Ajuste de subelementos

Descripcion

Auto Exposure
Configuracién de
ajustes de
exposicion
automadtica

Level
-2.0/-1.75/-15/-1.25/
-1.0/-0.75/-0.5/-0.25/0/
+0.25/+0.5/40.75/+1.0/
+1.25/+1.5/+1.75/42.0

Establece el nivel de brillo para la exposicion detectada
automdticamente.

Mode Ajusta el modo de control.

Backlight / Standard / Backlight:

Spotlight Modo de retroiluminacién (modo para reducir el
oscurecimiento de un sujeto cuando dicho sujeto estd
retroiluminado)

Standard:
Modo estdndar
Spotlight:
Modo de luz direccional (modo para reducir la
sobreexposicién de blancos cuando el sujeto recibe un
iluminacién direccional)
Speed Establece la velocidad de ajuste.

De -99 a +99 (x0)

AGC Activa y desactiva la funcion AGC (Control automdtico de

On / Off ganancia).

AGC Limit Ajusta la ganancia maxima de la funcién AGC.

Cuando ISO/Gain/EI >Mode estd
establecido en dB:
3dB /6dB/9dB /12dB /
15dB / 18dB
Cuando ISO/Gain/EI >Mode se
ajusta en ISO y el rango dindmico
es 460%:
1SO1000/1SO1600/ISO2000/
1S03200 / 1SO4000 / ISO6400

Cuando ISO/Gain/EI >Mode se ajusta en ISO y el rango
dindmico es 800%:
1SO2000 / 1S03200 / ISO4000 / 1SO6400 / 1SO8000 /
1SO12500
Cuando ISO/Gain/EI >Mode se ajusta en ISO y el rango
dindmico es 1300%:
1SO2500 / 1SO4000 / ISO5000 / 1SO8000 / 1SO10000 /
1SO16000

Auto Shutter

Activa y desactiva la funcién de control del obturador

On / Off automdtico.
A.SHT Limit Ajusta la velocidad mds rédpida del obturador en la funcién de
1/100/ 1/150/ 1/200 / obturador automético.
1/250/1/2000
Clip High light Activa y desactiva la funcién que ignora las zonas mds
On / Off iluminadas para proporcionar una reaccién menor a la
luminosidad alta.
Detect Window Ajusta el rango del medidor de luz para ajustar

1/2/3/4/5/6

automadticamente la exposicion de acuerdo con la luminosidad
del sujeto. (No disponible cuando se ajusta la exposicién
manualmente)

Detect Window Indication
On / Off

Activa y desactiva la funcién Detect Window.
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Camera

Elemento Ajuste de subelementos Descripcion
Focus Focus Area Establece el drea de destino para el enfoque automdtico
Ajustes de enfoque ~ Wide / Center / Flexible (pdgina 40).

Wide:

busca un sujeto en un dngulo amplio de la imagen al
enfocar.
Center:
enfoca un sujeto en el centro de la imagen.
Flexible Spot:
enfoca una posicion especificada en la imagen.

Focus Area (Push AF)
Center / Flexible

Establece el drea de destino para la funcién Push Auto Focus
(pdgina 41).
Center:
enfoca un sujeto en el centro de la imagen.
Flexible Spot:
enfoca una posicién especificada en la imagen.

En el LA-EA2/4 (opcional), la posicién no se puede
establecer.

AF Assist
On / Off

Cuando estd ajustado en On, le permite anular temporalmente
el enfoque automatico para ajustar el enfoque manualmente.

Shutter Mode

Ajustes de las Speed / Angle / ECS / Off
condiciones

operativas del

obturador

electrénico

Selecciona el modo de operacion del obturador electrénico.

Speed/Angle (modo estdndar):
Se utiliza para filmar con claridad sujetos que se mueven
rapidamente. Selecciona el modo para ajustar la velocidad
del obturador en segundos (Speed) o como el dngulo del
obturador (Angle).

ECS (Extended Clear Scan):
Se utiliza para filmar sin que aparezcan barras horizontales
de desplazamiento en la pantalla del monitor.
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Camera

Elemento Ajuste de subelementos Descripcion
Shutter Speed Ajusta la velocidad del obturador cuando Mode estd ajustado
1/3 a 1/9000 en Speed. Los ajustes disponibles dependen de la frecuencia
de fotogramas del formato de video seleccionado.
59.94P/59.94i:
1/4,1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250,
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000,
1/4000, 1/6000, 1/9000
50P/50i:
1/3, 1/6, 1/12, 1/25, 1150, 1/60, 1/100, 1/120, 1/150, 1/215,
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500,
1/3500, 1/6000, 1/9000
29.97P:
1/4,1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250,
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000,
1/4000, 1/6000, 1/9000
25P:
1/3, 1/6, 1/12, 1/25, 1150, 1/60, 1/100, 1/120, 1/150, 1/215,
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500,
1/3500, 1/6000, 1/9000
24P:
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100,
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200,
1/2400, 1/4800, 1/9000
23.98P:
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100,
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200,
1/2400, 1/4800, 1/9000
Nota |
1/1 se puede establecer cuando la velocidad de fotogramas de
grabacion S&Q estd ajustada en 1fps.
Shutter Angle Ajusta el dngulo del obturador cuando Mode estd ajustado en
5.625°/11.25°/22.5°/45°/  Angle.
90°/120°/ 144° / 150° /
172.8°/180° / 216° / 300°
ECS Frequency Ajusta la frecuencia ECS cuando Mode estd ajustado en ECS.
De 23.99 a 8000 Los ajustes disponibles dependen de la frecuencia de
fotogramas del formato de video seleccionado.
A continuacién se indican los valores predeterminados.
59.94P: 60.00
59.94i: 60.00
50P: 50.00
50i: 50.00
29.97P: 30.00
24P: 24.02
23.98P: 23.99
25P: 25.02
Color Bars Setting Activa y desactiva las barras de colores.
Ajustes de las On / Off
barras de colores m
No se puede ajustar en On cuando se ha configurado para
grabar video RAW.
Type Selecciona el tipo de barra de color.

ARIB / SMPTE / 75% / 100%
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Camera

Elemento Ajuste de subelementos Descripcion

Noise Setting Activa y desactiva la funcién de supresion de ruido.
Suppression On/ Off El valor predeterminado es Off si Base Setting >Shooting
Ajustes de Mode en el ment System estd ajustado en Cine EI.

supresion de ruido Level

Low / Mid / High

Ajusta el nivel de supresién de ruido.

Flicker Reduce Mode

Ajusta el modo de correccién de parpadeo.

Ajustes de Auto / On / Off

correccion de Frequency Ajusta la frecuencia de la fuente de alimentacion que
parpadeo 50Hz / 60Hz proporciona la iluminacion causante del parpadeo.
SteadyShot Setting Activa y desactiva la funcién de estabilizacién de la imagen.
Ajustes de Active SteadyShot / m

estabilizaciéndela ~ SteadyShot / Off

imagen Habilitado cuando se acopla un objetivo compatible.

Handle Zoom
Ajustes del zoom
del asa

Zoom Speed Type
Fix / Variable / Off

Ajusta el modo de la palanca del zoom en el asa.

Desactivado cuando el asa no estd acoplada.

Velocidad de zoom
Del1a8(3)

Ajusta la velocidad del zoom del asa.
(Habilitado cuando Zoom Speed Type esta ajustado en Fix)

Desactivado cuando el asa no estd acoplada.

Auto Black
Balance
Ajustes del
balance
automdtico de
negros

Auto Black Balance
Execute / Cancel

Ejecuta la funcién de balance automdtico de negros.

* Ejecute la funcion de balance automadtico de negros con la
tapa del objetivo acoplada.

* No se puede ejecutar durante la grabacién ni cuando se
muestran las barras de colores.

* No se puede ejecutar cuando se encuentre en el modo
Interval Rec o el modo Slow & Quick Motion.

AF Micro
Adjustment
Microajuste de la
posicién de
enfoque
(Habilitado
cuando se utiliza
LA-EA2/4
(opcional))

Setting Activa/desactiva la funcién de microajuste del enfoque
On/ Off automdtico.
Amount Ajusta el nivel de microajuste del enfoque automético.

De -20a0a +20

Utilice el siguiente procedimiento para ajustar los objetivos de

montura A.

1 Acople el objetivo que desea ajustar con LA-EA2/4
(opcional).

2 Configure Setting en On y ajuste el valor Amount.
Los valores positivos mueven el enfoque detrds del sujeto,
mientras que los valores negativos mueven el enfoque
delante del sujeto.
Se recomienda comprobar el resultado utilizando el AF de
un toque, por ejemplo, mientras se ajusta el enfoque.

Clear All
Execute / Cancel

Inicializa los valores de ajuste guardados.
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Camera

Elemento Ajuste de subelementos Descripcion
Video Light Video Light Set Ajusta el método de control de iluminacién para la luz de
Set Power Link / Rec Link /Rec  video acoplada a la zapata de interfaces miltiples.

Ajustes de luz de
video (cuando se
usa HVL-LBPC
(opcional))

Link + Stby

Power Link:
Activa y desactiva la luz de video cuando el camcorder se
enciende/apaga.

Rec Link:
Activa y desactiva la luz de video cuando el camcorder
inicia/detiene la grabacion.

Rec Link + Stby:
Activa y desactiva la luz de video cuando el camcorder estd
grabando o en modo de espera.
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Menu Paint

Elemento Ajuste de subelementos Descripcion
White Preset White Ajusta el valor predeterminado del balance de blancos.
Ajustes del De 2100K a 10000K (3200K)

balance de blancos (qlor Temp <A>
De 1500K a 50000K (3200K)

Visualiza la temperatura de color del balance de blancos que
estd guardada en la memoria A.

Color Temp. Balance <A>
De 99 a +99 (x0)

Ajusta los valores de ganancia del balance de blancos que
estan guardados en la memoria A (relacionado con ganancia R
y ganancia B).

R Gain <A>
De -99 a +99 (x0)

Ajusta la ganancia R del balance de blancos que estd guardada
en la memoria A.

B Gain <A>
De 99 a +99 (x0)

Ajusta la ganancia B del balance de blancos que estd guardada
en la memoria A.

Color Temp <B>
De 1500K a 50000K (3200K)

Visualiza la temperatura de color del balance de blancos que
estd guardada en la memoria B.

Color Temp. Balance <B>
De 99 a +99 (x0)

Ajusta los valores de ganancia del balance de blancos que
estan guardados en la memoria B (ganancia R y ganancia B
unidas).

R Gain <B>
De 99 a +99 (x0)

Ajusta la ganancia R del balance de blancos que estd guardada
en la memoria B.

B Gain <B>
De -99 a +99 (x0)

Ajusta la ganancia B del balance de blancos que estd guardada
en la memoria B.

Filter White Memory

Activa y desactiva la funcién que ajusta el drea de memoria

On / Off del balance de blancos para cada filtro ND.
On: ajusta la memoria de alance de blancos para cada filtro
ND.
Off: ajusta la memoria de alance de blancos comtin a todos los
filtros ND.
Shockless White Ajusta la velocidad de respuesta del balance de blancos
Off /1/2/3 cuando se cambia el modo de balance de blancos.
Off: cambia instantdneamente.
De 1 a 3: cambia mds lentamente cuanto mayor es el nimero.
White Switch<B> Selecciona el modo de ajuste de balance de blancos
Memory / ATW seleccionado cuando el interruptor WHT BAL est4 ajustado
en B.
ATW Speed Ajusta la velocidad de respuesta en el modo ATW.
1/2/3/4/5 1: Velocidad de respuesta mds rapida
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Elemento Ajuste de subelementos Descripcion
Offset White Offset White <A> Selecciona si se debe (On) o no se debe (Off) anadir un valor
Ajustes de On / Off de desviacion al balance de blancos especificado en la

desviacion del

memoria A.

balance de blancos

Warm Cool <A>
De -99 a +99 (x0)

Ajusta la desviacion afiadida al balance de blancos en la
memoria A como una temperatura de color cuando Offset
White <A> estd ajustado en “On”.

Warm Cool Balance <A>
De -99 a +99 (x0)

Ajusta una temperatura de color mds precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
Warm Cool <A>.

Offset White <B>
On / Off

Selecciona si se debe (On) o no se debe (Off) afadir un valor
de desviacion al balance de blancos especificado en la
memoria B.

‘Warm Cool <B>
De 99 a +99 (x0)

Ajusta la desviacion afiadida al balance de blancos en la
memoria B como una temperatura de color cuando Offset
White <B> estd ajustado en “On”.

‘Warm Cool Balance <B>
De 99 a +99 (x0)

Ajusta una temperatura de color mds precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
Warm Cool <B>.

Offset White<ATW>
On / Off

Selecciona si se debe (On) o no se debe (Off) afiadir un valor
de desviacion al balance de blancos ATW.

Warm Cool<ATW>
De -99 a +99 (x0)

Ajusta la desviacion anadida al balance de blancos ATW como
una temperatura de color cuando Offset White<ATW> estd
ajustado en “On”.

Warm Cool Balance<ATW>
De -99 a +99 (x0)

Ajusta una temperatura de color mds precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
Warm Cool<ATW>.

Black
Ajustes de negro

Setting Activa y desactiva la correccion de negro.
On/ Off
Master Black Ajusta el nivel de negro maestro.

De -99 a +99 (x0)

El ajuste fino es compatible girando el dial SEL/SET
lentamente. En este caso, es posible que el valor que se
muestra no cambie.

R Black Ajusta el nivel de negro R.
De -99 a +99 (x0)
B Black Ajusta el nivel de negro B.

De 99 a +99 (x0)
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Elemento Ajuste de subelementos Descripcion

Gamma Setting Activa y desactiva la funcién de correcciéon gamma.

Ajustes de On/ Off

correccion de Step Gamma Ajusta un valor de correccién gamma en incrementos de 0,05.
gamma De 0.35 2 0.45 2 0.90

Master Gamma
De -99 a +99 (x0)

Ajusta el nivel de gamma maestro.

R Gamma
De -99 a +99 (x0)

Ajusta el nivel de gamma R.

G Gamma Ajusta el nivel de gamma G.
De 99 a +99 (x0)
B Gamma Ajusta el nivel de gamma B.

De -99 a +99 (x0)

Gamma Category
STD /HG / User / S-Log2 /
S-Log3

Selecciona el uso de gamma estdndar (STD), HyperGamma
(HG), gamma de usuario (User), S-Log2 o S-Log3.

Gamma Select
Cuando Gamma Category estd
ajustado en STD:
STD1 DVW /STD2x 4.5/
STD3 x 3.5/ STD4 240M /
STD5 R709 / STD6 x 5.0
Cuando Gamma Category estd
ajustado en HG:
HG1 3250G36 / HG2 4600G30
/HG3 3259G40 / HG4
4609G33 / HG7 8009G40 /
HGS8 8009G33
Cuando Gamma Category estd
ajustado en User:
User 1/ User 2/ User 3/ User 4
/ User 5
Cuando Gamma Category estd
ajustado en S-Log2:
S-Log2
Cuando Gamma Category estd
ajustado en S-Log3:

Selecciona la tabla de gamma utilizada para la correccion
gamma.

Consulte la tabla siguiente para obtener mas informacién
acerca de HyperGamma y S-Log2/S-Log3.

Salida de

video de

Nombre R.altg(). Limite tarjeta gris

dindmico blanco 18%

(entrada de

video 20%)
HG1 3250G36 325% 100% 36%
HG2 4600G30 460% 100% 30%
HG3 3259G40 325% 109% 40%
HG4 4609G33 460% 109% 33%
HG7 8009G40 800% 109% 40%
HGS8 8009G33 800% 109% 33%
S-Log2 1300% - 32%
S-Log3 1300% - 41%

Black Gamma

S-Log3
Setting Activa y desactiva la funcién de correcciéon gamma de negro.
On / Off (Habilitado cuando Gamma >Gamma Category estd ajustado
en STD)
Las funciones Black Gamma y Knee >Knee Saturation no se
pueden utilizar simultdneamente.
Range Selecciona el rango efectivo de correccién gamma del negro.

Low / Mid / High

Master Black Gamma
De 99 a +99 (x0)

Ajusta el nivel de gama del negro maestro.
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Elemento Ajuste de subelementos Descripcion
Knee Setting Activa y desactiva la funcién de correccién de inflexion.
On/ Off (Habilitado cuando Gamma >Gamma Category estd ajustado
en STD)
Auto Knee Activa y desactiva la funcién de correccién de inflexién
On/ Off automatica.
Point Ajusta el punto de inflexion.
De 75% a 109% (90%)
Slope ajusta la pendiente de inflexion.
De 99 a +99 (x0)
Knee Saturation Habilita/inhabilita el ajuste de la saturacion de inflexion
On/ Off (ajusta los colores por encima del punto de inflexion).
Las funciones Black Gamma y Knee >Knee Saturation no se
pueden utilizar simultdneamente.
Knee Saturation Level Ajusta el nivel de ajuste de colores por encima del punto de
De -99 a +99 (x0) inflexi6n (saturacién de inflexion).
White Clip Setting Activa y desactiva la funcién de ajuste de picos del blanco.
Ajustes de ajuste On/ Off

de picos del blanco

« El ajuste se restablece en On cuando se apaga la
videocdmara. Para establecerlo en Off de manera
permanente, ajuste Level en 109%.

* No se puede establecer cuando Gamma > Gamma Category
se ha ajustado en S-Log2 o S-Log3.

Level
De 90.0% a 109.0%

El ajuste predeterminado variara

segtin el pais de adquisicién.
NTSC Area: 108.0%
PAL Area: 105.0%

Ajusta el nivel de limitacién de picos del blanco.
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Elemento Ajuste de subelementos Descripcion
Detail Setting Activa y desactiva la funcién de ajuste de detalles.
Ajustes de ajuste On/ Off
de detalles Level Ajusta el nivel de detalle.
De 99 a +99 (x0)
H/V Ratio Ajusta la relacion de mezcla entre el nivel de detalle H y el
De -99 a +99 (+0) nivel de detalle V.
Crispening Establece el nivel de nitidez.

De -99 a +99 (x0)

Level Depend

Activa y desactiva la funcién de ajuste de la dependencia de

On/ Off nivel.
Level Depend Level Ajusta el nivel de dependencia de nivel.
De -99 a +99 (x0)
Frequency Ajusta la frecuencia central del detalle (grosor del detalle).

De 99 a +99 (x0)

El detalle serd mds fino cuanto mayor sea la frecuencia central
y serd mds grueso cuanto menor sea la frecuencia central.

Knee Aperture
On / Off

Activa y desactiva la funcién de apertura de inflexién.

Knee Aperture Level
De -99 a +99 (x0)

Establece el nivel de apertura de inflexion.

Limit Ajusta el limitador del detalle tanto para la direccién de los
De -99 a +99 (x0) blancos como para la de los negros.

‘White Limit Ajusta el limitador del detalle de los blancos.
De 99 a +99 (x0)

Black Limit Ajusta el limitador del detalle de los negros.
De -99 a +99 (x0)

V Black Limit Ajusta el limitador del detalle V de los negros.

De 99 a +99 (x0)

V Detail Creation

Ajusta la fuente de sefial para crear el detalle V en NAM (G o

NAM/Y/G/G+R R, el que sea mayor), Y, G o G+R.
Skin Detail Setting Activa y desactiva la funcién de correccién de las
Ajustes de On / Off imperfecciones de la piel.

correccion de las
imperfecciones de
la piel

Area Detection
Execute / Cancel

Detecta el color utilizado para la correccion de las
imperfecciones de la piel.
Execute: Ejecutar la deteccion

Area Indication

Activa y desactiva la funcién que muestra patrones cebra en

On / Off dreas de color utilizadas para la correccién de imperfecciones
de la piel.

Level Ajusta el nivel de detalle de la piel.
De 99 a +99 (x0)

Saturation Ajusta la saturacién del color que es objeto de la correccién de
De -99 a +99 (x0) las imperfecciones de la piel.

Hue Ajusta el matiz del color que es objeto de la correccién de las
De 0 a 359 imperfecciones de la piel.

Width Ajusta el rango del matiz del color que es objeto de la
De 0 a 90 (40) correccion de las imperfecciones de la piel.
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Elemento Ajuste de subelementos Descripcion
Aperture Setting Habilita/inhabilita la correccién de la apertura (procesamiento
Ajustes de On/ Off que mejora la resolucion al afiadir una sefial de apertura de alta
correccion de frecuencia a la sefial de video para corregir el deterioro
apertura producido por las caracteristicas de alta frecuencia).
Level Establece el nivel de correccion de apertura.
De 99 a +99 (x0)
Matrix Setting Activa y desactiva la funcién de correccion matricial.
Ajustes de On/ Off
correccion Adaptive Matrix Activa y desactiva la funcién de matriz adaptable.
matricial On/ Off
Preset Matrix Activa y desactiva la funcién de matriz predeterminada.
On/ Off
Preset Select Selecciona una matriz predeterminada.
Standard
High Saturation
FL Light
Cinema
F55 709 Like
User Matrix Activa y desactiva la funcién de correccién matricial del
On / Off usuario.
Level Ajusta la saturacion de color de toda la imagen.
De -99 a +99 (x0)
Phase Ajusta el tono de color (fase) de toda la imagen.

De 99 a +99 (x0)

User Matrix R-G
De -99 a +99 (x0)

Ajusta una matriz del usuario R-G definida por el usuario.

User Matrix R-B
De -99 a +99 (x0)

Ajusta una matriz del usuario R-B definida por el usuario.

User Matrix G-R
De 99 a +99 (x0)

Ajusta una matriz del usuario G-R definida por el usuario.

User Matrix G-B
De -99 a +99 (x0)

Ajusta una matriz del usuario G-B definida por el usuario.

User Matrix B-R
De 99 a +99 (x0)

Ajusta una matriz del usuario B-R definida por el usuario.

User Matrix B-G
De -99 a +99 (x0)

Ajusta una matriz del usuario B-G definida por el usuario.
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Elemento Ajuste de subelementos Descripcion

Multi Matrix Setting Activa y desactiva la funcién de correccién de matrices
Ajustes de On / Off multiples.

correccion de Area Indication Activa y desactiva la funcién de indicacién de drea.
matrices multiples On / Off

Color Detection
Execute / Cancel

Detecta el color utilizado para la correccién de matrices
multiples.

Axis
B /B+/MG-/MG /MG+/
R/R+/YL-/YL/YL+/G-/

Selecciona el eje.

G/G+/CY/CY+/B-
Hue Ajusta el matiz del color utilizado para la correccién de
De 99 a +99 (x0) matrices multiples.
Saturation Ajusta la saturacién del color utilizado para la correccion de
De -99 a +99 (+0) matrices multiples.
Maintenance  Test Saw Activa y desactiva la sefial de prueba.
Ajustes de On / Off
mantenimiento
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Menu Audio

Elemento

Ajuste de subelementos

Descripcion

Audio Input
Ajustes de entrada
de audio

CHI Input Select
INPUT1 / Internal MIC /
Shoe 1

Cambia la fuente de entrada para la grabacién en el canal 1.

CH2 Input Select
INPUTI1 /INPUT2/
Internal MIC / Shoe 2

Cambia la fuente de entrada para la grabacién en el canal 2.

CH3 Input Select
Off / Internal MIC / Shoe 1

Cambia la fuente de entrada para la grabacién en el canal 3.

CH4 Input Select
Off / Internal MIC / Shoe 2

Cambia la fuente de entrada para la grabacién en el canal 4.

INPUT1 MIC Reference
—60dB / -50dB / -40dB

Ajusta el nivel de la grabacion de referencia para la entrada
del micréfono XLR desde INPUTI.

INPUT2 MIC Reference
—60dB / -50dB / -40dB

Ajusta el nivel de la grabacién de referencia para la entrada
del micréfono XLR desde INPUT2.

CH1 Wind Filter

Habilita/inhabilita el filtro de reduccién de ruido del viento

On / Off para la grabacién del canal 1.
CH2 Wind Filter Habilita/inhabilita el filtro de reduccién de ruido del viento
On / Off para la grabacién del canal 2.
CH3 Wind Filter Habilita/inhabilita el filtro de reduccién de ruido del viento
On / Off para la grabacién del canal 3.
CH4 Wind Filter Habilita/inhabilita el filtro de reduccién de ruido del viento
On / Off para la grabacién del canal 4.
CH3 Level Control Selecciona el ajuste de nivel de entrada de audio automdtico o
Auto / Manual el ajuste manual para el canal de grabacion 3.
Si CH3 Input Select o CH4 Input Select estd ajustado en
“Internal MIC”, CH4 cambia a automdatico/manual juntamente
con este ajuste.
CH4 Level Control Selecciona el ajuste de nivel de entrada de audio automadtico o
Auto / Manual el ajuste manual para el canal de grabacion 4.

Si CH3 Input Select o CH4 Input Select estd ajustado en
“Internal MIC”, CH4 cambia a automdtico/manual juntamente
con el ajuste CH3 Level Control.

CH3 Input Level
De 0299 (49)

Establece el nivel de entrada de audio para el canal de
grabacion 3.

Si CH3 Input Select o CH4 Input Select estd ajustado en
“Internal MIC”, el CH4 Input Level cambia juntamente con
este ajuste.
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Ajuste de subelementos

Descripcion

CH4 Input Level Establece el nivel de entrada de audio para el canal de
De 0a 99 (49) grabacion 4.
Si CH3 Input Select o CH4 Input Select estd ajustado en
“Internal MIC”, el CH4 Input Level cambia juntamente con el
ajuste CH3 Input Level.
Audio Input Level Ajusta el nivel de entrada de audio.
De 099 Se puede utilizar como volumen maestro en funcién de los
ajustes de CH1 Level a CH4 Level.
Limiter Mode Selecciona la caracteristica del limitador para sefiales de

Off / -6dB / -9dB / —12dB /
—15dB / -17dB

entrada grandes cuando estd ajustado el nivel de entrada de
audio manualmente.

CH1&2 AGC Mode Establece el modo de ajuste de nivel automatico para la
Mono / Stereo grabacién en el canal 1y en el canal 2.

CH3&4 AGC Mode Establece el modo de ajuste de nivel automatico para la
Mono / Stereo grabacidn en el canal 3 y en el canal 4.

AGC Spec Selecciona la caracteristica AGC.
—6dB /-9dB /-12dB /
—15dB /-17dB

1kHz Tone on Color Bars

Activa y desactiva la sefial de tono de referencia de 1 kHz

On / Off cuando se muestran las barras de colores.
Cuando se ajusta en On, la sefial de tono de referencia de
1 kHz se establece para grabar en el canal 3 y en el canal 4,
aunque CH3 Input Select y CH4 Input Select estén ajustados
en Off.
CH1 Level Ajusta la combinacién de ajustes de nivel de entrada de audio

Entrada sin el adaptador de XLR
Audio Input Level / Side /
Level+Side

Entrada con el adaptador de XLR

(pdgina 54)

Audio Input Level / Through

habilitada para el canal de grabacion 1.

“Side” hace referencia al dial CH1 INPUT LEVEL situado en
el lateral del camcorder. Cuando se selecciona Level+Side, el
nivel de grabacion de audio estd determinado por la
combinacién de Audio Input Level y los ajustes del dial
(pdgina 135).

CH2 Level

Entrada sin el adaptador de XLR
Audio Input Level / Side /
Level+Side

Entrada con el adaptador de XLR

(pdgina 54)
Audio Input Level / Through

Ajusta la combinacién de ajustes de nivel de entrada de audio
habilitada para el canal de grabacion 2.

“Side” hace referencia al dial CH2 INPUT LEVEL situado en
el lateral del camcorder. Cuando se selecciona Level+Side, el
nivel de grabacion de audio estd determinado por la
combinacién de Audio Input Level y los ajustes del dial
(pdgina 135).
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Elemento

Ajuste de subelementos

Descripcion

CH3 Level

Entrada sin el adaptador de XLR
Audio Input Level / CH3 Input
Level / Level+CH3 Input
Level

Entrada con el adaptador de XLR

(pdgina 54)
Audio Input Level / Through

Ajusta la combinacion de ajustes de nivel de entrada de audio
habilitada para el canal de grabacién 3.

Cuando se selecciona Level+CH3 Input Level, el nivel de
grabacion de audio estd determinado por la combinacién de
Audio Input Level y los ajustes de CH3 Input Level
(pdgina 136).

CH4 Level

Entrada sin el adaptador de XLR
Audio Input Level / CH4 Input
Level / Level+CH4 Input
Level

Entrada con el adaptador de XLR

(pdgina 54)
Audio Input Level / Through

Ajusta la combinacién de ajustes de nivel de entrada de audio
habilitada para el canal de grabacion 4.

Cuando se selecciona Level+CH4 Input Level, el nivel de
grabacion de audio estd determinado por la combinacién de
Audio Input Level y los ajustes de CH4 Input Level
(pdgina 136).

Audio Output
Ajustes de salida
de audio

Monitor CH
CH1/CH2 / CH3/CH4 / MIX
ALL/CHI1/CH2/CH3/CH4

Selecciona la salida del canal de audio en el conector de
auriculares y en el altavoz incorporado.

Si el audio de varios canales se establece para la salida
simultdnea, el nivel de salida de cada canal se reduce para la
emisién con el fin de evitar la sobreexposicion.

Monitor Volume

Ajusta la salida del nivel de audio del monitor al conector de

De0al5(7) auriculares y al altavoz incorporado.

Headphone Out Selecciona si la salida del conector de los auriculares es
Mono / Stereo monoaural (Mono) o estéreo (Stereo).

Alarm Volume Ajusta el volumen de la alarma.
De0Oa7(4)

Output Limiter Activa y desactiva el limitador de salida de audio.
On / Off

HDMI Output CH Ajusta la combinacion de canales de audio en la salida HDMI.
CH1/CH2 / CH3/CH4
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Meni Video

Elemento Ajuste de subelementos

Descripcion

Output On/Off SDI

Activa y desactiva la salida SDI.

Ajustes de salida On/ Off
de video HDMI Activa y desactiva la salida HDMI.
On/ Off
Output Format SDI Ajusta la resolucién de salida de SDI y HDMI.
Ajustes del HDMI Para obtener mds detalles acerca de los ajustes, consulte
formato de salida REF “Formatos de video y sefiales de salida” (pdgina 109).

Es posible que el ajuste de Output Format no se pueda
configurar en el modo Picture Cache Rec. Si esto sucede,
ajuste temporalmente Picture Cache Rec en Off y, a
continuacién, cambie el ajuste.

Output Setting HDMI Target Device
Ajustes del modo Recorder / Monitor
de conversién de la

salida

Ajusta el tipo de dispositivo de entrada HDMI conectado a la
salida HDMI.
Recorder:
Emite el mismo video que SDI1 en HDMI cuando se
encuentra en el modo Cine EI
Monitor:
Emite el mismo video que SDI2 en HDMI cuando se
encuentra en el modo Cine EL

4K/2K a HD Conv.
Edge Crop / Letter Box

Establece el modo de conversién para la salida de video HD
del video de 17:9.
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Descripcion

Elemento Ajuste de subelementos
Monitor LUT  Category

Ajustes LUT del LUT / Look Profile / User 3D
monitor LUT

Disponible solo en
modo Cine EL

Es posible que
Monitor LUT no
se pueda
establecer de
manera
independiente para
cada sistema

Ajusta el tipo de Look aplicado como LUT del monitor.

LUT:
Salidas de video a las que se aplica un LUT
predeterminado o del usuario.

Look Profile:
Salidas de video similares a videos o peliculas impresas
que son adecuadas como punto de inicio de la graduacién
de color, si se selecciona un numero de Look.

User 3D LUT:
Salidas de video a las que se aplica un LUT 3D de usuario.

User 3D LUT no se puede seleccionar si Base Setting >Color
Space estd ajustado en S-Gamut/S-Log2 en el mend System.

(pdgina 122). LUT Select
P1: 709(800%)

Selecciona el tipo de LUT, cuando Monitor LUT >Category
estd ajustado en LUT.

P2: HG8009G40 709(800%):
P3: HG8009G33 Sefial con curva base ITU-R709 con rango dindmico
P4: S-Log2 ampliado hasta 800%.
P5: S-Log3 HG8009G40:
Ul Seiial que utiliza HyperGamma con rango dindmico 800%,
U2 limite blanco 109% y salida de video de tarjeta gris18% de
U3 40%.
U4 HG8009G33:
us Seiial que utiliza HyperGamma con rango dindmico 800%,
U6 limite blanco 109% y salida de video de tarjeta gris18% de
33%.
S-Log2:
Seiial de registro con rango dindmico 1300% que tiene en
cuenta la visibilidad en un monitor de video y cuyo metraje
se revela en posproduccion.
(Habilitada cuando Base Setting >Color Space en el menu
System estd ajustado en S-Gamut/SLog?2)
S-Log3:
Seiial de registro con rango dindmico 1300% que imita las
caracteristicas de la pelicula, similar a la curva Cineon Log.
(Habilitada cuando Base Setting >Color Space en el menu
System estd ajustado en S-Gamut3.Cine/SLog3 o
S-Gamut3/SLog3)
Ul to U6:
Sefiales LUT de usuario importadas desde una tarjeta SD.
[ Nota
Seleccione F55/F5 como formato de salida al crear un LUT
mediante el Visor RAW.
Cree e implemente archivos LUT en la siguiente carpeta de
una tarjeta SD.
\PRIVATE\SONY\PRO\CAMERA\PMWF55_F5
Look Profile Select Selecciona el tipo de perfil Look, cuando Monitor LUT
1: LC-709 >Category estd ajustado en Look Profile.
2: LC-709typeA
3: SLog2-709
4: Cine+709
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Elemento Ajuste de subelementos Descripcion

User 3D LUT Select Selecciona el tipo de LUT 3D de usuario.
User 3D-1
User 3D-2
User 3D-3
User 3D-4

SDII & Internal Rec Selecciona si se va a aplicar el LUT de monitor al video de
MLUT On/ MLUT Off salida SDI OUT1 y al video grabado en tarjetas de memoria

XQD.

SDI2 Selecciona si se aplica el LUT de monitor al video de salida de
MLUT On/ MLUT Off SDI OUT2.

HDMI Muestra si se aplica el LUT de monitor al video de salida de
MLUT On/ MLUT Off HDMI (pdgina 122).

Viewfinder Selecciona si se aplica el LUT de monitor al video de salida
MLUT On/MLUT Off del visor.

Output Display SDI2
Ajustes de la sefial On/ Off

de salida HDMI
On/ Off

Selecciona si se superponen los ments y los estados en la
sefial de salida de SDI y en la sefial de salida de HDMI.
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Menu VF

Elemento Ajuste de subelementos Descripcion
VF Setting Brightness Ajusta el brillo de la imagen del visor.
Ajustes del visor De -99 a +99 (£0)
Color Mode Selecciona el modo de visualizacién del visor en modo E-E/
Color / B&W grabacién.
Peaking Setting Activa y desactiva la funcién de nitidez.
Ajustes de nitidez On / Off
Peaking Type Selecciona el tipo de nitidez.
Normal / Color Normal: Nitidez normal

Color: Nitidez del color

Frequency Selecciona la frecuencia de nitidez.
Normal / High
Normal Peaking Level Ajusta el nivel de nitidez normal.
De 0299 (50)
Color Selecciona el color de la sefial de nitidez de color.
B&W /Red/ Yellow / Blue
Color Peaking Level Ajusta el nivel de nitidez de color.
De 0299 (50)
Zebra Setting Activa y desactiva la funcién cebra.
Ajustes de los On / Off
patrones de cebra  7ehra Select Selecciona el tipo de patrén de cebra (Zebra 1, Zebra 2, Both).
1/2/Both
Zebral Level Ajusta el nivel de visualizacién de Zebra 1.
De 0% a 107% (70%)
Zebral Aperture Level Ajusta el nivel de apertura de Zebra 1.
De 1% a 20% (10%)
Zebra2 Level Ajusta el nivel de visualizacién de Zebra 2.

De 0% a 109% (100%)
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Elemento Ajuste de subelementos Descripcion
Marker Setting Activa y desactiva la visualizacién de todos los marcadores.
Ajustes de On/ Off
visualizacién de Color Selecciona el color de la sefial de los marcadores.
marcadores White / Yellow / Cyan / Green /
Magenta / Red / Blue
Center Marker Activa y desactiva el marcador central.
1/2/37410Off
Safety Zone Activa y desactiva el marcador de la zona de seguridad.
On / Off

Safety Area
80% / 90% / 92.5% 1 95%

Selecciona el tamafio del marcador de la zona de seguridad
(como un porcentaje del tamaiio total de la pantalla).

Aspect Marker Selecciona el tipo de marcador de aspecto.
Line / Mask / Off

Aspect Mask Ajusta el nivel de senal de video fuera del marcador en
De0al5(12) relacion con la sefal dentro del marcador en forma de

porcentaje.

Aspect Safety Zone Activa y desactiva el marcador de la zona de seguridad de
On/ Off aspecto.

Aspect Safety Area Selecciona el tamafio del marcador de la zona de seguridad de
80% 190% / 92.5% / 95% aspecto (como un porcentaje del tamaiio total de la pantalla).

Aspect Select Ajusta el modo cuando se muestra el marcador de aspecto.
4:3/1.66:1/
1.85:1/2.35:1/2.4:1

User Box Activa y desactiva la visualizacién del cursor de cuadro.
On / Off

User Box Width Ajusta la amplitud del cursor de cuadro (distancia del centro a

De 3 a 479 (240)

los bordes derecho e izquierdo).

User Box Height
De 3 a 269 (135)

Ajusta la altura del cursor de cuadro (distancia del centro a los
bordes superior e inferior).

User Box H Position
De —476 a +476 (0)

Ajusta la posicién horizontal del centro del cursor de cuadro.

User Box V Position
De -266 a +266 (0)

Ajusta la posicion vertical del centro del cursor de cuadro.

100% Marker Activa y desactiva el marcador de 100%.
On / Off

Guide Frame Activa y desactiva la visualizacién del fotograma de la
On / Off imagen.
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Elemento Ajuste de subelementos

Descripcion

Display On/Off Setting
Ajustes de los On/ Off

Selecciona los elementos que se visualizan en el visor.

elementos de la Shutter Setting
pantalla On/ Off

ND Filter Position
On/ Off

Gain Setting
On/ Off

Rec/Play Status
On/ Off

HXR-IFRS5 Rec Control
On/ Off

Color Temp.
On/ Off

Frame Rate / Interval
On/ Off

Battery Remain
On/ Off

Timecode
On/ Off

Audio Manual
On/ Off

Audio Level Meter
On/ Off

Media Status
On/ Off

Focus Position
Meter / Feet / Off

Iris Position
On/ Off

Zoom Position
Number / Bar / Off

SteadyShot
On/ Off

Focus Mode
On/ Off

Focus Area Indicator
On/ Off

Focus Area Ind. (Push AF)
On/ Off

Focus Indicator
On/ Off

Auto Shutter
On/ Off

AGC
On/ Off

Auto Iris
On/ Off
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Elemento

Ajuste de subelementos

Descripcion

AE Mode
On/ Off

Auto Exposure Level
On/ Off

White Balance Mode
On/ Off

SDI/HDMI Rec Control
On/ Off

Rec Format
On/ Off

Gamma
On/ Off

Timecode Lock
On/ Off

Wi-Fi Condition
On/ Off

Clip Name
On / Off

Focus Assist Indicator
On/ Off

Focus Area Marker
On/ Off

Video Level Warning
On/ Off

Clip Number
On/ Off

GPS
On/ Off

Level Gauge
On/ Off

Lens Info
Meter / Feet / Off

Notice Message
On/ Off

Video Signal
Monitor

Ajustes de monitor
de senal de video
(pdgina 52)

Setting
Off / Waveform / Vector /
Histogram

Establece el tipo de monitor de sefial de video.

No se muestra cuando Display On/Off > Setting estd ajustado
en Off.

Source

En el modo Cine EI con una
resolucién de salida de video de

2K o inferior:

SDI1 & Internal Rec / SDI2

En el modo Custom o en el
modo Cine EI con una

resolucién de salida de video

superior a 2K:
Internal Rec

Establece la fuente de medicién del monitor de sefial de video.
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Ment TC/UB

TC/UB

Elemento Ajuste de subelementos Descripcion
Timecode Mode Ajusta el modo de ejecucion del cédigo de tiempo.
Ajustes de c6digo Preset / Regen / Clock Preset:
de tiempo Empieza a funcionar a partir de un valor preestablecido.
Regen:
Empieza a funcionar a partir del cédigo de tiempo del final
del clip anterior.
Clock:
Utiliza el reloj interno como cédigo de tiempo.
Run Rec Run: Funciona solo durante la grabacion.
Rec Run / Free Run Free Run: Funciona siempre, independientemente del
funcionamiento del camcorder.
Setting Ajusta el cédigo de tiempo en un valor arbitrario.
SET: Ajustar el valor.
Reset Restablece el valor del cédigo de tiempo a 00:00:00:00
Execute / Cancel Execute: Restablece el codigo de tiempo
TC Format Ajusta el formato del cédigo de tiempo.
DF / NDF DF: Omisién de fotograma
NDF: No omisién de fotograma
TC Display Display Select Cambia la visualizacion de datos de tiempo.
Ajustes de Timecode / Users Bit /

visualizacién de
datos de tiempo

Duration

Users Bit Mode Ajusta el modo de bit de usuario.

Ajustes Fix / Time Fix: Utiliza un valor fijo arbitrario en bits de usuario.

relacionados con Time: Utiliza la hora actual en bits de usuario.

los bits de usuario. getting Ajusta los bits de usuario en un valor arbitrario.

HDMI TC Out  Setting Ajusta si enviar la salida del c6digo de tiempo a dispositivos
On / Off con otros objetivos, mediante HDMI.
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Meni Recording

Elemento Ajuste de subelementos

Descripcion

S&Q Motion
Ajustes del modo
de movimiento
lento y rapido
(pdgina 48)

Setting
On / Off

Activa y desactiva el movimiento lento y rdpido.
Cuando se ajusta en On, se inhabilitan las siguientes
funciones.

* Auto iris

 Auto focus

High Frame Rate Mode
Off / Full Scan / Center Scan

Permite una velocidad de imdgenes superior a 60P.

Off:
Se inhabilita la velocidad de imagenes superior a 60P.

Full Scan:
Imégenes de alta velocidad de dngulo de visién de tamafio
Stper de 35mm.

Center Scan:
Imagenes de alta velocidad de la mitad del dngulo de vision
de tamafio Stper de 35mm en el centro de la imagen.

Este ajuste no se puede establecer de conformidad con Imager
Scan Mode cuando Imager Scan Mode estd ajustado en 2K
Full o 2K Center.

Frame Rate
Up to 240fps

Ajusta la velocidad de fotogramas para la filmacién con
movimiento lento y rdpido.

El valor inicial varia segtin los ajustes de Codec, Country,
Video Format y RAW Output Format.

Interval Rec
Ajustes de Interval
Rec (pdgina 48)

Setting
On / Off

Activa y desactiva el modo de grabacién de intervalo. (Si se
ajusta este modo en On, el resto de modos especiales se
ajustard en Off).

Interval Time
1/2/3/4/5/6/7/819/

10/15/20/30/40/50(s) 1/

2/3/4/516/7/8/9/710/
15/20/30/40/50/ (min) 1/
2/3/4/6/12/24 (hora)

Ajusta el intervalo entre grabaciones en el modo de grabacién
Interval Rec (cuando Interval Rec estd ajustado en On).

Number of Frames
1frame / 2frames / 3frames /
6frames / 9frames / 12frames

Ajusta el nimero de fotogramas que se desea grabar por toma
en el modo de grabacién Interval Rec (cuando Interval Rec
estd ajustado en On).
Los ajustes disponibles dependen de la frecuencia de
fotogramas del formato de video seleccionado.
50P/59.94P:

2frames / 6frames / 12frames
23.98P /25P /29.97P / 50i / 59.94i:

1frame / 3frames / 6frames / 9frames

Pre-Lighting

Disponible inicamente cuando se

utiliza el HVL-LBPC (opcional).
Off / 2sec / 5sec / 10sec

Ajusta el nimero de segundos que se enciende la luz de video
antes de que se inicie la grabacién en el modo de grabacién
Interval Rec.
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Elemento Ajuste de subelementos Descripcion

Picture Cache Setting Activa y desactiva la funcién de grabacién de memoria

Rec On / Off intermedia.

Ajustes del modo  Cache Rec Time Ajusta el tiempo de grabacién de memoria intermedia, cuando
de grabaci6n de 0-2sec / 2-4sec / 4-6sec / Picture Cache Rec estd ajustado en On.

memoria 6-8sec / 8-10sec /

intermedia 10-12sec / 12-14sec /

(pdgina 50) 13-15sec

Simul Rec Setting Activa y desactiva la funcién de grabacién simultdnea y ajusta
Ajustes de On / Off el soporte de destino de grabacion.

gfabacién Rec Button Set Asigna los botones de grabacion utilizados para controlar cada
simultdnea “Rec Button [SlotA SlotB] soporte de grabacion.

(pdgina 39) Handle Rec Button [SlotA

SlotB]” / “Rec Button [SlotA]
Handle Rec Button [SlotB]” /
“Rec Button [SlotB] Handle
Rec Button [SlotA]”

SDI/HDMI Rec  Setting Activa y desactiva el control de inicio/parada de grabacién
Control On / Off para un dispositivo externo conectado, mediante sefiales SDI/
Ajustes de control HDMI.

de grabacién SDI/ Cuando se asignan botones distintos mediante Rec Button Set,
HDMI la sefial de control de grabacién sigue el estado de grabacién

de la ranura A.

Cuando estd ajustada en On, esta funcién inicia/detiene la
grabacion en un dispositivo conectado externo, incluso si en
ese momento no hay insertada ninguna tarjeta XQD.
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Meni Thumbnail

Thumbnail

Elemento Ajuste de subelementos Descripcion
Display Clip Muestra la pantalla de propiedades de visualizacién de clips.
Properties

Display clip
properties screen

Set Index
Picture

Ajustes de imagen
indice de clip

Ajusta la imagen indice de un clip.

Thumbnail Essence Mark Thumbnail

View All / Rec Start / Shot Mark1 /

Ajustes de la Shot Mark2 / Shot Mark3 /

pantalla de Shot Mark4 / Shot Mark5 /

imdgenes en Shot Mark6 / Shot Mark7 /

miniatura Shot Mark8 / Shot Mark9 /
Shot Mark0

Muestra las imdgenes en miniatura de fotogramas con
marcadores.

Clip Thumbnail

Muestra las imdgenes en miniatura de clips grabados.

Set Shot Mark Add Shot Mark1

Agrega la marca de filmacién 1.

Ajustes de marcas DeJete Shot Mark

Elimina la marca de filmacién 1.

de filmaci6n Add Shot Mark2

Agrega la marca de filmacién 2.

Delete Shot Mark2

Elimina la marca de filmacién 2.

Set Clip Flag  Add OK Agrega una marca OK.
Ajustes de marca  Add NG Agrega una marca NG.
de clip Add KEEP Agrega una marca Keep.
Delete Clip Flag Elimina todas las marcas.
Lock/Unlock  Select Clip Selecciona y bloque/desbloquea un clip.
Clip Lock All Clips Bloquea todos los clips.
Protecci6n de clips Unlock All Clips Desbloquea todos los clips.
Delete Clip Select Clip Elimina el clip seleccionado.
Elimina un clip All Clips Elimina todos los clips mostrados.
Filter Clips OK Muestra todos los clips con la marca OK.
A_juste%s d‘f ) NG Muestra todos los clips con la marca NG.
I’(;:u:ﬂ:;gl?:dgzb KEEP Muestra todos los clips con la marca Keep.
None Muestra solo los clips que no tienen marca.
Customize Thumbnail Caption Cambia la informacién mostrada debajo de las imdgenes en
View Date Time / Time Code / miniatura.

Ajustes de la Duration / Sequential Number
pantalla de
imdgenes en

miniatura
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Menu Media

Elemento Ajuste de subelementos Descripcion

Update Media Media (A) Actualiza el archivo de gestién en la tarjeta de memoria XQD
Actualizar tarjetas Execute / Cancel en la ranura A.

de memoria Execute: Actualizar la tarjeta

Media (B)
Execute / Cancel

Actualiza el archivo de gestion en la tarjeta de memoria XQD
en la ranura B.
Execute: Actualizar la tarjeta

Format Media Media (A) Inicializa la tarjeta de memoria XQD en la ranura A.
Formatear Execute / Cancel Execute: Inicializar la tarjeta
(inicializa) tarjeta  Media (B) Inicializa la tarjeta de memoria XQD en la ranura B.
de memoria Execute / Cancel Execute: Inicializar la tarjeta
SD Card Inicializa la tarjeta UTILITY SD.

Execute / Cancel Execute: Inicializar la tarjeta
Clip Auto Naming Ajusta el método para nombrar clips.
Ajustes del Cam ID + Reel#/ Title Cam ID + Reel#:

nombre del clip

ID de la cdmara + Nimero de rollo + Nimero de filmacién
+ Fecha + cadena aleatoria

Title:
Cadena ajustada con Prefijo de titulo + Nimero de clip

Cuando Simul Rec estd ajustado en On, no se puede
configurar Cam ID + Reel#.

Camera ID Ajusta el identificador de la cdmara cuando Auto Naming estd
DeAaZ ajustado en Cam ID + Reel#.
Reel Number Ajusta la parte numérica del nimero de rollo cuando Auto
De 001 a 999 Naming estd ajustado en Cam ID + Reel#.
Camera Position Ajusta el prefijo del nimero de filmacién cuando Auto
C/L/R Naming estd ajustado en Cam ID + Reel#.
Title Prefix Ajusta la parte del titulo del nombre del clip cuando Auto
Naming estd ajustado en Title.
(El valor inicial es un identificador especifico del modelo y
comprende al menos tres digitos de un nimero de serie).
(El valor se introduce mediante una pantalla de introduccién
de caracteres (pdgina 63)).
Number Set Ajusta la parte numérica del nombre del clip cuando Auto

De 0001 a 9999

Naming estd ajustado en Title.
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Meni File

Elemento Ajuste de subelementos Descripcion
All File Load SD Card Carga un archivo ALL.
Ajuste relacionado Execute / Cancel Execute: Cargar archivo
con los archivos  gave SD Card Guarda un archivo ALL.
ALL. Execute / Cancel Execute: Guardar archivo
File ID Asigna un nombre al archivo.
Scene File Recall Internal Memory Carga un archivo de escena desde la memoria interna.
Ajustes de Execute / Cancel Execute: Cargar archivo

archivos de escena

Store Internal Memory
Execute / Cancel

Guarda un archivo de escena en la memoria interna.
Execute: Guardar archivo

Load SD Card Carga un archivo de escena desde una tarjeta SD.
Execute / Cancel Execute: Cargar archivo
Save SD Card Guarda un archivo de escena en una tarjeta SD.
Execute / Cancel Execute: Guardar archivo
File ID Asigna un nombre al archivo.
Scene White Data Ajusta si se deben aplicar los datos de balance de blancos
On / Off cuando se cargan archivos de escena.
User Menu Load SD Card Carga los ajustes del mend User en una tarjeta SD de la
Item Execute / Cancel memoria interna.

Ajustes de los
elementos del
menu de usuario

Execute: Cargar ajustes

Save SD Card Guarda los ajustes del ment User en una tarjeta SD.
Execute / Cancel Execute: Guardar ajustes
File ID Muestra el identificador de archivo especificado para el

archivo cargado mediante Load SD Card. También ajusta
(edita) el identificador de archivo cuando guarda un archivo
con este menu.

User Gamma
Ajustes de
archivos gamma
de usuario

Current Settings

Muestra una lista de los ajustes actuales de archivos gamma de
usuario (nombres de archivos).

Load SD Card
Execute / Cancel

Carga los ajustes de gamma de usuario en una tarjeta SD de la
memoria interna.

Execute: Cargar gamma

Para utilizar los archivos gamma creados con CvpFileEditor™
V4.2 con el camcorder, guarde los archivos en la siguiente
carpeta de la tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\HD_CAM

Reset
1/2/3/4/5/A1
Valor inicial: 709(800%)

Restablece los archivos de gamma de usuario en la memoria
interna a los valores predeterminados.

De 1 a 5: Restablece gamma de usuario individual

All: Restablece todos los gammas de usuario
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Elemento Ajuste de subelementos Descripcion

Monitor LUT  Current Settings Muestra una lista de los ajustes actuales de archivos LUT del
Ajustes de monitor (nombres de archivos).

archi'vos LUT del 1 0ad SD Card Carga los ajustes de LUT del monitor en una tarjeta SD de la
monitor Execute / Cancel memoria interna.

Execute: Cargar ajustes LUT

Guarde los archivos LUT del usuario generados utilizando
RAW Viewer en la siguiente carpeta de la tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Reset Restablece los datos LUT del monitor en la memoria interna a
1/2/3/4/5/6/Al los valores predeterminados.
De 1 a 6: Restablece el LUT de monitor individual
All: Restablece todos los LUT de monitor

Monitor 3D Current Settings Muestra una lista de los ajustes actuales de archivos LUT 3D
LUT del monitor (nombres de archivos).

Ajustes de Load SD Card Carga los ajustes de LUT 3D del monitor en una tarjeta SD de
archivos LUT 3D Execute / Cancel la memoria interna.

del monitor Execute: carga ajustes LUT 3D

Puede importar archivos CUBE (*.cube) con resolucién de
entramado de 17 o 33 creados mediante Catalyst Browse,
RAW Viewer o BMD Da Vinci Resolve*.

* Verificado con Resolve V9.0, V10.0y V11.0.

Si crea un archivo CUBE mediante Catalyst Browse 0 RAW
Viewer, establezca el ajuste de Source en Catalyst Browse o el
ajuste de Input en RAW Viewer en S-Gamut3.Cine/S-Log3.
Ajuste Format en Resolve al exportar el archivo CUBE.
Guarde los datos LUT 3D creados (archivo LUT 3D de
usuario) en la siguiente carpeta de la tarjeta SD.
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

La funcién Monitor 3D LUT no se puede utilizar si Base
Setting >Color Space estd ajustado en S-Gamut/S-Log2 en el
menu System del camcorder.

Reset Restablece los datos LUT 3D del monitor en la memoria
1/2/3/747Al interna a los valores predeterminados.
De 1 a 4: restablece el LUT 3D de monitor individual
All: restablece todos los LUT 3D de monitor

Lens File White Offset R Ajusta el valor de correccién del canal R de desviacion del
Ajustes de De -99 a +99 (£0) balance de blancos para el objetivo en el archivo del objetivo.
arc{hiyos del White Offset B Ajusta el valor de correccién del canal B de desviacion del
objetivo De -99 a +99 (0) balance de blancos para el objetivo en el archivo del objetivo.

Coloque los archivos en las siguientes carpetas de la tarjeta SD.
Archivos ALL, archivos Scene, User Menu Item:
PRIVATE\Sony\PRO\CAMERA\PXW-FS7
Archivos de gamma de usuario:
PRIVATE\Sony\PRO\CAMERA\HD_CAM
Archivos LUT de monitor, archivos LUT 3D de monitor:
PRIVATE\Sony\PRO\CAMERA\PMWF55_F5

95



Meni System

Elemento Ajuste de subelementos Descripcion
Base Setting  Shooting Mode Ajusta el modo de filmacién.
Ajustes bésicos Custom / Cine EI

Color Space Ajusta el espacio de color.

S-Gamut/SLog?2 /
S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3 / Matrix

Imager Scan Mode
Normal / 2K Full / 2K Center

Ajusta el modo de escaneado para capturar informacién a
través del sensor de imagen (pdgina 27).

Codec
Ajustes de cédec

Select
RAW/RAW & XAVC-1/RAW
& XAVC-L /RAW & MPEG
HD 422 / XAVC-l1/ XAVC-L /
MPEG HD 422 / ProRes 422
HQ / ProRes 422

Ajusta el modo de grabacién/reproduccién.

* RAW /RAW & XAVC-1/RAW & XAVC-L /RAW &
MPEG HD 422 estan disponibles cuando se conecta un
XDCA-FS7 y Base Setting >Shooting Mode se ajusta en
Cine EL.

* ProRes 422 HQ / ProRes 422 estdn disponibles solamente
cuando se conecta un XDCA-FS7.
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Elemento Ajuste de subelementos Descripcion
Rec Format Video Format Ajusta el formato de grabacion.
Ajustes de formato

de grabacién

Cuando Codec >Select estd
ajustado en ProRes 422 HQ o

« En sistemas NTSC:

Si Codec >Select estd ajustado en

XAVC-I:

* En sistemas PAL:
Si Codec >Select estd ajustado en XAVC-I:
4096x2160 50P

4096x2160 59.94P
4096x2160 29.97P
4096x2160 24.00P
4096x2160 23.98P
3840x2160 59.94P
3840x2160 29.97P
3840x2160 23.98P
1920x1080 59.94P
1920x1080 59.94i
1920x1080 29.97P
1920x1080 23.98P

Si Codec >Select estd ajustado en
XAVC-L:

3840x2160 59.94P
3840x2160 29.97P
3840x2160 23.98P

1920x1080 59.94P 50

1920x1080 59.94P 35
1920x1080 59.94i 50
1920x1080 59.94i 35
1920x1080 59.94i 25
1920x1080 29.97P 50
1920x1080 29.97P 35
1920x1080 23.98P 50
1920x1080 23.98P 35

Si Codec >Select estd ajustado en
MPEG HD422:
1920x1080 59.94i 50

1920x1080 29.97P 50
1920x1080 23.98P 50
1280x720 59.94P 50
1280x720 29.97P 50
1280x720 23.98P 50

ProRes 422:

1920x1080 59.94i
1920x1080 29.97P
1920x1080 23.98P

4096x2160 25P
3840x2160 50P
3840x2160 25P
1920x1080 50P
1920x1080 50i
1920x1080 25P

Si Codec >Select estd ajustado en XAVC-L:

3840x2160 50P
3840x2160 25P
19201080 50P 50
1920x1080 50P 35
1920x1080 50i 50
1920x1080 50i 35
19201080 50i 25
1920x1080 25P 50
1920x1080 25P 35

Si Codec >Select estd ajustado en MPEG HD422:

1920x1080 50i 50
1920x1080 25P 50
1280x720 50P 50
1280x720 25P 50

Cuando Codec >Select estd ajustado en ProRes 422 HQ o
ProRes 422:

1920x1080 50i
1920x1080 25P

“---"aparece en gris cuando Codec >Select estd ajustado en

RAW.

Los valores fijos aparecen en gris cuando Codec >Select estd
establecido en RAW & XAVC-I, RAW & XAVC-L o RAW

& MPEG HD 422.

El formato de grabacién no se puede ajustar en 4096x2160 o
3840x2160 cuando Imager Scan Mode estd ajustado en 2K

Full o 2K Center.
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Elemento Ajuste de subelementos Descripcion
RAW Output Format Ajusta el formato de grabacion para una grabadora externa
RAW.
* En sistemas NTSC: * En sistemas PAL:
Cuando Codec >Select estd Cuando Codec >Select estd ajustado en un elemento que
ajustado en un elemento que incluye RAW e Imager Scan Mode estd ajustado en Normal:
incluye RAW e Imager Scan Mode ~ 4096x2160 50P
estd ajustado en Normal: 4096x2160 25P
4096x2160 59.94P Cuando Codec >Select estd ajustado en un elemento que
4096x2160 29.97P incluye RAW e Imager Scan Mode est4 ajustado en 2K Full o
4096x2160 23.98P 2K Center:
Cuando Codec >Select estd 2048x1080 50P
ajustado en un elemento que 2048x1080 25P
incluye RAW e Imager Scan Mode
estd ajustado en 2K Full 0 2K
Center:
2048x1080 59.94P
2048x1080 29.97P
2048%1080 23.98P
Genlock Reference Muestra el estado del generador de sincronismo. Muestra el
Ajustes del Internal / External(HD) / tipo de sefial si se aplica el generador de sincronismo.
generador de External(SD) Internal: no se aplica un generador de sincronismo externo.
sincronismo External(HD): generador de sincronismo a la sefial HD.
External(SD): generador de sincronismo a la sefial SD.
Assignable De <1>a <6> Asigna funciones a los botones asignables.
Button Off / Marker / Zebra / Peaking / Marker:
Ajustes de los Video Signal Monitor / Focus Activa y desactiva la funcién de marcador.
botones asignables Magnifier x4/x8 / Focus Magnifier Zebra:
x4 / Focus Magnifier x8 / Focus Activa y desactiva la funcién cebra.
Area / Focus Area (Push AF) / VF Peaking:

Mode / IRIS / Push Auto Iris /
AGC / Push AGC/ SHUTTER /
Auto Exposure Level / Spotlight /
Backlight / ATW / ATW Hold /
Push AF/Focus Hold / SteadyShot
/ Color Bars / User Menu / Rec
Lamp / S&Q Motion / Picture
Cache Rec / Rec Review /
Thumbnail / Shot Mark1 / Shot
Mark?2 / Clip Flag OK / Clip Flag
NG / Clip Flag Keep /
DURATION/TC/U-BIT / High/
Low Key

Activa y desactiva la funcién de nitidez.
Video Signal Monitor:
Cambia el monitor de sefial de video (como un monitor de
forma de onda).
Focus Magnifier x4/x8:
Focus Magnifier x4:
Focus Magnifier x8:
Activa y desactiva la funcién de ampliacion de enfoque.
Focus Area:
Focus Area (Push AF):
Abre la pantalla de configuracién de Focus Area.
VF Mode:
Cambia la visualizacién del visor entre color y blanco y
negro.
IRIS:
Cambia la funcién del diafragma entre automadtica y
manual.
Push Auto Iris:
Habilita la funcién de diafragma automdtico mientras se
mantenga pulsado el botén.
AGC:
Activa y desactiva la funcién AGC.
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Elemento

Ajuste de subelementos

Descripcion

Push AGC:
Habilita la funcién AGC mientras se mantenga pulsado el
botén.
SHUTTER:
Cambia la funcién del obturador entre automética y
manual.
Auto Exposure Level:
Abre la pantalla de nivel de exposicién automatico.
Spotlight:
Cambia entre luz direccional y estdndar.
Backlight:
Cambia entre retroiluminacién y estandar.
ATW:
Activa y desactiva la funcién ATW.
ATW Hold:
Pausa la operacién de la funcion ATW.
Push AF/Focus Hold:
Ejecuta la funcién de enfoque automdtico con un toque o la
funcién de detencion temporal de enfoque.
SteadyShot:
Cambia entre Active SteadyShot, SteadyShot y Off.
Color Bars:
Activa y desactiva las barras de colores.
User Menu:
Abre/cierra el ment User.
Rec Lamp:
Activa y desactiva el indicador de grabacion.
S&Q Motion:
Activa y desactiva el movimiento lento y rdpido.
Establece la velocidad de fotogramas de grabacién si se
mantiene pulsado.
Picture Cache Rec:
Activa y desactiva el modo de grabacién de memoria
intermedia.
Rec Review:
Activa y desactiva la funcién Rec Review.
Thumbnail:
Abre/cierra la pantalla de imdgenes en miniatura.
Shot Mark1:
Ejecuta la funcién Add Shot Mark1.
Shot Mark2:
Ejecuta la funcién Add Shot Mark2.
Clip Flag OK:
Ejecuta la funcién Add OK.
Pulse dos veces para ejecutar Delete Clip Flag.
Clip Flag NG:
Ejecuta la funcién Add NG.
Pulse dos veces para ejecutar Delete Clip Flag.
Clip Flag Keep:
Ejecuta la funcién Add Keep.
Pulse dos veces para ejecutar Delete Clip Flag.
DURATION/TC/U-BIT:
Alterna entre Time Code, Users Bit y Duration.
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Elemento Ajuste de subelementos Descripcion
High/Low Key:
Alterna entre High Key (visualizacién para comprobar los
blancos apagados), Low Key (visualizacién para
comprobar las dreas subexpuestas) y Off (visualizacién
normal) en este orden.
Se puede aplicar a los sistemas en los que Monitor LUT
estd ajustado en On.
Assignable Assignable Dial Asigna funciones a los diales asignables en el control remoto
Dial Off / ISO/Gain/EI / IRIS / de empunadura.
Ajustes de diales Focus / Audio Input Level ISO/Gain/ElL: Ajusta la ganancia o EI.
asignables IRIS: Ajusta el diafragma.
Focus: Ajusta el enfoque.
Audio Input Level: Ajusta el nivel de audio.
IRIS Dial Asigna funciones al dial IRIS.
(Los mismos ajustes que
Assignable Dial)
Assignable Dial Direction Ajusta el sentido de rotacién del dial asignable en el control
Normal / Opposite remoto de empuiiadura.
Normal: Girar en sentido de avance.
Opposite: Girar en sentido contrario.
IRIS Dial Direction Ajusta el sentido de rotacién del dial IRIS.
Normal / Opposite Normal: Girar en sentido de avance.
Opposite: Girar en sentido contrario.
Rec Lamp Rec Lamp Activa y desactiva el indicador de grabacion.
Ajustes del On/ Off
indicador de
grabacion
Fan Control Setting Ajusta el modo de control del ventilador del camcorder.

Ajustes del modo
de control del

Auto / Minimum / Off in Rec

ventilador Si la temperatura interna del camcorder asciende por encima
de un valor determinado, el ventilador comenzard a funcionar,
aunque esté seleccionada la opcion “Off in Rec”.

HOLD Switch  with Rec Button Ajusta si se bloquea o no el botén de grabacién.

Setting On/ Off

Ajustes del with Hand Grip Remote Ajusta si se bloquea el funcionamiento del control remoto de

interruptor Hold On/ Off la empufadura.

Lens Zoom Ring Direction Ajusta el sentido de funcionamiento del anillo del zoom.

Ajustes del Left(W)/Right(T) / Right(W)/ m

objetivo Left(T)

Solo estd habilitado cuando se utiliza un objetivo de montura
E compatible con el cambio de direccion del anillo de zoom.

Distortion Comp.
Auto / Off

Activa y desactiva la compensacién automatica de la
distorsion.

* No estd disponible en el modo de grabacién en memoria
intermedia ni durante la grabacion.

» La compensacién de la distorsién no se aplica durante la
grabacion 4K o QFHD.

» Cuando “Auto” esté seleccionado, habrd algunas
restricciones para Monitor LUT (pdgina 122).
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Elemento Ajuste de subelementos Descripcion

Language Select Ajusta el idioma de visualizacién.

Ajustes de idioma SET: Ajustar el lenguaje.

Clock Set Time Zone Ajusta la diferencia horaria desde UTC en intervalos de 30

Ajustes del reloj
interno

UTC 12:00 Kwajalein a UTC
+14:00

minutos.

Date Mode Selecciona el formato de visualizacion de la fecha.
YYMMDD / MMDDYY / YYMMDD: Afio, mes, dia
DDMMYY MMDDYY: Mes, ao, dia
DDMMYY: Dia, mes, afio
12H/24H Ajusta el formato de visualizacién del reloj.
12H / 24H 12H: modo de 12 horas
24H: modo de 24 horas
Date Ajusta la fecha actual.
SET: Ajustar el valor.
Time Ajusta la hora actual.
SET: Ajustar el valor.
Country NTSC/PAL Area Ajusta la regién de uso.
Ajustes de regién NTSC Area/ PAL Area

El ajuste predeterminado variard
segun el pais de adquisicion.

Hours Meter
Ajustes del
medidor de horas

Hours (System)

Muestra el nimero de horas acumuladas de uso (no se puede
restablecer).

Hours (Reset)

Muestra el niimero de horas acumuladas de uso (se puede
restablecer).

Reset
Execute / Cancel

Restablece la visualizacion de Hours (Reset) a 0.
Execute: Restablecer

Basic User Name Ajusta un nombre de usuario deseado (entre 1y 16 caracteres
Authentication (admin) alfanuméricos).

Ajustes de SET: Ajustar el valor.

autenticacion Password Ajusta una contrasefia (entre 1y 16 caracteres alfanuméricos).
basica de red (pxw-fs7) SET: Ajustar el valor.

Wi-Fi Wi-Fi Selecciona si se activa o desactiva la conexién Wi-Fi.

Ajustes de Enable / Disable

conexién LAN SSID & Password Muestra el SSID y la contrasefa.

inaldmbrica

Wi-Fi Direct Connection
Execute / Cancel

Inicia una conexién de red “Wi-Fi Direct”.
Execute: Conectar

Client Muestra informacion acerca del dispositivo cliente conectado
(nombre de modelo y direcciéon MAC).
IP Address Muestra la direccion IP del camcorder.
192.168.1.1 m
No se muestra cuando se utiliza el CBK-WA100.
Subnet Mask Muestra la médscara de subred.
255.255.0.0

No se muestra cuando se utiliza el CBK-WA100.

MAC Address

Muestra la direccion MAC del médulo Wi-Fi acoplado al
camcorder.

Regenerate Password
Execute / Cancel

Crea una nueva contrasefia.
Execute: Ejecutar
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Elemento Ajuste de subelementos Descripcion
GPS GPS Activa y desactiva la funcién GPS.
Ajustes de GPS On/ Off m
El médulo de GPS estd integrado en el asa.
IR Remote Setting Habilita/deshabilita el control desde el control remoto
Ajustes del control On/ Off suministrado.
remoto
Camera Low BATT Ajusta el nivel de baterfa restante a partir del cual se mostrard
Battery Alarm 5% 110% / 15% | -+ 1 45% / una alarma de tensién baja en la bateria (saltos de 5%).

Ajustes de la
alarma de tensién
baja en la bateria

50%

BATT Empty
De 3% a 7%

Ajusta el nivel de baterfa restante a partir del cual se mostrard
una alarma de bateria agotada.

Camera DC IN
Alarm

Ajustes de alarma
de tensién de

DC Low Voltagel
De11,5Val70Vv

Ajusta la tension a partir de la cual se mostrard una alarma de
tensién de entrada DC IN baja.

DC Low Voltage2
De11,0Val4,0V

Ajusta la tensi6n a partir de la cual se mostrard una alarma de
tension de entrada DC IN insuficiente.

entrada

Ext. Unit Near End:Info Battery Ajusta el nivel de bateria restante a partir del cual se mostrard
Battery Alarm De 5% a 100% una alarma de tensién baja en la bateria de Info-Lithium
Ajustes de la (intervalos de 5%).

baterfa XDCA- End:Info Battery Ajusta el nivel de bateria restante a partir del cual se mostrard
ES7 De 0% a 5% una alarma de baterfa Info-Lithium agotada y se detendrd el

acceso a los soportes.

Near End:Sony Battery
De 11.5V a 17.0V

Ajusta el nivel de bateria restante a partir del cual se mostrard
una alarma de tensién baja en una bateria que no sea Info-
Lithium.

End:Sony Battery
De11.0Vall.5V

Ajusta el nivel de bateria restante a partir del cual se mostrard
una alarma de baterfa que no sea Info-Lithium agotada y se
detendrd el acceso a los soportes.

Near End:Other Battery
De 11.5V a 17.0V (11.8V)

Ajusta el nivel de bateria restante a partir del cual se mostrara
una alarma de tensién baja en una bateria Anton/Bauer.

End:Other Battery
De 11.0V a 14.0V

Ajusta el nivel de baterfa restante a partir del cual se mostrard
una alarma de bateria Anton/Bauer agotada y se detendrd el
acceso a los soportes.

Detected Battery

Muestra el tipo de bateria conectada a la XDCA-FS7.

Si hay una bateria conectada a la XDCA-FS7, se mostrard
“Info Battery”, “Sony Battery” o “Other Battery”. Si se ha
conectado una fuente de alimentacién de CC, se mostrard “DC
IN™.

Si la alimentacién se proporciona mediante una bateria o una

s

fuente de CC conectada al camcorder, se mostrard “ --- .

Ext. Unit DC IN
Alarm

Ajustes de alarma
de tension de
entrada en XDCA-
FS7

DC Low Voltagel
De 11.5V a 17.0V

Ajusta la tension a partir de la cual se mostrard una alarma de
tensién de entrada DC IN baja.

DC Low Voltage2
De 11.0V a 14.0V

Ajusta la tensi6n a partir de la cual se mostrard una alarma de
tension de entrada DC IN insuficiente.
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Elemento Ajuste de subelementos Descripcion

All Reset Reset Restablece todos los ajustes a los valores predeterminados de
Restablece los Execute / Cancel fébrica.

valores Execute: Restablecer

predeterminados

de fébrica

APR APR Ejecuta APR (restauracion automatica de pixeles) para ajustar
Ejecutar APR Execute / Cancel automdticamente el sensor de imagen.

Execute: Ejecutar

Coloque siempre la tapa del objetivo antes de ejecutar APR.

Camera Config HD/2K Modulation

Ajusta el ancho de banda de salida del down-converter para la

Ajustes de salida High / Low conversion a HD y 2K.
del Down
Converter
Version Number Muestra la version del software del camcorder.
Mostrar la version X.XX
Version Up Actualiza el camcorder.*

Execute / Cancel

Execute: Ejecutar
* Actualiza el software del camcorder.

Ext. Unit Version Number
X.XX

Muestra la version del software de XDCA-FS7.

Ext. Unit Version Up
Execute / Cancel

Actualiza XDCA-FS7.*
Execute: Ejecutar
* Actualiza el software de XDCA-FS7.
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Conexidn de dispositivos externos

Conexion de dispositivos de grabacion y monitores

externos

Para mostrar imédgenes de grabacién o
reproduccién en un monitor externo, seleccione la
sefial de salida del camcorder y utilice un cable
adecuado para conectar el monitor.

También puede conectar dispositivos de
grabacioén, como una videograbadora y grabar la
sefial de salida desde el camcorder.

Puede mostrar la misma informacién que aparece
en el visor, como por ejemplo, la informacién de
estado y los menus, en un monitor externo. Ajuste
Output Display (pdgina 84) en el meni Video en
“On” para el tipo de sefial correspondiente que se
enviard al monitor.

Conector SDI OUT (tipo BNC)

Active o desactive la salida y ajuste el formato de
salida a través del menu Video (pdgina 82).
Utilice un cable coaxial de 75 Q disponible en el
mercado para realizar la conexion.

Compruebe que la conexién entre el camcorder y el
dispositivo externo estd conectada a tierra antes de
encender los dispositivos.

(Se recomienda que el camcorder y el dispositivo externo
se enciendan después de conectar el cable coaxial de

75 Q).

Si el dispositivo externo se debe conectar al camcorder
mientras este estd encendido, conecte primero el cable
coaxial de 75 Q al dispositivo externo y, a continuacion,
conéctelo al camcorder.

Para iniciar una grabacion en el camcorder y en
el dispositivo externo simultaneamente

Con la salida de sefial SDI habilitada, ajuste SDI/
HDMI Rec Control (pdgina 91) >Setting en el
menud Recording en “On” para habilitar la salida
de una senal de activacion REC hacia el
dispositivo externo conectado en el conector SDI
OUT. Esto sincronizard la grabacion en el
dispositivo externo con el camcorder.

« Si el dispositivo externo conectado no es compatible
con la sefial de activacién REC, el dispositivo no se
podré utilizar.

¢ Cuando el botén de grabacién START/STOP y la
empufiadura de grabacion START/STOP estdn
establecidos para controlar diferentes soportes, se
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emite la sefial de activacion REC de acuerdo con la
utilizacién de la ranura A.

« Solo se emite la sefial de activaciéon REC cuando no
hay ningtin soporte insertado en ese momento.

Conector HDMI OUT (conector tipo A)

Active o desactive la salida y ajuste el formato de

salida a través del ment Video (pdgina 82).
Utilice un cable HDMI de alta velocidad
disponible en el mercado para realizar la
conexion.

Seleccione el tipo de dispositivo conectado que
utiliza HDMI Target Device (pdgina 122) en el
mend Video.

Conector RAW OUT (tipo BNC)

Acople una unidad de extension XDCA-FS7 al
camcorder para obtener ayuda para que se pueda
conectar un grabador RAW externo, como AXS-
RS, al conector RAW OUT de la XDCA-FS7
(pdgina 35).




Sincronizacion externa

Cuando se filma con varios camcorders, estos se
pueden sincronizar con una sefial de referencia o
un cddigo de tiempo especifico sincronizado a
través del conector Genlock de las unidades
XDCA-FS7 (pdgina 12) acopladas a los
camcorders.

La bateria del camcorder no se puede utilizar cuando la
unidad XDCA-FS7 también estd conectada al
camcorder. Deberd acoplar la bateria a la XDCA-FS7 o
conectar el camcorder a una toma de alimentacion
externa.

Sincronizacion de la fase de las sefiales
de video (generador de sincronismo)

Habilite el generador de sincronismo mediante el
suministro de una sefial de referencia al conector
Genlock (pdgina 12) de las unidades XDCA-FS7
conectadas a los camcorders.

Las sefiales de referencia que se pueden utilizar
varfan segiin la velocidad de fotogramas del
formato de grabacion seleccionado.

Para el area NTSC

Velocidad de
fotogramas del
formato de grabacion

Seiiales de referencia
validas

59.94P 1920 x 1080 59.94i
720 x 486 59.94i
1280 x 720 59.94P
29.97P 1920 x 1080 59.94i
720 x 486 59.94i
24.0P 1920 x 1080 48i (24PsF)
23.98P 1920 x 1080 47.95i
(23.98PsF)
59.94i 1920 x 1080 59.94i

720 x 486 59.94i

Para el area PAL

Velocidad de
fotogramas del
formato de grabacion
50P

Seiiales de referencia
validas

1920 x 1080 50i
720 x 576 501
1280 x 720 50P

105

Velocidad de
fotogramas del
formato de grabacion

Seiiales de referencia
validas

25P 1920 x 1080 50i
720 x 576 50i
50i 1920 x 1080 50i

720 x 576 50i

« Si el formato de grabacién seleccionado es 1280x720
60P, deberd proporcionar una sefial de video y una
sefial de tiempo.

« Si la sefial de referencia es inestable, no se podra
obtener el generador de sincronismo.

* La subportadora no se sincronizara.

Bloqueo del cddigo de tiempo en otros
dispositivos

Ajuste la unidad que proporciona el cédigo de
tiempo en un modo en el que la salida del c6digo
de tiempo siga funcionando (por ejemplo, Free
Run o Clock).

1

Ajuste Timecode en el menti TC/UB de
la siguiente manera.

Mode: Preset

Run: Free Run

Pulse el boton asignable (pdgina 47)
correspondiente a la funcion
DURATION/TC/U-BIT para mostrar
los codigos de tiempo en la pantalla.

Compruebe que el interruptor TC IN/
OUT (pdgina 12) de 1a XDCA-FS7 esta
ajustado en la posicién IN, y
proporcione una sefial de video de
referencia HD o SD y un cédigo de
tiempo sincronizado con la seial de
video a los conectores del generador de
sincronismo y TC IN/OUT
respectivamente.

El generador de cédigos de tiempo del camcorder
se bloqueard con el cédigo de tiempo de
referencia y “EXT-LK” aparecerd en la pantalla.
Después de que hayan transcurrido diez segundos
desde el bloqueo del cédigo de tiempo, el estado
de bloqueo externo se mantendra incluso si se
desconecta la fuente externa de cédigos de
tiempo.



« Compruebe que el cédigo de tiempo de referencia y la
sefial de video de referencia suministrados tienen una
relacion de fase que cumple con el estindar SMPTE de
codigos de tiempo.

Cuando se utiliza el bloqueo externo, el cédigo de
tiempo obtendra el bloqueo con el cédigo de tiempo
externo de forma instantdnea y el valor de este cédigo
de tiempo externo aparecerd en el drea de visualizacion
de datos. Sin embargo, no comience a grabar
inmediatamente. Espere unos segundos antes de
comenzar a grabar hasta que el generador de
sincronizacidn se estabilice.

Si la frecuencia de la sefial del video de referenciay la
frecuencia de fotogramas en el camcorder no son
iguales, no se podrd conseguir un bloqueo y el
camcorder no funcionard correctamente. Si esto
ocurre, el cédigo de tiempo no conseguird un bloqueo
correcto con el cédigo de tiempo externo.

Si la fuente del cédigo de tiempo externo se
desconecta, es posible que el cédigo de tiempo cambie
un fotograma por hora con respecto al cédigo de
tiempo de referencia.

Para liberar el blogueo externo

Cambie el ajuste Timecode en el meni TC/UB o
apague el camcorder.

El bloqueo externo también se liberara si
comienza a grabar en modo Slow & Quick
Motion.

Sincronizacion del cddigo de tiempo de
otro dispositivo con el codigo de tiempo
del camcorder

Ajuste la unidad que proporciona el cédigo de
tiempo en un modo en el que la salida del c6digo
de tiempo siga funcionando (por ejemplo, Free
Run o Clock).

1 Ajuste el cédigo de tiempo del
camcorder mediante Timecode
(pdgina 89) en el meni TC/UB.

Compruebe que el interruptor TC IN/
OUT (pdgina 12) esté ajustado en la
posicion OUT y conecte el conector TC
IN/OUT y el conector del generador de
sincronismo (pdgina 12) a la entrada de
codigo de tiempo y a la entrada de seiial
de referencia respectivamente, en el
dispositivo que desea sincronizar.

106

Gestion/Edicion de clips

con un ordenador

Conexion con un cable USB

Uso de un lector de tarjetas XQD
(opcional)

Conecte un lector de tarjetas XQD MRW-E80
(opcional) mediante un cable USB e introduzca
una tarjeta de memoria en la ranura. La tarjeta de
memoria se reconocerd como una unidad de
extension del ordenador.

Uso del modo de almacenamiento
masivo

Conecte el camcorder mediante un cable USB e
introduzca una tarjeta de memoria en la ranura.

La tarjeta de memoria se reconocera como una

unidad de extensién del ordenador.

1 Sitie el interruptor POWER del
camcorder en la posicién ON.

En la pantalla o en el visor aparecerd un
mensaje que le preguntard si desea habilitar
la conexion USB.

El mensaje de confirmacion de la conexién USB no
se muestra si en esos momentos aparece otro
mensaje de confirmacién o de proceso en curso, por
ejemplo, cuando se formatea o se restaura un tarjeta
de memoria XQD.

El mensaje de confirmacién se mostrard cuando
finalice el formateo o la restauracion. El mensaje de
confirmacién de USB tampoco se muestra mientras
aparece la pantalla de propiedades del clip. El
mensaje se mostrard cuando el procesamiento
finalice o cuando vuelva a la pantalla de imagenes
en miniatura.

Gire el dial SEL/SET y seleccione
Execute.



3 En Windows, compruebe que la tarjeta
se ha afiadido como un disco extraible
en la ventana “Mi Equipo”.

En Macintosh, compruebe que se crea
una carpeta “NO NAME” o “Untitled”
(editable) en el escritorio.

* Norealice las siguientes operaciones si la luz de acceso
se ilumina en rojo.
- Apagar el dispositivo o desconectar el cable de
alimentacién
- Extraer la tarjeta de memoria XQD
- Desconectar el cable USB
* No se garantiza el funcionamiento en todos los
ordenadores.

Uso de sistemas de edicion no lineales

En un sistema de edicién no lineal, es necesario
disponer de software de edicion (opcional) que
sea compatible con los formatos grabados por el
camcorder.

Utilice el software especifico de aplicaciones para
guardar previamente los clips que desee editar en
el disco duro del ordenador.
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Precauciones de uso

El ventilador es un consumible y, como tal, debe
sustituirse periédicamente.

Si utiliza la unidad a temperatura ambiente, el
ciclo de sustitucién normal serd de 5 aflos
aproximadamente.

Sin embargo, esto representa solo una directriz
general y no constituye ninguna garantia de su
vida util. Para obtener mds informacién acerca de
la sustitucién de componentes, pongase en
contacto con el distribuidor.

Si la unidad se lleva de repente de un lugar frio a
uno célido o si la temperatura ambiente sufre un
aumento repentino, es posible que se acumule
humedad en la superficie exterior o interior de la
unidad. Este fendmeno se conoce como
condensacion. Si se produce condensacion,
apague la unidad y espere a que se evapore antes
de ponerla en marcha. No la utilice en ese estado,
ya que podria dafiarla.

El panel LCD de esta unidad ha sido fabricado
con tecnologia de alta precision y ofrece un indice
de pixeles funcionales de al menos el 99,99%. Por
ello, es posible que quede una pequefia
proporcidn de pixeles “atascados”, o bien siempre
apagados (negro), siempre encendidos (rojo,
verde o azul), o parpadeando. Ademds, a lo largo
de un amplio periodo de tiempo, esos pixeles
“atascados” pueden ir apareciendo
espontdneamente debido a las caracteristicas de la
pantalla de cristal liquido. Esto no significa que la
unidad funcione mal. Tenga en cuenta que dichos
problemas no producen efectos en los datos
grabados.

La terminal de la bateria de esta unidad (el
conector para paquetes de pilas y adaptadores de
CA) es una parte consumible.

Puede que la unidad no funcione correctamente si
los contactos de las pilas estdan doblados o
deformados debido a algtin golpe o a vibraciones
o si se han corroido debido a un uso prolongado
en el exterior.

Se recomienda realizar inspecciones periddicas
para que la unidad contintie funcionando
correctamente y para prolongar su vida util.
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Acerca de la bateria recargable incorporada
Contacte con el servicio de asistencia técnica de
Sony o con el responsable de ventas para obtener
mas informacién sobre las inspecciones.

El camcorder dispone de una bateria recargable
incorporada que almacena la fecha, 1a hora y otros
ajustes incluso cuando estd apagado. La bateria
recargable tardard aproximadamente 3 meses en
descargarse por completo si no se conecta el
adaptador de CA o si se utiliza el camcorder sin la
bateria. Cargue la bateria antes de utilizar el
camcorder.

No obstante, aunque la baterfa recargable
incorporada no esté cargada, el funcionamiento
del camcorder no se verd afectado, a menos que
esté grabando la fecha y la hora.



Limitaciones y formatos de salida

Formatos de video y seifiales de salida

Los ajustes predeterminados de fbrica se muestran en negrita (por ejemplo, 2048x1080P (Level A)).

» Laresolucién del formato de grabacién estd limitada por el ajuste de Base Setting >Imager Scan Mode en el menu
System (pdgina 96).
« Silaresolucidn de la salida de video es mayor que la resolucién de la imagen, no se emite ninguna imagen reproducida.

Formatos de salida del conector SDI OUT

Cuando Country >NTSC/PAL Area en el menii System estéa ajustado en NTSC Area

Cuando se utilice una configuracion basica (XAVC-I1/ XAVC-L / MPEG HD)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
4096 x 2160 59.94P - 4096 x 2160P Sin salida

- 3840 x 2160P Sin salida
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A

(Level A)
1920 x 1080P - 1920 x 1080 59.94P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
4096 x 2160 29.97P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF
4096 x 2160 24.00P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x - 1920 x 1080 24PsF
1080PsF
- 1920 x 1080P Sin salida
4096 x 2160 23.98P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x - 1920 x 1080 23.98PsF
1080PsF

- 1920 x 1080P Sin salida
3840 x 2160 59.94P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida

1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)

1920 x 1080P - 1920 x 1080 59.94P Level-B
(Level B)

1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
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Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
3840 x 2160 29.97P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF
3840 x 2160 23.98P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x - 1920 x 1080 23.98PsF
1080PsF
- 1920 x 1080P Sin salida
1920 x 1080 59.94P 2048 x 1080P - 2048 x 1080 59.94P Level-A
(Level A)
2048 x 1080P - 2048 x 1080 59.94P Level-B
(Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)
1920 x 1080P - 1920 x 1080 59.94P Level-B
(Level B)
1920 x 10801 1920 x 1080i 1920 x 1080 59.94i
- 720 x 4801 Sin salida
- 720 x 480P Sin salida
1920 x 1080 59.94i 1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
- 720 x 4801 Sin salida
- 720 x 480P Sin salida
1920 x 1080 29.97P 2048 x 1080PsF |— 2048 x 1080 29.97PsF
1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF
- 720 x 4801 Sin salida
1920 x 1080 23.98P 2048 x 1080PsF |— 2048 x 1080 23.98PsF
1920 x - 1920 x 1080 23.98PsF
1080PsF
- 1920 x 1080P Sin salida

1920 x 1080i (2-
3PD)

1920 x 1080i (2-
3PD)

1920 x 1080 59.94i (2-3PD)

- 720 x 4801 (2- Sin salida
3PD)
1280 x 720 59.94P 1280 x 720P 1280 x 720P 1280 x 720 59.94P
- 720 x 4801 Sin salida
- 720 x 480P Sin salida
1280 x 720 29.97P 1280 x 720P 1280 x 720P 1280 x 720 59.94P (2-2RP)
- 720 x 4801 Sin salida
1280 x 720 23.98P 1280 x 720P (2-| 1280 x 720P (2-| 1280 x 720 59.94P (2-3PD)
3PD) 3PD)
- 720 x 4801 (2- Sin salida
3PD)
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Cuando se utiliza una unidad de extension (RAW)

Ajustes de formato de grabaciéon

Ajustes de salida SDI/HDMI

Seial de salida SDI

(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x 1080P | 2048 x 1080 59.94P Level-A
4096 x 2160 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 59.94P Level-B
1920 x 1080 59.94P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 59.94P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
RAW Output Format 2048 x 1080P | 2048 x 1080 59.94P Level-A
4096 x 2160 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 59.94P Level-B
1280 x 720 59.94P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 59.94P Level-B
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 59.94P
RAW Output Format 2048 x 1080P |- 2048 x 1080 59.94P Level-A
2048 x 1080 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 59.94P Level-B
1920 x 1080 59.94P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 59.94P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
RAW Output Format 2048 x 1080P |- 2048 x 1080 59.94P Level-A
2048 x 1080 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 59.94P Level-B
1280 x 720 59.94P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 59.94P Level-B
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 59.94P
RAW Output Format 2048 x - 2048 x 1080 29.97PsF
4096 x 2160 29.97P 1080PsF
Video Format (valor fijo) 1920 x 1080PSE | 1920 x 1080i 1920 x 1080 29.97PsF
1920 x 1080 29.97P
RAW Output Format 2048 x - 2048 x 1080 29.97PsF
2048 x 1080 29.97P 1080PsF
Video Format (valor fijo) 1920 x 1080PsF | 1920 x 1080i 1920 x 1080 29.97PsF
1920 x 1080 29.97P
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Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x - 2048 x 1080 23.98PsF
4096 x 2160 23.98P 1080PsF

Video Format (valor fijo)
1920 x 1080 23.98P

1920 x 1080PsF

1920 x 1080 23.98PsF

1920 x 1080P

Sin salida

RAW Output Format
2048 x 1080 23.98P

Video Format (valor fijo)
1920 x 1080 23.98P

2048 x
1080PsF

2048 x 1080 23.98PsF

1920 x 1080PsF

1920 x 1080 23.98PsF

1920 x 1080P

Sin salida

Cuando se utiliza una unidad de extension (ProRes 422)
Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)

SDI HDMI
1920 x 1080 59.94i 1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
1920 x 1080 29.97P 1920 x 1920 x 1080i SDIOUT 1

1080PsF 1920 x 1080 29.97P

SDIOUT 2

1920 x 1080 29.97PsF

1920 x 1080 23.98P

1920 x 1080P

1920 x 1080P

1920 x 1080 23.98P *!

*1 No puede emitir una sefial compatible con el CBK-WA100.

Cuando Country >NTSC/PAL Area en el menii System esté ajustado en PAL Area

Cuando se utilice una configuracion basica (XAVC-I1/ XAVC-L / MPEG HD)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
4096 x 2160 50P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida

1920 x 1080P

1920 x 1080P

1920 x 1080 50P Level-A

(Level A)
1920 x 1080P - 1920 x 1080 50P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 50i
4096 x 2160 25P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x 1920 x 1080i 1920 x 1080 25PsF
1080PsF
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Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
3840 x 2160 50P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida
1920 x 1080P |1920 x 1080P | 1920 x 1080 50P Level-A
(Level A)
1920 x 1080P - 1920 x 1080 50P Level-B
(Level B)
1920 x 10801 1920 x 10801 1920 x 1080 50i
3840 x 2160 25P - 4096 x 2160P Sin salida
- 3840 x 2160P Sin salida

1920 x 1920 x 1080i 1920 x 1080 25PsF
1080PsF

1920 x 1080 50P 2048 x 1080P - 2048 x 1080 50P Level-A
(Level A)
2048 x 1080P - 2048 x 1080 50P Level-B
(Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 S0P Level-A
(Level A)
1920 x 1080P - 1920 x 1080 50P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 50i
- 720 x 576i Sin salida
- 720 x 576P Sin salida

1920 x 1080 50i 1920 x 1080i 1920 x 1080i 1920 x 1080 501
- 720 x 5761 Sin salida
- 720 x 576P Sin salida

1920 x 1080 25P 2048 x 1080PsF |- 2048 x 1080 25PsF
1920 x 1920 x 1080i 1920 x 1080 25PsF
1080PsF
- 720 x 576i Sin salida

1280 x 720 50P 1280 x 720P 1280 x 720P 1280 x 720 50P
- 720 x 576i Sin salida
- 720 x 576P Sin salida

1280 x 720 25P 1280 x 720P 1280 x 720P 1280 x 720 50P (2-2RP)
- 720 x 5761 Sin salida
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Cuando se utiliza una unidad de extension (RAW)

Ajustes de formato de grabaciéon

Ajustes de salida SDI/HDMI

Seial de salida SDI

(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x 1080P |- 2048 x 1080 50P Level-A
4096 x 2160 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 50P Level-B
1920 x 1080 50P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 S0P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 50i
RAW Output Format 2048 x 1080P |- 2048 x 1080 50P Level-A
4096 x 2160 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 50P Level-B
1280 x 720 50P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 S0P Level-B
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 50P
RAW Output Format 2048 x 1080P |- 2048 x 1080 S0P Level-A
2048 x 1080 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 50P Level-B
1920 x 1080 50P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 50P Level-B
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 50i
RAW Output Format 2048 x 1080P |- 2048 x 1080 50P Level-A
2048 x 1080 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- 2048 x 1080 50P Level-B
1280 x 720 50P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P Level-A
(Level A)
1920 x 1080P |- 1920 x 1080 50P Level-B
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 50P
RAW Output Format 2048 x - 2048 x 1080 25PsF
4096 x 2160 25P 1080PsF
Video Format (valor fijo) 1920 x 1080PSE | 1920 x 1080i 1920 x 1080 25PsF
1920 x 1080 25P
RAW Output Format 2048 x - 2048 x 1080 25PsF
2048 x 1080 25P 1080PsF
Video Format (valor fijo) 1920 x 1080PsF | 1920 x 1080i 1920 x 1080 25PsF
1920 x 1080 25P
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Cuando se utiliza una unidad de extension (ProRes 422)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI | Seial de salida SDI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)

SDI HDMI
1920 x 1080 50i 1920 x 1080i 1920 x 1080i 1920 x 1080 50i
1920 x 1080 25P 1920 x 1920 x SDIOUT 1

1080PsF 1080PsF 1920 x 1080 25P

SDIOUT 2
1920 x 1080 25PsF
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Formatos de salida del conector HDMI OUT

Cuando Country >NTSC/PAL Area en el menii System estéa ajustado en NTSC Area
Cuando se utilice una configuracion basica (XAVC-1/XAVC-L / MPEG HD)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
4096 x 2160 59.94P - 4096 x 2160P 4096 x 2160 59.94P

- 3840 x 2160P 3840 x 2160 59.94P

1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P

(Level A)

1920 x 1080P - Sin salida

(Level B)

1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
4096 x 2160 29.97P - 4096 x 2160P 4096 x 2160 29.97P

- 3840 x 2160P 3840 x 2160 29.97P

1920 x 1920 x 1080i | 1920 x 1080 29.97PsF

1080PsF
4096 x 2160 24.00P - 4096 x 2160P 4096 x 2160 24P

- 3840 x 2160P 3840 x 2160 24P

1920 x - Sin salida

1080PsF

- 1920 x 1080P 1920 x 1080 24P (Puro)
4096 x 2160 23.98P - 4096 x 2160P 4096 x 2160 23.98P

- 3840 x 2160P 3840 x 2160 23.98P

1920 x - Sin salida

1080PsF

- 1920 x 1080P 1920x1080 23.98P (Puro)

3840 x 2160 59.94P - 4096 x 2160P 4096 x 2160 59.94P

- 3840 x 2160P 3840 x 2160 59.94P

1920 x 1080P | 1920 x 1080P | 1920 x 1080 59.94P

(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
3840 x 2160 29.97P - 4096 x 2160P 4096 x 2160 29.97P
- 3840 x 2160P 3840 x 2160 29.97P
1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF
3840 x 2160 23.98P - 4096 x 2160P 4096 x 2160 23.98P
- 3840 x 2160P 3840 x 2160 23.98P
1920 x - Sin salida
1080PsF

- 1920 x 1080P 1920x1080 23.98P (Puro)
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Ajustes de formato de grabaciéon
(Rec Format >Video Format en el
menu System)

Ajustes de salida SDI/HDMI
(Output Format >SDI y
HDMI en el meni Video)

SDI

HDMI

Seiial de salida de HDMI

1920 x 1080 59.94P

2048 x 1080P
(Level A)

Sin salida

2048 x 1080P
(Level B)

Sin salida

1920 x 1080P
(Level A)

1920 x 1080P

1920 x 1080 59.94P

1920 x 1080P
(Level B)

Sin salida

1920 x 1080i

1920 x 10801

1920 x 1080 59.94i

- 720 x 4801 720 x 480 59.94i
- 720 x 480P 720 x 480 59.94P
1920 x 1080 59.94i 1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i
- 720 x 4801 720 x 480 59.94i
- 720 x 480P 720 x 480 59.94P
1920 x 1080 29.97P 2048 x 1080PsF |- Sin salida
1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF
- 720 x 4801 720 x 480 59.94i (PsF)
1920 x 1080 23.98P 2048 x 1080PsF |- Sin salida
1920 x - Sin salida
1080PsF
— 1920 x 1080P 1920x1080 23.98P (Puro)
1920 x 10801 (2- | 1920 x 1080i (2- | 1920 x 1080 59.94i (2-3PD)
3PD) 3PD)
- 720 x 4801 (2- 720 x 480 59.94i (2-3PD)
3PD)
1280 x 720 59.94P 1280 x 720P 1280 x 720P 1280 x 720 59.94P
- 720 x 4801 720 x 480 59.94i
- 720 x 480P 720 x 480 59.94P
1280 x 720 29.97P 1280 x 720P 1280 x 720P 1280 x 720 59.94P (2-2RP)
- 720 x 4801 720 x 480 59.94i (PsF)
1280 x 720 23.98P 1280x720P (2- | 1280x720P (2- | 1280 x 720 59.94P (2-3PD)
3PD) 3PD)

720 x 430 (2-
3PD)

720 x 480 59.94i
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Cuando se utiliza una unidad de extension (RAW)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x 1080P |- Sin salida
4096 x 2160 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1920 x 1080 59.94P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 59.94P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 10801 1920 x 1080i 1920 x 1080 59.94i
RAW Output Format 2048 x 1080P |- Sin salida
4096 x 2160 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1280 x 720 59.94P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 59.94P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 59.94P
RAW Output Format 2048 x 1080P |- Sin salida
2048 x 1080 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1920 x 1080 59.94P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 59.94P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 10801 1920 x 1080i 1920 x 1080 59.94i
RAW Output Format 2048 x 1080P |- Sin salida
2048 x 1080 59.94P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1280 x 720 59.94P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 59.94P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 59.94P
RAW Output Format 2048 x - Sin salida
4096 x 2160 29.97P 1080PsF

Video Format (valor fijo)
1920 x 1080 29.97P

1920 x 1080PsF |1920 x 1080i

1920 x 1080 29.97PsF

RAW Output Format
2048 x 1080 29.97P

Video Format (valor fijo)
1920 x 1080 29.97P

2048 x -
1080PsF

Sin salida

1920 x 1080PsF | 1920 x 1080i

1920 x 1080 29.97PsF

118



Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x - Sin salida
4096 x 2160 23.98P 1080PsF
Video Format (valor fijo) 1920 x 1080PsF |- Sin salida

1920 x 1080 23.98P

1920 x 1080P

1920x1080 23.98P (Puro)

RAW Output Format
2048 x 1080 23.98P

Video Format (valor fijo)
1920 x 1080 23.98P

2048 x
1080PsF

Sin salida

1920 x 1080PsF

Sin salida

1920 x 1080P

1920x1080 23.98P (Puro)

Cuando se utiliza una unidad de extens

ion (ProRes 422)

Ajustes de formato de grabacion Ajustes de salida SDI/HDMI |Sefial de salida de HDMI

(Rec Format >Video Format en el (Output Format >SDI y

menu System) HDMI en el meni Video)
SDI HDMI

1920 x 1080 59.94i 1920 x 1080i 1920 x 1080i 1920 x 1080 59.94i

1920 x 1080 29.97P 1920 x 1920 x 1080i 1920 x 1080 29.97PsF
1080PsF

1920 x 1080 23.98P 1920 x 1080P |1920 x 1080P | 1920x1080 23.98P (Puro)

Cuando Country >NTSC/PAL Area en el menii System esté ajustado en PAL Area

Cuando se utilice una configuracion basica (XAVC-I1/ XAVC-L / MPEG HD)

Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
4096 x 2160 50P - 4096 x 2160P 4096 x 2160 50P

3840 x 2160P

3840 x 2160 50P

1920 x 1080P

1920 x 1080P

1920 x 1080 50P

(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 1080i 1920 x 1080i 1920 x 1080 50i
4096 x 2160 25P - 4096 x 2160P 4096 x 2160 25P
- 3840 x 2160P 3840 x 2160 25P
1920 x 1920 x 1080i 1920 x 1080 25PsF
1080PsF
3840 x 2160 50P - 4096 x 2160P 4096 x 2160 50P
- 3840 x 2160P 3840 x 2160 50P
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)

1920 x 1080i

1920 x 1080i

1920 x 1080 50i
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Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
3840 x 2160 25P - 4096 x 2160P 4096 x 2160 25P
- 3840 x 2160P 3840 x 2160 25P
1920 x 1920 x 1080i 1920 x 1080 25PsF
1080PsF
1920 x 1080 50P 2048 x 1080P - Sin salida
(Level A)
2048 x 1080P - Sin salida
(Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 10801 1920 x 1080i 1920 x 1080 501
- 720 x 5761 720 x 576 501
- 720 x 576P 720 x 576 50P
1920 x 1080 50i 1920 x 1080i 1920 x 1080i 1920 x 1080 50i
- 720 x 5761 720 x 576 501
- 720 x 576P 720 x 576 50P
1920 x 1080 25P 2048 x 1080PsF |- Sin salida

1920 x 1920 x 1080i 1920 x 1080 50i (PsF)
1080PsF
- 720 x 5761 720 x 576 50i (PsF)

1280 x 720 50P 1280 x 720P 1280 x 720P 1280 x 720 50P
- 720 x 5761 720 x 576 501
- 720 x 576P 720 x 576 50P

1280 x 720 25P 1280 x 720P 1280 x 720P 1280 x 720 50P (2-2RP)
- 720 x 5761 720 x 576 50i (PsF)

Cuando se utiliza una unidad de extension (RAW)

Ajustes de formato de grabacién Ajustes de salida SDI/HDMI |Sefial de salida de HDMI

(Rec Format >RAW Output Format y | (Output Format >SDI y

Video Format en el meni System) HDMI en el meni Video)
SDI HDMI

RAW Output Format 2048 x 1080P |- Sin salida

4096 x 2160 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1920 x 1080 50P (Level B)

1920 x 1080P 1920 x 1080P 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)

1920 x 1080i

1920 x 10801

1920 x 1080 50i
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Ajustes de formato de grabaciéon Ajustes de salida SDI/HDMI |Seiial de salida de HDMI
(Rec Format >RAW Output Format y | (Output Format >SDI y
Video Format en el menu System) HDMI en el meni Video)
SDI HDMI
RAW Output Format 2048 x 1080P |- Sin salida
4096 x 2160 50P (Level A)
Video Format (valor fijo) 2048 x 1080P - Sin salida
1280 x 720 50P (Level B)
1920 x 1080P | 1920 x 1080P | 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 50P
RAW Output Format 2048 x 1080P |- Sin salida
2048 x 1080 50P (Level A)
Video Format (valor fijo) 2048 x 1080P |- Sin salida
1920 x 1080 50P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1920 x 10801 1920 x 1080i 1920 x 1080 501
RAW Output Format 2048 x 1080P |- Sin salida
2048 x 1080 50P (Level A)
Video Format (valor fijo) 2048 x 10380P |- Sin salida
1280 x 720 50P (Level B)
1920 x 1080P 1920 x 1080P 1920 x 1080 50P
(Level A)
1920 x 1080P - Sin salida
(Level B)
1280 x 720P 1280 x 720P 1280 x 720 50P
RAW Output Format 2048 x - Sin salida
4096 x 2160 25P 1080PsF
Video Format (valor fijo) 1920 x 1080PSF | 1920 x 1080i 1920 x 1080 25PsF
1920 x 1080 25P
RAW Output Format 2048 x - Sin salida
2048 x 1080 25P 1080PsF
Video Format (valor fijo) 1920 x 1080PsF | 1920 x 1080i 1920 x 1080 25PsF
1920 x 1080 25P
Cuando se utiliza una unidad de extension (ProRes 422)
Ajustes de formato de grabacién Ajustes de salida SDI/HDMI |Sefial de salida de HDMI
(Rec Format >Video Format en el (Output Format >SDI y
menu System) HDMI en el meni Video)
SDI HDMI
1920 x 1080 501 1920 x 1080i 1920 x 1080i 1920 x 1080 501
1920 x 1080 25P 1920 x 1920 x 1080i 1920 x 1080 50i (PsF)
1080PsF
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Ajustes de salida HDMI para dispositivos HDMI

Output Setting >SHDMI Target |Output Display >SDI/HDMI en |Salida de HDMI
Device en el meni Video el meni Video OSD On/Off |MLUT On/Off
Recorder (predeterminado) SDI=On, HDMI=On (predeterminado) |— Sigue SDII
* En gris, no se puede seleccionar.
SDI=On, HDMI=Off Off
SDI=0ff, HDMI=Off Off
Monitor SDI=On, HDMI=On (predeterminado) | On Sigue SDI2

SDI=On, HDMI=Off
* En gris, no se puede seleccionar.

SDI=0ff, HDMI=Off

Off

« Si el ajuste Output Display no se puede seleccionar después de cambiar HDMI Target Device, dicho ajuste cambiara

de la siguiente forma.

- Cambiard de manera forzosa al valor predeterminado.
- Sila seleccion del valor predeterminado no estd disponible, cambiard de manera forzosa a “SDI=On, HDMI=On".
« HDMI Target Device no se puede establecer en Recorder si Codec estd establecido en ProRes.

Define cuando no se puede configurar Monitor LUT de manera independiente

En los siguientes casos, Monitor LUT >SDI2, HDMI y Viewfinder en el menid Video no se pueden ajustar
de forma individual. Estdn sincronizados con el ajuste SDI1 & Internal Rec.
- Cuando Output Format >HDMI en el menu Video estd ajustado en 4096x2160 o 3840x2160
- Cuando S&Q Motion >Setting en el ment Recording estd On
- Si Lens >Distortion Comp. en el ment System estd ajustado en Auto
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Advertencias de funcionamiento

Si en el camcorder se produce una condicién de funcionamiento, precaucion o advertencia que requiera
confirmacion, en el visor aparecerd un mensaje, los indicadores de grabacién comenzardn a parpadear y
sonard un pitido de advertencia.

El pitido de advertencia se emite desde el altavoz incorporado y los auriculares conectados a la toma de
auriculares.

Mensajes de error

El camcorder dejard de funcionar cuando se visualicen los siguientes mensajes.

Mensaje del visor Sonidode Indicadorde Causa y solucion
advertencia grabacién
E + error code Continuo Parpadeo Indica una anomalia en el camcorder. La grabacion se detiene,
rdpido incluso si @REC se muestra en el visor.

Apague el camcorder y compruebe si existe algtin problema
con los dispositivos, cables o soportes conectados. Si el error
continda cuando el camcorder se vuelve a encender, péngase
en contacto con el servicio de asistencia técnica de Sony.
(Si el camcorder no se apaga cuando el interruptor POWER se
ajusta en OFF, extraiga la bateria o desconecte la alimentacién
DCIN).

Mensajes de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Mensaje del visor Sonido de Indicadorde Causa y solucion
advertencia grabacion

Media Near Full Intermitente Parpadeo La capacidad restante de la tarjeta de memoria XQD se estd
agotando.
Sustitdyala en cuanto pueda.
Media Full Continuo Parpadeo Los clips no se pueden grabar, copiar ni dividir porque no
rdpido queda capacidad en la tarjeta de memoria XQD.
Sustitdyala inmediatamente.
Battery Near End Intermitente Parpadeo La capacidad restante de la bateria se estd agotando.
Recdrguela en cuanto pueda.
Battery End Continuo Parpadeo La baterfa estd agotada. La grabacion se detiene.
rdpido Detenga el funcionamiento y sustituya la bateria.
Temperature High Intermitente Parpadeo La temperatura interna es elevada.
Apague el camcorder y deje que se enfrie antes de volverlo a
utilizar.
Voltage Low Intermitente Parpadeo La tensién de DC IN es baja (nivel 1). Compruebe la fuente de
alimentacién.
Insufficient Voltage Continuo Parpadeo La tensién de DC IN es demasiado baja (nivel 2). La
rdpido grabacion se detiene.

Conecte a una fuente de alimentacion distinta.
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Mensajes de precaucion y de funcionamiento

Es posible que los siguientes mensajes de precaucion y funcionamiento aparezcan en el centro de la
pantalla. Siga las instrucciones proporcionadas para resolver el problema.

Mensaje del visor

Causa y solucion

Battery Error

Se ha detectado un error en la bateria.

Please Change Battery. Sustitdyala por una baterfa normal.

Backup Battery End La capacidad restante de la bateria de reserva es insuficiente.

Please Change. Cargue la bateria de reserva.

Unknown Media(A)D Se ha introducido una tarjeta de memoria particionada o una tarjeta de
Please Change. memoria que contiene mds clips de los que puede manipular el

camcorder.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Cannot Use Media(A)!)
Unsupported File System

Se ha introducido una tarjeta que utiliza un sistema de archivos diferente
o que no se ha formateado.

La tarjeta no se puede utilizar en el camcorder y se debe sustituir o
formatear con el camcorder.

Media Error
Media(A)!) Needs to be Restored

Se ha producido un error en la tarjeta de memoria y se debe restaurar.
Restaure la tarjeta de memoria.

Media Error
Cannot Record to Media(A)!)

Es posible que la tarjeta de memoria esté dafiada y ya no se puede
utilizar para la grabacion.

La reproduccién es posible, por tanto, se recomienda copiar y sustituir la
tarjeta de memoria.

Media Error
Cannot Use Media(A)!)

Es posible que la tarjeta de memoria esté dafiada y ya no se puede
utilizar para la grabacién ni la reproduccién.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Media(A)!) Error
Recording Halted
Playback Halted

La grabacién y la reproduccion se han detenido a causa de un error que
se ha producido mientras se utilizaba la tarjeta de memoria.
Si el problema continda, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media(A)D

La tarjeta de memoria ha llegado al final de su vida qtil.

Realice una copia de seguridad y sustituya la tarjeta inmediatamente Si
continda utilizando la tarjeta, es posible que no pueda grabar o
reproducir.

Para obtener mds informacion, consulte las instrucciones de
funcionamiento de la tarjeta de memoria.

Fan Stopped

El ventilador incorporado se ha detenido.

Evite utilizar el camcorder con temperaturas elevadas, desconecte la
alimentacién y péngase en contacto con el servicio de asistencia técnica
de Sony.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

El ajuste de formato para darle nombre al clip se ha restablecido porque
se ha cargado un archivo ALL no vilido.

Configure los ajustes de formato deseados e intente guardar el archivo
ALL de nuevo.

1) Se muestra “Media (B)” para la tarjeta de la ranura B.
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Elementos guardados en Files

Si: el elemento se guarda.
No: el elemento no se guarda.

LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Camera ISO/Gain/EI Mode Si Si
1SO/Gain<H> Si Si

1SO/Gain<M> Si Si

1SO/Gain<L> Si Si

Exposure Index<H> Si Si

Exposure Index<M> Si Si

Exposure Index<L> Si Si

Shockless Gain Nit St

Auto Exposure Level Si Si
Mode Si Nit

Speed Si Nit

AGC Si Si

AGC Limit Si Si

Auto Shutter Nit Nit

A.SHT Limit Si Si

Clip High Light Si Si

Detect Window Nit Nit

Detect Window Indication Si Si

Focus Focus Area Si No
Focus Area (Push AF) Si No

AF Assist Si No

Shutter Mode Si Si
Shutter Speed Nit Nit

Shutter Angle Si Si

ECS Frequency Si Si

Color Bars Setting No No
Type Si No

Noise Suppression Setting Si Si
Level Si Nit

Flicker Reduce Mode Si No
Frequency Si No

SteadyShot Setting Nit No
Handle Zoom Zoom Speed Type Si No
Zoom Speed Si No

Auto Black Balance Auto Black Balance - -
AF Micro Adjustment Setting No No
Amount No No

Clear All - -

Video Light Set Video Light Set Nit No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Paint White Preset White Si St
Color Temp <A> Si Si

Color Temp Balance <A> St St

R Gain <A> Si Si

B Gain <A> Si Si

Color Temp <B> Si Nit

Color Temp Balance <B> Si Nit

R Gain <B> Si Si

B Gain <B> Si Si

Filter White Memory Si No

Shockless White Si Si

White Switch<B> Si No

ATW Speed Si Si

Offset White Offset White <A> Si Si
Warm Cool <A> Si Si

‘Warm Cool Balance <A> Si St

Offset White <B> Si Si

Warm Cool <B> Si Si

Warm Cool Balance <B> Si St

Offset White<ATW> Si Si

Warm Cool<ATW> Si Si

Warm Cool Balance<ATW> Si St

Black Setting Si Si
Master Black Si Si

R Black Si Si

B Black Si Si

Gamma Setting Si Si
Step Gamma Nit Nit

Master Gamma Si Si

R Gamma Si Si

G Gamma Nit Nit

B Gamma Si Si

Gamma Category Si Si

Gamma Select Nit Nit

Black Gamma Setting Si Nit
Range - -

Master Black Gamma Nit Nit

Knee Setting Si Si
Auto Knee Si Si

Point Si St

Slope Si Si

Knee Saturation Si Nit

Knee Saturation Level Nit Nit

White Clip Setting Si Si
Level Si Si
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Detail Setting Nit Nit
Level Si Si
H/V Ratio Si St
Crispening Nit Nit
Level Depend Si Si
Level Depend Level Si Si
Frequency Si Si
Knee Aperture Si Si
Knee Aperture Level Si Si
Limit Si Si
White Limit Si Nit
Black Limit Si Si
V Black Limit Si Si
V Detail Creation Si Si
Skin Detail Setting Si Si
Area Detection - -
Area Indication No No
Level Si Si
Saturation Nit St
Hue Si Si
Width Si Si
Aperture Setting Si Si
Level Si Si
Matrix Setting Si Si
Adaptive Matrix Nit Nit
Preset Matrix Si Si
Preset Select Si Nit
User Matrix Si St
Level Si Si
Phase Si Si
User Matrix R-G Si St
User Matrix R-B Si Si
User Matrix G-R Si Si
User Matrix G-B Si St
User Matrix B-R Si St
User Matrix B-G Si Si
Multi Matrix Setting Si Si
Area Indication No No
Color Detection - -
Axis No No
Hue Si Si
Saturation Si Si
Maintenance Test Saw Nit No

127



LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Audio Audio Input CHI1 Input Select Si No
CH2 Input Select Si No

CH3 Input Select Si No

CH4 Input Select Si No

INPUT1 MIC Reference Si No

INPUT2 MIC Reference Nit No

CH1 Wind Filter Si No

CH2 Wind Filter Si No

CH3 Wind Filter Si No

CH4 Wind Filter Si No

CH3 Level Control Si No

CH4 Level Control Nit No

CH3 Input Level Si No

CH4 Input Level Si No

Audio Input Level Si No

Limiter Mode Si No

CH1&2 AGC Mode Si No

CH3&4 AGC Mode Si No

AGC Spec Si No

1kHz Tone on Color Bars Si No

CHI1 Level Si No

CH2 Level Si No

CH3 Level Si No

CH4 Level Si No

Audio Output Monitor CH St No
Monitor Volume Si No

Headphone Out Si No

Alarm Volume Si No

Output Limiter Si No

HDMI Output CH Si No

Video Output On/Off SDI Si No
HDMI Si No

Output Format SDI Si No
HDMI Si No

REF No No

Output Setting HDMI Target Device Si No
4K/2K to HD Conv. Si No

Monitor LUT Category Si No
LUT Select Si No

Look Profile Select Si No

User 3D LUT Select Si No

SDI1 & Internal Rec Si No

SDI2 Si No

HDMI Si No

Visor Si No

Output Display SDI2 Nit No
HDMI Si No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

VF VF Setting Brightness Si No
Color Mode Si No

Peaking Setting Si No
Peaking Type Si No

Frequency Si No

Normal Peaking Level Si No

Color Nit No

Color Peaking Level Si No

Zebra Setting Nit No
Zebra Select Nit No

Zebral Level Si No

Zebral Aperture Level Si No

Zebra2 Level Nit No

Marker Setting Si No
Color Si No

Center Marker Nit No

Safety Zone Si No

Safety Area Si No

Aspect Marker Nit No

Aspect Mask Si No

Aspect Safety Zone Si No

Aspect Safety Area Nit No

Aspect Select Si No

User Box Si No

User Box Width Nit No

User Box Height Si No

User Box H Position Si No

User Box V Position Nit No

100% Marker Si No

Guide Frame Si No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Display On/Off Setting Si No
Shutter Setting Si No
ND Filter Position Si No
Gain Setting Nit No
Rec/Play Status Si No
HXR-IFRS Rec Control Si No
Color Temp. Nit No
Frame Rate / Interval Si No
Battery Remain St No
Timecode Nit No
Audio Manual Si No
Audio Level Meter Nit No
Media Status Nit No
Focus Position Si No
Iris Position Si No
Zoom Position Nit No
SteadyShot Si No
Focus Mode Si No
Focus Area Indicator St No
Focus Area Ind. (Push AF) Si No
Focus Indicator Si No
Auto Shutter Nit No
AGC Si No
Auto Iris Si No
AE Mode Si No
Auto Exposure Level Si No
White Balance Mode Si No
SDI/HDMI Rec Control St No
Rec Format Si No
Gamma Si No
Timecode Lock Nit No
Wi-Fi Condition Si No
Clip Name Si No
Focus Assist Indicator Nit No
Focus Area Marker Si No
Video Level Warning Si No
Clip Number Si No
GPS Si No
Level Gauge Si No
Lens Info Si No
Notice Message Si No

Video Signal Monitor Setting Si No
Source Nit No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File
TC/UB Timecode Mode Nit No
Run Si No
Setting No No
Reset - -
TC Format Si No
TC Display Display Select Si No
Users Bit Mode Nit No
Setting No No
HDMI TC Out Setting Si No
Recording S&Q Motion Setting Si No
High Frame Rate Mode Si No
Frame Rate Nit No
Interval Rec Setting No No
Interval Time Si No
Number of Frames Si No
Pre-Lighting Si No
Picture Cache Rec Setting Si No
Cache Rec Time Si No
Simul Rec Setting Si No
Rec Button Set Si No
SDI/HDMI Rec Control Setting Si No
Thumbnail Display Clip Properties - -
Set Index Picture - -
Thumbnail View Essence Mark Thumbnail - -
Clip Thumbnail - -
Set Shot Mark Add Shot Mark1 - -
Delete Shot Mark1 - -
Add Shot Mark2 - —
Delete Shot Mark2 - -
Set Clip Flag Add OK - -
Add NG - -
Add KEEP - -
Delete Clip Flag - -
Lock/Unlock Clip Select Clip - -
Lock All Clips - -
Unlock All Clips - -
Delete Clip Select Clip - -
All Clips - -
Filter Clips OK - -
NG - -
KEEP - -
None - -
Customize View Thumbnail Caption Si Si
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

Media Update Media Media(A) — -

Media(B) - _

Format Media Media(A) - _

Media(B) _ _

SD Card - -

Clip Auto Naming S

Camera ID

%]

Reel Number Si No

Camera Position

AR
Z
o

Title Prefix S

Number Set No No

File All File Load SD Card - -

Save SD Card - -

File ID Si No

Scene File Recall Internal Memory - -

Store Internal Memory - —

Load SD Card - -

Save SD Card - -

File ID No Si

Scene White Data Si No

User Menu Item Load SD Card - -

Save SD Card - -

File ID No No

User Gamma Current Settings - -

Load SD Card - -

Reset - -

Monitor LUT Current Settings - -

Load SD Card - -

Reset - -

Monitor 3D LUT Current Settings - -

Load SD Card - -

Reset - -

Lens File White Offset R No No

White Offset B No No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File

System Base Setting Shooting Mode N No
Color Space Si No

Imager Scan Mode Si No

Codec Select Nit No
Rec Format Video Format Si No
RAW Output Format Si No

Genlock Reference - -
Assignable Button <I> Si No
<2> Nit No

<3> Nit No

<4> Si No

<5> Nit No

<6> Nit No

Assignable Dial Assignable Dial Si No
IRIS Dial Si No

Assignable Dial Direction Si No

IRIS Dial Direction Si No

Rec Lamp Rec Lamp Si No
Fan Control Setting Si No
HOLD Switch Setting with Rec Button Si No
with Hand Grip Remote Si No

Lens Zoom Ring Direction Si No
Distortion Comp. Si No

Language Select Si No
Clock Set Time Zone Nit No
Date Mode Si No

12H/24H Si No

Date No No

Time No No

Country NTSC/PAL Area Si No
Hours Meter Hours(System) - -
Hours(Reset) - -

Reset - -

Basic Authentication User Name No No
Password No No
Wi-Fi Wi-Fi Si No
SSID & Password - -

Wi-Fi Direct Connection - -

Client - -

IP Address - -

Subnet Mask - -

MAC Address - -

Regenerate Password - -
GPS GPS Si No
IR Remote Setting Si No
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LEVEL 1 LEVEL 2 LEVEL 3 ALL File Scene File
Camera Battery Alarm Low BATT St No
BATT Empty Si No
Camera DC IN Alarm DC Low Voltagel Si No
DC Low Voltage2 Si No
Ext. Unit Battery Alarm Near End:Info Battery Si No
End:Info Battery Si No
Near End:Sony Battery St No
End:Sony Battery Si No
Near End:Other Battery St No
End:Other Battery Nit No
Detected Battery No No
Ext. Unit DC IN Alarm DC Low Voltagel Nit No
DC Low Voltage2 Si No
All Reset Reset - -
APR APR - -
Camera Config HD/2K Modulation Nit No

Version

Number

Version Up

Ext. Unit Version Number

Ext. Unit Version Up
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Diagramas de bloques

»

Consulte los elementos relacionados en “Especificacion del audio que se va a grabar” (pdgina 45) y

”»

“Lista del menii de configuracion” (pdgina 64).

Audio Input (CH1&CH2)

Internal
MIC

=

Shoet

Audio Input Level
Side
Level + Side
Through

CH1 INPUT
LEVEL
0~10

( ( |
Q ! Q
O, Q O Q
O I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

! I ! I ! I

o o o

<CH1 Input Select> <CH1 Wind Filter> CH1 LEVEL OOz,_.mO_.* <CH1 Level>
Input1 On AUTO
Internal MIC Off MAN
Shoet
-—— == -—— == (T

(
|

Q
O
I
I
I
I
|

|
!
|
|
!
|
J

t
1
|
|
!
|
|
|

1
!
|
!
!
|
)

\ﬁ

|
!
|
|
)

<CH1 Input Select> <CH2 Wind Filter> CH2 LEVEL OOz._.mO_.* <CH2 Level>

Input1
Input2
Internal MIC
Shoe2

On
Off

AUTO
MAN

Audio Input Level
Side
Level + Side
Through

CH2 INPUT <Audio Input Level>

LEVEL
0~10

0~99

<Limiter Mode> <CH1&2 AGC Mode>

Off, -6dB
-9dB, -12dB
—15dB, -17dB

Mono
Stereo

* Ajtstelo en MAN cuando el audio entre desde el adaptador XLR.
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Audio input (CH3&CH4)

Internal
E’I‘

Shoe1

)

)

O
I
I
I
I
I
I
I

- ==~

|
!
|
|
)

<CH3 Input Select> <CH3 Wind Filter> <CH3 Level Control>™ <CH3 Level>

Off
Internal MIC
Shoe1

o,
O
I
I
I
I
|
|

On
Off

Auto
Manual

Audio Input Level
CHS3 Input Level
Level + CH3 Input Level
Through

<CH3 Input Level>
0~99

!
!
|
!
J

) G | S

<CH4 Input Select> <CH4 Wind Filter> <CH4 Level Oo::o_v» <CH4 Level>

off
Internal MIC
Shoe2

On
Off

Audio Input Level
CH4 Input Level
Level + CH4 Input Level
Through

<CH4 Input Level> <Audio Input Level>

0~99

0~99

<Limiter Mode> <CH3&4 AGC Mode>

Off, -6dB
-9dB, -12dB
—15dB, -17dB

Mono
Stereo

* Ajtstelo en Manual cuando el audio entre desde el adaptador XLR.
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Audio Output

CH1

CH2

CH3

SDI

CH4

<HDMI Output CH>
CH1/CH2, CH3/CH4

<Monitor CH>
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

<Output Limiter> <Monitor Volume>

On/Off

(

ouT

HDMI OUT

0~15

<Headphone Out>
Mono/Stereo

\

1
1 X
O

<Alarm Volume>
0~7

Headphone

Internal
Speaker

137



Licencias

Licencia de la cartera de patentes
de MPEG-4 AVC

LOS CONSUMIDORES PUEDEN UTILIZAR
ESTE PRODUCTO BAJO LA
AUTORIZACION DE LA LICENCIA DE LA
CARTERA DE PATENTES DE AVC PARA SU
USO PERSONAL O PARA OTROS USOS,
POR LOS CUALES NO SE RECIBE
REMUNERACION ALGUNA EN CASO DE

(i) CODIFICAR VIDEO DE CONFORMIDAD
CON EL ESTANDAR DE AVC (“VIDEO
AVC”) Y/O

(ii) DESCODIFICAR VIDEO AVC
CODIFICADO POR UN CONSUMIDOR
COMO PARTE DE UNA ACTIVIDAD
PERSONAL Y/U OBTENIDO DE UN
PROVEEDOR DE VIDEO CON LICENCIA
PARA PROPORCIONAR VIDEO AVC.

NO SE OTORGA NINGUN TIPO DE
LICENCIA O NO EXISTE NINGUNA
LICENCIA IMPLICITA PARA NINGUN
OTRO USO.PUEDE OBTENER
INFORMACION ADICIONAL EN MPEG LA,
L.L.C. CONSULTE
HTTP://WWW.MPEGLA.COM
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Obtencidn del software con la
licencia GPL/LGPL

Este producto utiliza un software al que se aplica
la licencia GPL/LGPL. Esto le informa de que
tiene derecho a acceder, modificar y redistribuir
el cédigo fuente de estos programas de software
de acuerdo con las condiciones de la GPL/LGPL.
El c6digo fuente se proporciona en Internet.
Utilice la siguiente URL y siga las instrucciones
de descarga.
http://www.sony.net/Products/Linux/common/
search.html

Le rogamos que no se ponga en contacto con
nosotros acerca de los contenidos del cédigo
fuente.

Para consultar el contenido de estas licencias,
consulte “Licensel.pdf” en la carpeta “License”
del CD-ROM suministrado.

Para visualizar archivos PDF es necesario tener
Adobe Reader instalado en el ordenador.

Si Adobe Reader no esta instalado en su
ordenador, podrd descargarlo a través de la
siguiente URL.

http://get.adobe.com/reader/



CONTRATO DE LICENCIA DE
USUARIO FINAL

IMPORTANT:

BEFORE USING THE SOFTWARE
CONTAINED IN THE SOLID STATE
MEMORY CAMCORDER, PLEASE READ
THIS END USER LICENSE AGREEMENT
(“EULA”) CAREFULLY. BY USING THE
SOFTWARE YOU ARE ACCEPTING THE
TERMS OF THIS EULA. IF YOU DO NOT
ACCEPT THE TERMS OF THIS EULA, YOU
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and
Sony Corporation (“SONY”). This EULA
governs your rights and obligations regarding the
software of SONY and/or its third party licensors
(including SONY s affiliates) and their respective
affiliates (collectively, the “THIRD-PARTY
SUPPLIERS”) contained in the wireless adapter,
together with any updates/ upgrades provided by
SONY, any printed, on-line or other

electronic documentation for such software, and
any data files created by operation of such
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in
the SOFTWARE having a separate end user
license agreement (including, but not limited to,
GNU General Public license and Lesser/Library
General Public License) shall be covered by such
applicable separate end user license agreement in
lieu of the terms of this EULA to the extent
required by such separate end user license
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE

The SOFTWARE is licensed, not sold. The
SOFTWARE is protected by copyright and other
intellectual property laws and international
treaties.

COPYRIGHT

All right and title in and to the SOFTWARE
(including, but not limited to, any images,
photographs, animation, video, audio, music, text
and “applets” incorporated into the SOFTWARE)
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.
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GRANT OF LICENSE

SONY grants you a limited license to use the
SOFTWARE solely in connection with the
wireless adapter and only for your individual use.
SONY and the THIRD-PARTY SUPPLIERS
expressly reserve all rights, title and interest
(including, but not limited to, all intellectual
property rights) in and to the SOFTWARE that
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute,
attempt to derive source code, modify, reverse
engineer, decompile, or disassemble any of the
SOFTWARE, whether in whole or in part, or
create any derivative works from or of the
SOFTWARE unless such derivative works are
intentionally facilitated by the SOFTWARE. You
may not modify or tamper with any digital rights
management functionality of the SOFTWARE.
You may not bypass, modify, defeat or
circumvent any of the functions or protections of
the SOFTWARE or any mechanisms operatively
linked to the SOFTWARE. You may not separate
any individual component of the SOFTWARE
for use on more than one wireless adapter unless
expressly authorized to do so by SONY. You may
not remove, alter, cover or deface any trademarks
or notices on the SOFTWARE. You may not
share, distribute, rent, lease, sublicense, assign,
transfer or sell the SOFTWARE. The software,
network services or other products other than
SOFTWARE upon which the SOFTWARE’S
performance depends might be interrupted or
discontinued at the discretion of the suppliers
(software suppliers, service suppliers, or SONY).
SONY and such suppliers do not warrant that the
SOFTWARE, network services, contents or other
products will continue to be available, or will
operate without interruption or modification.

EXCLUDED SOFTWARE AND OPEN
SOURCE COMPONENTS

Notwithstanding the foregoing limited license
grant, you acknowledge that the SOFTWARE
may include EXCLUDED SOFTWARE. Certain
EXCLUDED SOFTWARE may be covered by
open source software licenses (“Open Source
Components”), which means any software
licenses approved as open source licenses by the
Open Source Initiative or any substantially
similar licenses, including but not limited to any
license that, as a condition of distribution of the



software licensed under such license, requires
that the distributor make the software available in
source code format. If and to the extent disclosure
is required, please visit www.sony.com/linux or
other SONY -designated web site for a list of
applicable OPEN SOURCE COMPONENTS
included in the SOFTWARE from time to time,
and the applicable terms and conditions
governing its use. Such terms and conditions may
be changed by the applicable third party at any
time without liability to you. To the extent
required by the licenses covering EXCLUDED
SOFTWARE, the terms of such licenses will
apply in lieu of the terms of this EULA. To the
extent the terms of the licenses applicable to
EXCLUDED SOFTWARE prohibit any of the
restrictions in this EULA with respect to such
EXCLUDED SOFTWARE, such restrictions will
not apply to such EXCLUDED SOFTWARE. To
the extent the terms of the licenses applicable to
Open Source Components require SONY to make
an offer to provide source code in connection with
the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH
COPYRIGHTED MATERIALS

The SOFTWARE may be capable of being used
by you to view, store, process and/or use content
created by you and/or third parties. Such content
may be protected by copyright, other intellectual
property laws, and/or agreements. You agree to
use the SOFTWARE only in compliance with all
such laws and agreements that apply to such
content. You acknowledge and agree that SONY
may take appropriate measures to protect the
copyright of content stored, processed or used by
the SOFTWARE. Such measures include, but are
not limited to, counting the frequency of your
backup and restoration through certain
SOFTWARE features, refusal to accept your
request to enable restoration of data, and
termination of this EULA in the event of your
illegitimate use of the SOFTWARE.

CONTENT SERVICE

PLEASE ALSO NOTE THAT THE
SOFTWARE MAY BE DESIGNED TO BE
USED WITH CONTENT AVAILABLE
THROUGH ONE OR MORE CONTENT
SERVICES (“CONTENT SERVICE”). USE OF
THE SERVICE AND THAT CONTENT IS
SUBJECT TO THE TERMS OF SERVICE OF
THAT CONTENT SERVICE. IF YOU
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DECLINE TO ACCEPT THOSE TERMS,
YOUR USE OF THE SOFTWARE WILL BE
LIMITED. You acknowledge and agree that
certain content and services available through the
SOFTWARE may be provided by third parties
over which SONY has no control. USE OF THE
CONTENT SERVICE REQUIRES AN
INTERNET CONNECTION. THE CONTENT
SERVICE MAY BE DISCONTINUED AT ANY
TIME.

INTERNET CONNECTIVITY AND THIRD
PARTY SERVICES

You acknowledge and agree that access to certain
SOFTWARE features may require an Internet
connection for which you are solely responsible.
Further, you are solely responsible for payment of
any third party fees associated with your Internet
connection, including but not limited to Internet
service provider or airtime charges. Operation of
the SOFTWARE may be limited or restricted
depending on the capabilities, bandwidth or
technical limitations of your Internet connection
and service. The provision, quality and security of
such Internet connectivity are the sole
responsibility of the third party providing such
service.

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export
and re-export restrictions and regulations of the
area or country in which you reside, and not to
transfer, or authorize the transfer, of the
SOFTWARE to a prohibited country or otherwise
in violation of any such restrictions or
regulations.

HIGH RISK ACTIVITIES

The SOFTWARE is not fault-tolerant and is not
designed, manufactured or intended for use or
resale as on-line control equipment in hazardous
environments requiring fail-safe performance,
such as in the operation of nuclear facilities,
aircraft navigation or communication systems, air
traffic control, direct life support machines, or
weapons systems, in which the failure of the
SOFTWARE could lead to death, personal injury,
or severe physical or environmental damage
(“HIGH RISK ACTIVITIES”). SONY, each of
the THIRD-PARTY SUPPLIERS, and each of
their respective affiliates specifically disclaim
any express or implied warranty, duty or
condition of fitness for HIGH RISK
ACTIVITIES.



EXCLUSION OF WARRANTY ON
SOFTWARE

You acknowledge and agree that use of the
SOFTWARE is at your sole risk and that you are
responsible for use of the SOFTWARE. The
SOFTWARE is provided “AS IS,” without
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”)
EXPRESSLY DISCLAIM ALL
WARRANTIES, DUTIES OR CONDITIONS,
EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT AND FITNESS FOR A
PARTICULAR PURPOSE. SONY DOES NOT
WARRANT OR MAKE ANY CONDITIONS
OR REPRESENTATIONS (A) THAT THE
FUNCTIONS CONTAINED IN ANY OF THE
SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THEY WILL BE
UPDATED, (B) THAT THE OPERATION OF
ANY OF THE SOFTWARE WILL BE
CORRECT OR ERROR-FREE OR THAT ANY
DEFECTS WILL BE CORRECTED, (C) THAT
THE SOFTWARE WILL NOT DAMAGE ANY
OTHER SOFTWARE, HARDWARE OR
DATA, (D) THAT ANY SOFTWARE,
NETWORK SERVICES (INCLUDING THE
INTERNET) OR PRODUCTS (OTHER THAN
THE SOFTWARE) UPON WHICH THE
SOFTWARE’S PERFORMANCE DEPENDS
WILL CONTINUE TO BE AVAILABLE,
UNINTERRUPTED OR UNMODIFIED, AND
(E) REGARDING THE USE OR THE
RESULTS OF THE USE OF THE SOFTWARE
IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, OR
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR
ADVICE GIVEN BY SONY OR AN
AUTHORIZED REPRESENTATIVE OF SONY
SHALL CREATE A WARRANTY, DUTY OR
CONDITION OR IN ANY WAY INCREASE
THE SCOPE OF THIS WARRANTY. SHOULD
THE SOFTWARE PROVE DEFECTIVE YOU
ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR
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CORRECTION. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO THESE EXCLUSIONS
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY

SONY AND EACH OF THE THIRD-PARTY
SUPPLIERS (for purposes of this Section, SONY
and each of the THIRD-PARTY SUPPLIERS
shall be collectively referred to as “SONY”)
SHALL NOT BE LIABLE FOR ANY
INCIDENTAL OR CONSEQUENTIAL
DAMAGES FOR BREACH OF ANY EXPRESS
OR IMPLIED WARRANTY, BREACH OF
CONTRACT, NEGLIGENCE, STRICT
LIABILITY OR UNDER ANY OTHER LEGAL
THEORY RELATED TO THE

SOFTWARE, INCLUDING, BUT NOT
LIMITED TO, ANY DAMAGES ARISING
OUT OF LOSS OF PROFITS, LOSS OF
REVENUE, LOSS OF DATA, LOSS OF USE
OF THE SOFTWARE OR ANY ASSOCIATED
HARDWARE, DOWN TIME AND USER’ S
TIME, EVEN IF ANY OF THEM HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN ANY CASE, EACH AND ALL
OF THEIR AGGREGATE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE
LIMITED TO THE AMOUNT ACTUALLY
PAID FOR THE PRODUCT. SOME
JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE EXCLUSION
OR LIMITATION MAY NOT APPLY TO
YOU.

CONSENT TO USE OF NON-PERSONAL
INFORMATION, LOCATION DATA,DATA
SECURITY

You acknowledge and agree that SONY and its
affiliates, partners and agents may read, collect,
transfer, process and store certain information
collected from the SOFTWARE, including but
not limited to information about (i) the
SOFTWARE and (ii) the software applications,
contents and peripheral devices that interact with
your wireless adapter and the SOFTWARE
(“Information”). Information includes, but is not
limited to: (1) unique identifiers relating to your
wireless adapter and its components; (2)
performance of the wireless adapter, the
SOFTWARE and their components; (3)



configurations of your wireless adapter, the
SOFTWARE and the software applications,
contents and peripheral devices that interact with
the wireless adapter and the SOFTWARE; (4) use
and frequency of use of the functions of (x) the
SOFTWARE, and (y) the software applications,
contents and peripheral devices that interact with
the SOFTWARE; and (5) location data, as
indicated below. SONY and its affiliates, partners
and agents may use and disclose Information
subject to applicable laws in order to improve its
products and services or to provide products or
services to you. Such uses include, but are not
limited to: (a) administering the functionalities of
the SOFTWARE; (b) to improve, service, update
or upgrade the SOFTWARE; (c) improving,
developing and enhancing the current and future
products and services of SONY and other parties;
(d) to provide you with information about the
products and services offered by SONY and other
parties; (e) complying with applicable laws or
regulations; and (f) to the extent offered,
providing you with location-based services of
SONY and other parties, as indicated below. In
addition, SONY retains the right to use
Information to protect itself and third parties from
illegal, criminal or harmful conduct.

Certain services available through the
SOFTWARE may rely upon location
information, including, but not limited to, the
geographic location of the wireless adapter. You
acknowledge that for the purpose of providing
such services, SONY, the THIRDPARTY
SUPPLIERS or their partners may collect,
archive, process and use such location data, and
that such services are governed by the privacy
policies of SONY or such third party. By
reviewed the privacy policies applicable to such
services and consent to such activities.

SONY, its affiliates, partners and agents will not
intentionally use Information to personally
identify the owner or user of the SOFTWARE
without your knowledge or consent. Any use of
Information will be in accordance with the
privacy policies of SONY or such third party.

Please contact applicable contact address of each
area or country for SONY’ s current privacy

policy. Please contact applicable third parties for
privacy policies relating to personally identifiable
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and other information you provide when you use
or access third party software or services.

Information may be processed, stored or
transferred to SONY, its affiliates or agents which
are located in countries outside of your country of
residence. Data protection and information
privacy laws in certain countries may not offer the
same level of protection as your country of
residence and you may have fewer legal rights in
relation to Information processed and stored in, or
transferred to, such countries. SONY will use
reasonable efforts to take appropriate technical
and organizational steps to prevent unauthorized
access to or disclosure of Information, but does
not warrant it will eliminate all risk of misuse of
such Information.

AUTOMATIC UPDATE FEATURE

From time to time, SONY or the THIRD-PARTY
SUPPLIERS may automatically update or
otherwise modify the SOFTWARE, including,
but not limited to, for purposes of enhancement of
security functions, error correction and
improvement of functions, at such time as you
interact with SONY" s or third parties’ servers, or
otherwise. Such updates or modifications may
delete or change the nature of features or other
aspects of the SOFTWARE, including, but not
limited to, functions you may rely upon. You
acknowledge and agree that such activities may
occur at SONY” s sole discretion and that SONY
may condition continued use of the SOFTWARE
upon your complete installation or acceptance of
such update or modifications. Any updates/
modifications shall be deemed to be, and shall
constitute part of, the SOFTWARE for purposes
of this EULA. By acceptance of this EULA, you
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER,
SEVERABILITY

This EULA and SONY’ s privacy policy, each as
amended and modified from time to time,
together constitute the entire agreement between
you and SONY with respect to the SOFTWARE.
The failure of SONY to exercise or enforce any
right or provision of this EULA shall not
constitute a waiver of such right or provision. If
any part of this EULA is held invalid, illegal, or
unenforceable, that provision shall be enforced to
the maximum extent permissible so as to maintain



the intent of this EULA, and the other parts will
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for
the International Sale of Goods shall not apply to
this EULA. This EULA shall be governed by the
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA
shall be subject to the exclusive venue of the
Tokyo District Court in Japan, and the parties
hereby consent to the venue and jurisdiction of
such courts.

EQUITABLE REMEDIES

Notwithstanding anything contained in this
EULA to the contrary, you acknowledge and
agree that any violation of or noncompliance with
this EULA by you will cause irreparable harm to
SONY, for which monetary damages would be
inadequate, and you consent to SONY obtaining
any injunctive or equitable relief that SONY
deems necessary or appropriate in such
circumstances. SONY may also take any legal
and technical remedies to prevent violation of
and/or to enforce this EULA, including, but not
limited to, immediate termination of your use of
the SOFTWARE, if SONY believes in its sole
discretion that you are violating or intend to
violate this EULA. These remedies are in addition
to any other remedies SONY may have at law, in
equity or under contract.

TERMINATION

Without prejudice to any of its other rights,
SONY may terminate this EULA if you fail to
comply with any of its terms. In case of such
termination, you must: (i) cease all use, and
destroy any copies, of the SOFTWARE; (ii)
comply with the requirements in the section
below entitled “Your Account Responsibilities”.

AMENDMENT

SONY RESERVES THE RIGHT TO AMEND
ANY OF THE TERMS OF THIS EULA AT ITS
SOLE DISCRETION BY POSTING NOTICE
ON A SONY DESIGNATED WEB SITE, BY
EMAIL NOTIFICATION TO AN EMAIL
ADDRESS PROVIDED BY YOU, BY
PROVIDING NOTICE AS PART OF THE
PROCESS IN WHICH YOU OBTAIN
UPGRADES/ UPDATES OR BY ANY OTHER
LEGALLY RECOGNIZABLE FORM OF
NOTICE. If you do not agree to the amendment,
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you should promptly contact SONY for
instructions. Your continued use of the
SOFTWARE after the effective date of any such
notice shall be deemed your agreement to be
bound by such amendment.

THIRD-PARTY BENEFICIARIES

Each THIRD-PARTY SUPPLIER is an express

intended thirdparty beneficiary of, and shall have
the right to enforce, each provision of this EULA
with respect to the SOFTWARE of such party.

Should you have any questions concerning this
EULA, you may contact SONY by writing to
SONY at applicable contact address of each area
or country.

Copyright © 2012 Sony Corporation.

Licencias de software libre

En base a los contratos de licencia entre Sony y
los propietarios del copyright del software, este
producto utiliza software libre.

Para cumplir los requisitos de los propietarios del
copyright del software, Sony se ve obligado a
informarle acerca del contenido de estas
licencias.

Para consultar el contenido de estas licencias,
consulte “Licensel.pdf” en la carpeta “License”
del CD-ROM suministrado.



Especificaciones

General

Masa  Aprox. 2,0 kg (solo el cuerpo)
Dimensiones
(Unidad: mm, solo el cuerpo)l)
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1) Los valores de las dimensiones son aproximados.

Requisito de alimentacién
12VdeCC(de 11 Val70oVv)
Consumo de energia
Aprox. 19 W (cuerpo, objetivo
SELP28135G, grabaciéon XAVC-I
QFHD a 59.94P, visor activado)
Temperatura de funcionamiento
De 0°C a40°C
Temperatura de almacenamiento
De —20 °C a +60 °C
Tiempo de funcionamiento continuo
Aprox. 60 minutos (con BP-U30)

Formato de grabacién (video)
XAVC Intra
AVC/H.264 High 4:2:2 Intra Profile
QFHD: VBR, 600 Mbps m4x.
4K: VBR, 600 Mbps max.
HD: CBG, 222 Mbps
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XAVC Long

AVC/H.264 High Profile

QFHD: VBR, 150 Mbps méx., 4:2:0,
Long

HD: VBR, 50 Mbps madx., 4:2:2, Long
MPEG HD 422

MPEG-2 Long GOP

Modo HD422: CBR, 50 Mbps, MPEG-2
422P@HL

ProRes 422 HQ D

Apple ProRes 422 HQ

4:2:2, 10 bits, VBR, 220 Mbps méx.
ProRes 422 1)

Apple ProRes 422

4:2:2, 10 bits, VBR, 147 Mbps méx.

Formato de grabacién (audio)

LPCM de 24 bits, 48 kHz, 4-canales

Velocidad de fotogramas de grabacién

XAVC Intra

4096 x 2160/59.94P, 50P, 29.97P, 24P,
23.98P, 25P

3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P

1920 x 1080/59.94P, 50P, 59.94i, 50i,
29.97P, 23.98P, 25P

XAVC Long

3840 x 2160/59.94P, 50P, 29.97P,
23.98P, 25P

1920 x 1080/59.94P, 50P, 59.94i, 501,
29.97P, 23.98P, 25P

MPEG HD 422

1920 x 1080/59.94i, 50i, 29.97P,
23.98P, 25P

1280 x 720/59.94P, 50P, 29.97P,
23.98P, 25P

ProRes 422 HQ D

1920 x 1080/59.94i, 50i, 29.97P, 25P,
23.98P

ProRes 422 D

1920 x 1080/59.94i, 50i, 29.97P, 25P,
23.98P

Tiempo de grabacién/reproduccién

XAVC Intra 4096 x 2160/3840 x 2160
59.94p
Aprox. 22 minutos: con QD-G128A
Aprox. 11 minutos: con QD-G64A
50P
Aprox. 26 minutos: con QD-G128A
Aprox. 13 minutos: con QD-G64A



29.97P

Aprox. 44 minutos:
Aprox. 22 minutos:

23.98P/24P

Aprox. 55 minutos:
Aprox. 27 minutos:

25p

Aprox. 52 minutos:
Aprox. 26 minutos:

con QD-G128A
con QD-G64A

con QD-G128A
con QD-G64A

con QD-G128A
con QD-G64A

XAVC Intra 1920 x 1080

59.94P

Aprox. 59 minutos: con QD-G128A

Aprox. 30 minutos: con QD-G64A
50P

Aprox. 71 minutos: con QD-G128A

Aprox. 35 minutos: con QD-G64A
59.94i

Aprox. 118 minutos: con

QD-GI128A

Aprox. 59 minutos: con QD-G64A
50i

Aprox. 141 minutos: con

QD-GI128A

Aprox. 70 minutos: con QD-G64A
29.97P

Aprox. 118 minutos: con

QD-GI128A

Aprox. 59 minutos: con QD-G64A
23.98P

Aprox. 147 minutos: con

QD-GI128A

Aprox. 74 minutos: con QD-G64A
25P

Aprox. 141 minutos: con

QD-GI128A

Aprox. 70 minutos: con QD-G64A

XAVC Long 3840 x 2160
59.94P/50P
Aprox. 87 minutos: con QD-G128A
Aprox. 44 minutos: con QD-G64A
29.97P/23.98P/25P
Aprox. 131 minutos: con
QD-GI128A
Aprox. 66 minutos: con QD-G64A

XAVC Long 1920 x 1080

Modo 50M
Aprox. 262 minutos: con
QD-GI128A
Aprox. 131 minutos: con QD-G64A

Modo 35M

Aprox. 374 minutos:

QD-G128A
Aprox. 187 minutos
Modo 25M

Aprox. 524 minutos:

QD-G128A

Aprox. 262 minutos:

MPEG HD 422

Aprox. 262 minutos:

QD-G128A

Aprox. 131 minutos

ProRes 422 HQ D
59.94i/29.97P
Aprox
Aprox
50i/25P
Aprox
Aprox
23.98P
Aprox
Aprox

ProRes 422 1
59.94i/29.97P

Aprox. 90 minutos:

Aprox. 45 minutos
50i/25P

. 60 minutos:
. 30 minutos:

. 72 minutos:
. 36 minutos:

. 74 minutos:
. 37 minutos:

con

: con QD-G64A

con

con QD-G64A

con

: con QD-G64A

con QD-G128A
con QD-G64A

con QD-G128A
con QD-G64A

con QD-G128A
con QD-G64A

con QD-G128A
: con QD-G64A

Aprox. 108 minutos: con QD-

G128A
Aprox. 54 minutos
23.98p

: con QD-G64A

Aprox. 112 minutos: con QD-

G128A
Aprox. 56 minutos

: con QD-G64A

1) Con la unidad XDCA-FS7 (opcional)

conectada

El tiempo de grabacién/reproduccién puede variar
debido a las condiciones de uso y a las caracteristicas de

la memoria.
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Seccion de la camara

Dispositivo de generacion de imdgenes (tipo)
Sensor de imagen CMOS equivalente al
formato Stper de 35
Nimero de pixeles
11,6 megapixeles (totales),
8,8 megapixeles@17:9/
8,3 megapixeles@16:9 (efectivos)
Filtros ND
1: Clear
2: 1/AND
3: 1/16ND
4: 1/64ND
Sensibilidad
Gamma de video: T14 @ 24p
(2000 Ix, reflectancia del 89,9%, 3200K)
Sensibilidad ISO
S-Log3 Gamma ISO2000 (fuente de luz
D55)
Tluminacién minima
0.7 1x (18 dB, 23.98P, Shutter: OFF, ND
Clear, F1.4)
Montura del objetivo
Montura E
Latitud 14 pasos
Relacioén senal-ruido (S/N) de video
57 dB (Gamma de video/Supresion de
ruido: desactivado)
Velocidad del obturador
De 1/3 a 1/9000 de s (23.98P)
Angulo del obturador
De 5,6° a 300°
Movimiento a cimara lenta y rdpida
XAVC QFHD: de 1 a 60P
XAVC HD: de 1 a 180P
Balance de blancos
Modo predeterminado (de 2100K a
10000K), Modo de memoria A o B (de
1500K a 50000K)
Ganancia
-3,0,3,6,9,12,18 dB
Curva Gamma
STD1, STD2, STD3, STD4, STDS,
STD6, HG1, HG2, HG3, HG4, HG7,
HGS, S-Log2, S-Log3, USER1, USER?2,
USER3, USER4, USERS5
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Seccion de audio

Frecuencia de muestreo
48 kHz
Cuantificacion
24 bits
Respuesta en frecuencia
Modo MIC de la entrada XLR:
de 50 Hz a 20 kHz (+3 dB o0 menos)
Modo LINE de la entrada XLR:
de 20 Hz a 20 kHz (+3 dB o0 menos)
Rango dindmico
90 dB (tipico)
Distorsion
0,08% o inferior (nivel de entrada de
—40 dBu)
Altavoz integrado
Monoaural
Micréfono interno
Monoaural

Seccion de entrada/salida

Entradas

INPUT 1/2:
Tipo XLR, 3 contactos, hembra
Conmutable entre LINE / MIC /
MIC+48V
MIC: —40, —50, —60 dBu de referencia

Salidas

SDI OUT 1/2:
Tipo BNC, 0,8 Vp-p, no equilibrada
(salida 3G HD/1.5G HD)
Compatible con el estindar SMPTE
ST424 Level-A/B, SMPTE ST425
Level-A/B, SMPTE ST292-1
Audio de 4 canales

Auriculares (minitoma estéreo):
—16 dBu (salida del nivel de referencia,
volumen mdximo del monitor, carga de
16 Q)

HDMI: Tipo A, 19 contactos

Otras
DC IN: compatible con EIAJ,de 11 Val7Vde
CcC
Conector de la unidad de extensién:

Especifico (144 contactos)
Zapata de interfaz miltiple:

Especifica (21 contactos)



REMOTE:
Tipo D-sub de 3 polos y 2,5 @
USB: Compatible con el estandar 2,0, tipo
mini-AB para almacenamiento masivo
)]
Tipo A para conexién W-LAN (1)
VF: Especifica (40 contactos)

Seccion de visualizacion

Monitor LCD
Tamaiio de la pantalla
Diagonal de 8,8 cm (3,5 pulgadas)
Relacién de aspecto
16:9
Numero de pixeles
960 (H) x 540 (V)

Seccion de la ranura multimedia

Ranuras de tarjetas XQD para grabacion de video
@
Ranura de tarjetas UTILITY SD (1)

Accesorios suministrados

Visor (incluidos el ocular, la copa del ocular, la
varilla y la abrazadera)
Control remoto de la empufiadura
Moédulo LAN inalambrico USB (IFU-WLM3)
Control remoto de infrarrojos (RMT-845)
Adaptador de CA/Cargador
Bateria (BP-U30)
Tensién maxima: 16,4 V CC
Tension nominal: 14,4 V CC
Capacidad: 28 Wh
Cable de alimentacién (1)
Cable mini USB (1)
Soporte de montaje opcional (1)
Tapa de la montura del objetivo (1)
Tapa protectora del conector del asa (incluidos 2
tornillos M2) (1)
Tapa del médulo LAN inaldmbrico USB (2)
Tapa de repuesto del conector W-LAN (1)
Tapa de repuesto del conector de la unidad de
extension (1)
Kit de la zapata de accesorios (zapata de
accesorios (1), placa de la zapata (1), tornillos (4))
Antes de utilizar esta unidad (1)
Manual de instrucciones (CD-ROM) (1)

El disefio y las especificaciones estdn sujetos a
cambios sin previo aviso.

SONY NO SE HACE RESPONSABLE POR
DANOS DE NINGUN TIPO DEBIDOS A LA
OMISION DE LAS MEDIDAS DE
SEGURIDAD ADECUADAS EN
DISPOSITIVOS DE TRANSMISION,
FUGAS DE DATOS INEVITABLES
DERIVADAS DE LAS ESPECIFICACIONES
DE TRANSMISION O PROBLEMAS DE
SEGURIDAD DE CUALQUIER TIPO.




Notas

* Haga siempre un ensayo de grabacion y
verifique que se grabéd bien.

SONY NO SE HACE RESPONSABLE POR
DANOS DE NINGUN TIPO,
INCLUYENDO PERO NO LIMITADO A
LA COMPENSACION O PAGO POR
FALLO EN HACER CUALQUIER TIPO DE
CONTENIDO DE GRABACION POR
MEDIO DE ESTA UNIDAD O SU
SOPORTE DE GRABACION, SISTEMAS
DE MEMORIA EXTERNA O CUALQUIER
OTRO SOPORTE O SISTEMAS DE
MEMORIA.

Verifique siempre que esta unidad funciona
correctamente antes de utilizarla. SONY NO
SE HACE RESPONSABLE POR DANOS
DE NINGUN TIPO, INCLUYENDO PERO
NO LIMITADO A LA COMPENSACION O
PAGO POR LA PERDIDA DE
GANANCIAS PRESENTES O FUTURAS
DEBIDO AL FALLO DE ESTA UNIDAD,
YA SEADURANTE LA VIGENCIA DELA
GARANTIA O DESPUES DEL
VENCIMIENTO DE LA GARANTIA NI
POR CUALQUIER OTRA RAZON.

SONY NO SE HACE RESPONSABLE POR
RECLAMACIONES DE NINGUN TIPO
REALIZADAS POR USUARIOS DE ESTA
UNIDAD O POR TERCEROS.

SONY NO SE HACE RESPONSABLE POR
LA PERDIDA, REPARACION O
REPRODUCCION DE CUALQUIER DATO
GRABADO EN EL SISTEMA DE
ALMACENAMIENTO INTERNO,
SOPORTES DE GRABACION, SISTEMAS
DE ALMACENAMIENTO EXTERNO O
CUALQUIER OTRO SISTEMA DE
ALMACENAMIENTO.

SONY NO SE HACE RESPONSABLE DE
LA FINALIZACION NI DE LA
INTERRUPCION, POR LA
CIRCUNSTANCIA QUE FUERA, DE
CUALQUIER SERVICIO RELACIONADO
CON ESTA UNIDAD.
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Descargas de software

Cuando utilice la unidad con una conexién de PC,
descargue todos los controladores del dispositivo,
los complementos y las aplicaciones de software
que necesite de los siguientes sitios web.

Sitio web de productos de Sony Professional:

Estados Unidos

Canadd

http://pro.sony.com

http://www.sonybiz.ca
Latinoamérica http://sonypro-latin.com
Europa http://www.pro.sony.eu/pro

Oriente Medio y http://sony-psmea.com

Africa

Rusia http://sony.ru/pro/
Brasil http://sonypro.com.br
Australia http://pro.sony.com.au

Nueva Zelanda http://pro.sony.co.nz

Jap6n http://www.sonybsc.com
Asia Pacifico http://pro.sony-asia.com
Corea http://bp.sony.co.kr
China http://pro.sony.com.cn
India http://pro.sony.co.in

Sony Creative Software, pagina de descarga de
software:
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment



Marcas comerciales

XDCAM es una marca comercial de Sony

Corporation.

* XAVCy son marcas comerciales
registradas de Sony Corporation.

* XQD y DCQQ D son marcas comerciales de
Sony Corporation.

* HDMLI, el logotipo de HDMI y High-Definition
Multimedia Interface son marcas comerciales o
marcas comerciales registradas de HDMI
Licensing, LLC en Estados Unidos y en otros
paises.

Todos los demds nombres de compaiiias y de
productos son marcas comerciales registradas o
marcas comerciales de sus respectivos
propietarios. En este documento, no se utilizan
los simbolos ® o ™ para indicar los elementos
con marca registrada.
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